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About This Guide

This Filr 2.0 Installation Guide covers the installation and configuration of Filr. The guide is divided 
into the following sections:

 Chapter 1, “Overview,” on page 9

 Chapter 2, “Planning Your Filr Installation,” on page 27

 Chapter 3, “Creating a Small Deployment,” on page 37

 Chapter 4, “Creating a Large Deployment,” on page 53

 Chapter 5, “Configuring and Maintaining the Search Index Appliance,” on page 95

 Chapter 6, “Configuring and Maintaining the MySQL Database Appliance,” on page 97

 Chapter 7, “Setting Up the Filr Site,” on page 101

 Chapter 8, “Upgrading Filr,” on page 105

 Chapter 9, “Troubleshooting the Filr Installation and Upgrade,” on page 131

 Part I, “Appendixes,” on page 135

Audience

This guide is intended for Novell Filr administrators.

Feedback

Please use the User Comments feature at the bottom of each online documentation page to comment 
and suggest improvements to this guide and the other documentation included with Novell Filr.

Documentation Updates

The most recent version of this guide is available here (http://www.novell.com/documentation/novell-
filr-2/filr-2-inst/data/bookinfo.html) on the Novell Filr Web site.

Additional Documentation

For other Novell Filr documentation, see the Novell Filr Web site (http://www.novell.com/
documentation/novell-filr-2/).
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1 1Overview

This section provides overview information that is useful as you install Novell Filr. For an in-depth 
overview of the product, see the Filr 2.0: Understanding How Filr Works.

 Section 1.1, “What Is Novell Filr?,” on page 9

 Section 1.2, “Filr System Requirements,” on page 12

1.1 What Is Novell Filr?
Novell Filr is an enterprise file management tool designed to share files by leveraging your security 
infrastructure, both internally and externally. Filr gives you access to corporate files (including files 
that are located on mapped drives) and lets you access them from a mobile app on a mobile device, 
from a desktop application on your workstation, or from a web browser.

 Section 1.1.1, “Filr Applications and Appliances,” on page 9

 Section 1.1.2, “Filr Components,” on page 10

 Section 1.1.3, “Filr Storage,” on page 11

 Section 1.1.4, “Using Novell Filr,” on page 11

1.1.1 Filr Applications and Appliances

The following sections provide information about the distinction between Filr applications and 
appliances.

 “Applications” on page 9

 “Appliances” on page 10

Applications

Filr applications are client interfaces that allow users to access the Filr software. There are three Filr 
applications:

 Web application: See the Filr 2.0: Web Application User Guide for information about how to use 
the Filr web application.

After installing Filr, you can log in to the web application. Review the information in “Setting Up 
the Filr Site before Users Log In” in the Filr 2.0: Administration Guide for information about how 
you can configure your Filr site.

 Desktop application: See the Filr Desktop Application for Windows Quick Start (http://
www.novell.com/documentation/novell-filr-2/filr-2-qs-desktop/data/filr-2-qs-desktop.html) and the 
Filr Desktop Application for Mac Quick Start (http://www.novell.com/documentation/novell-filr-2/
filr-2-qs-desktopmac/data/filr-2-qs-desktopmac.html) for information about how to use the 
desktop application.

Before the desktop application can be available to users, you need to configure it for your Filr 
site, as described in “Setting Up the Filr Desktop Application” in the Filr 2.0: Administration 
Guide.
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 Mobile app: See the Novell Filr Mobile App Quick Start for information about how to download 
and use the mobile app.

Appliances

Appliances are prepackaged software bundles designed to reduce installation and configuration 
overhead. Components that make up a Filr site can be deployed either as a single appliance for small 
deployments or as multiple appliances for larger installations. Filr appliances run as virtual machines 
within a VMware, Hyper-V, or Xen environment. For more information, see Section 1.1.2, “Filr 
Components,” on page 10.

1.1.2 Filr Components

A Novell Filr site consists of three major components. In very small deployments, each of these 
components is part of the Filr appliance. In large deployments, the software, the database, and the 
search index each runs as a separate appliance.

 “Filr Software” on page 10

 “Filr Database” on page 10

 “Search Index” on page 10

Filr Software

The Filr software is a customized version of Apache Tomcat. This software provides the web-based 
functionality you use as you access the Filr site through your web browser.

Filr Database

Filr supports using a MySQL, MariaDB, or Microsoft SQL database. You can either install the MySQL 
database appliance that ships with Filr or configure Filr to use your organization’s existing SQL 
database server. (Using your organization’s existing database is recommended for enterprise 
installations.)

The Filr database is used for storing information about the Filr site and its users:

 Structural information about folders and files

 Identification information about folders and files (for example, titles, descriptions, dates of 
creation/modification, and users associated with creation and modification)

 User profile information (for example, full name, phone number, and email address)

The Filr database disk space requirements are relatively modest, because the database is not used 
for storing files.

Search Index

The search index is a high-performance Java search engine built with Lucene technology. The search 
index contains pointers to the actual data stored in the Filr file repository. The index enables the 
search engine to perform very fast searches through large quantities of Filr data.
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1.1.3 Filr Storage

Data for the Filr system is stored in three areas:

 “SQL Database” on page 11

 “Data Storage for the Appliance” on page 11

 “Configuration Data for the Appliance” on page 11

SQL Database

The SQL database is used to store SQL data files, including tablespace data files, tablespace log 
files, and binary log files. It is also used to store comments on files and folders.

The SQL database can be part of the all-in-one appliance (small deployment), can be configured as a 
separate appliance (large deployment), or can be leveraged on an existing SQL database.

Data Storage for the Appliance

When you set up Filr (either as a single appliance in a small deployment or as separate appliances for 
a large deployment), you configure data to reside on a hard disk. 

The following data is stored for each appliance on the hard disk: 

All appliances: Web application certificates for Jetty and Tomcat and the Ganglia RRD database

Filr appliance: Data for the Filr appliance (located in the /Cachefilestore and /conf, /extension, 
/filerepository, /temp direcotries)

Search index appliance: Data for the search appliance

MySQL database appliance: Data for the MySQL database appliance

For more detailed storage information, see “Filr Appliance Storage” on page 19.

Configuration Data for the Appliance

Configuration information for each appliance is stored on the appliance itself, and can be exported 
during and upgrade process and then re-imported.

For more information, see Chapter 8, “Upgrading Filr,” on page 105.

1.1.4 Using Novell Filr

Novell Filr lets users work with files in important ways: 

 Access: Users can access the files they need in multiple ways, including from a web browser, 
from a desktop, or from a mobile device.

For more information, see “Accessing Filr” in the Filr 2.0: Web Application User Guide.

 Share: Users can share files with their co-workers and grant them specific rights to the files. For 
example, a user can share a file with User A with Read-Only access, and then share the same 
file with User B with Edit access. 

Users can easily see what has been shared with them and what they have shared.
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For more information, see “Sharing Files and Folders” in the Filr 2.0: Web Application User 
Guide.

 Collaborate: Users can make comments on a file. Then all users with access can see the 
comments and make comments of their own. 

For more information, see “Commenting on a File” in the Filr 2.0: Web Application User Guide.

Filr allows users to access, share, and collaborate on files that are in two key locations:

 “Files in Net Folders” on page 12

 “My Files” on page 12

Files in Net Folders

Filr gives users easy access to folders and files on the corporate file system. Corporate files can be 
files on a user’s home drive, files on a mapped drive, or files on a remote server. Filr gives users 
seamless access to these files, regardless of their location. You as the Filr administrator define which 
corporate files users have access to. 

In Filr, users access these corporate files by clicking Net Folders in the masthead. For more 
information about Net Folders, see the Filr 2.0: Web Application User Guide.

My Files

Users can upload files directly to the Filr site for personal use or to promote collaboration; they can 
create folders to better organize files. For more information about how to upload files, see “Adding 
Files to a Folder” in the Filr 2.0: Web Application User Guide.

Files and folders that are located in a user’s My Files area are visible only to that user by default. 
Users can make files and folders available to others by sharing them, as described in “Sharing Files 
and Folders”in the Filr 2.0: Web Application User Guide.

The My Files area can contain two types of files. Users can access these files by clicking My Files in 
the masthead.

 Personal Storage: You can configure Filr to allow users to add Personal Storage files to the My 
Files area. These are files that users have uploaded to the Filr site and do not exist on an 
external server; instead, the files are on the Filr server itself.

 Home Folder: You can configure Filr to display users’ Home folders. Files in users’ Home 
folders are synchronized from the corporate file system.

1.2 Filr System Requirements
As a Novell Filr site administrator, ensure that your system meets Filr system requirements, so that 
your Filr site can be set up successfully. After your Filr site is set up, you must also ensure that users’ 
browsers and office applications meet Filr user requirements, so that they can access the Filr site 
successfully.

 Section 1.2.1, “Filr Server Requirements,” on page 13

 Section 1.2.2, “Filr Storage Size Requirements,” on page 18

 Section 1.2.3, “Filr User Requirements,” on page 23

 Section 1.2.4, “Desktop Application Requirements,” on page 24

 Section 1.2.5, “Mobile App Requirements,” on page 25
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 Section 1.2.6, “File Viewer Information,” on page 25

 Section 1.2.7, “Linux File System,” on page 25

For any known issues related to System Requirements for Filr 2.0, see the Novell Filr 2.0 Release 
Notes (http://www.novell.com/documentation/novell-filr-2/filr-2-relnote/data/filr-2-relnote.html).

1.2.1 Filr Server Requirements

 “Virtualization Requirements” on page 14

 “Memory Requirements” on page 15

 “Database Requirements” on page 16

 “File Server Requirements” on page 16

 “Net Folder Access to Storage” on page 17

 “Directory Requirements” on page 17

 “Browser Requirements” on page 17

 “File Shared Storage Requirements (/vashare Mount Point)” on page 18

 “IP Address Information” on page 18
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Virtualization Requirements

Hypervisor Type Supported Versions

VMware  One of the following VMware host servers for 
hosting the Filr appliance.

 ESXi 6.0 with the latest update

 ESX 5.5 with the latest update

For the most up-to-date compatibility matrix of 
supported VMware host servers, see the VMware 
Compatibility Guide (http://www.vmware.com/
resources/compatibility/
search.php?deviceCategory=software&testConfi
g=16) provided by VMware. 

To generate the correct chart from the VMware 
Compatibility Guide:

1. Ensure that Guest OS is selected in the 
What are you looking for field.

2. In the OS Vendor field, select SUSE, then 
in the OS Family Name field, select SUSE 
Linux Enterprise 11.

3. Click Update and View Results, then look 
at the SUSE Linux Enterprise Server 11 
Service Pack 3 64-bit line of the provided 
table.

The versions of ESX and ESXi that are 
listed in the Supported Releases column of 
this row are compatible with Filr 2.0

 A VMware vSphere client 5.1.x for accessing the 
host server and appliance for initial configuration

Not all versions of the vSphere client are 
compatible with versions of VMware ESX and 
ESXi. For a complete matrix of compatibility, see 
the VMware Product Interoperability Matrixes 
(http://partnerweb.vmware.com/comp_guide2/
sim/interop_matrix.php) provided by VMware. 

 VMware vMotion is supported when running Filr 
on VMware ESXi or 5.5 with the latest updates

Hyper-V  Windows 2008 R2 Server (as a Role)

 Hyper-V Server 2012 R2 (Core)

Xen IMPORTANT: All Xen and kernel patches must be 
applied before installing.

 SLES 11 SP4, 64-bit

 SLES 12, 64-bit

Citrix Xen  Citrix XenServer 6.5 and later
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Memory Requirements

Deployment Type Requirement

Small deployment (Filr appliance only) Minimum 12 GB of memory (16 GB is recommended) 
and 4 CPUs. At least 50% and preferably 66% of the 
memory should be dedicated to the Java heap. 
(Default is 8 GB and 4 CPUs.)

A small deployment requires more resources than a 
large deployment for the Filr appliance, because in a 
small deployment the database and the search index 
are also running on the Filr appliance.

For information about adjusting the Java heap 
settings, see “Changing the JVM Configuration 
Settings” in the Filr 2.0: Administration Guide.

Large deployment  Filr Appliance: Recommend 12 GB of memory 
and 4 CPUs. 2 GB of memory for the operating 
system, and 10 GB of memory for Java heap.

Default is 8 GB and 4 CPUs. 1.5 GB of memory 
for the operating system, and 6.5 GB of memory 
for Java heap.

 Database Appliance: 8 GB of memory and 2 
CPUs. 

In larger environments (more than 1,000 users), 
recommended memory is 12 GB.

 Search Index Appliance: 8 GB of memory and 
2 CPUs

2 GB of memory for the operating system, 2 GB 
for Memcached, and 4GB for the Java heap.

In larger environments (more than 1,000 users), 
recommended memory is 12 GB (allocate 2 GB 
for the operating system, 3 GB to Memcached, 
and 7 GB of memory for Java heap).

For information about adjusting the Java heap 
settings, see “Changing the JVM Configuration 
Settings” in the Filr 2.0: Administration Guide.
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Database Requirements

Following are the database requirements when configuring Filr to use an existing database instead of 
the database appliance (as described in Section 4.3, “Configuring an Existing Database Server,” on 
page 76):

File Server Requirements

You can configure Net Folders in Filr to access files on any combination of the file servers listed 
below. 

NOTE: File servers are not required if you use Filr only for files in the My Files area.

Database Type Supported Versions

MySQL  5.5.46 (Filr Appliance)

 5.6 on Linux

 5.6.x on Windows

Microsoft SQL  2008 R2 on Windows 2008 R2

 2012 SP2 on Windows 2012 R2

 2014 on Windows 2012 R2

MariaDB  SLES 12

Platform Supported Versions

Windows  Windows 2003 (CIFS)

 Windows 2008 R2 (CIFS)

 Windows 2012 R2 (CIFS)

Windows native DFS-N and DFS-R with replication are 
supported

OES  OES 2 SP3 (NCP)

 OES 11 SP1 (NCP and CIFS)

IMPORTANT: You must apply at least the 
December 2012 Scheduled Maintenance 
Update, otherwise the NCP server can fail.

 OES 11 SP2 (NCP and CIFS)

 OES 2015 (NCP and CIFS), including NSS AD 
(CIFS)

DFS and DST for OES are supported.

Domain Services for Windows (DSfW) is not 
supported.

NetWare  NetWare 6.5.8

Share Point  2013
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Net Folder Access to Storage

In addition to storage that is directly attached to the file servers listed in “File Server Requirements” 
on page 16, Net Folders can include access to files that are being stored through any of the following 
storage methods:

 Network Attached Storage (NAS) with NetApp, EMC, and other Microsoft Active Directory joined 
NAS devices that support the CIFS protocol. 

 Storage Area Network (SAN)

Directory Requirements

Browser Requirements

A workstation (Windows, Mac, or Linux) capable of running one of the supported browsers for 
configuring and managing the appliance after the initial setup:

Directory Service Platform Version

eDirectory  NetIQ eDirectory 8.8.x.x (8.8.8.3 is 
recommended).

For more information, see the NetIQ eDirectory 
8.8 Documentation website (http://
www.novell.com/documentation/edir88).

 NetIQ eDirectory version 8.8.x.x on standalone 
Windows.

eDirectory running on Windows servers with file 
shares is not supported.

Active Directory  Windows Server 2008 R2 Active Directory with 
the latest Service Pack

 Windows Server 2012 R2 Active Directory with 
the latest Service Pack

For more information, see Windows Server 2008 
Active Directory (http://www.microsoft.com/
windowsserver2008/en/us/active-directory.aspx).

Browser Requirement

Mozilla Firefox Latest version

Microsoft Internet Explorer 11

Microsoft Edge Latest version

Chrome Latest version

Safari Latest version
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File Shared Storage Requirements (/vashare Mount Point)

In large clustered deployments, personal storage must reside on an external NFS drive or CIFS 
share, as listed below.

IP Address Information

IP address information for assigning to the Filr appliance, including:

 Static IP address

 Network mask

 Gateway IP address

 DNS host name associated with the IP address

 IP address of a DNS server

 IP address or DNS name of the same NTP server that your target OES servers use (optional)

If using VMware, Novell recommends setting up NTP in accordance with the VMware best 
practices guidelines (http://kb.vmware.com/selfservice/microsites/
search.do?language=en_US&cmd=displayKC&externalId=1006427).

1.2.2 Filr Storage Size Requirements

The tables in the following sections outline the storage requirements for the various appliances, as 
well as the kinds of information that is stored. The storage requirements vary depending on the size 
of your Filr installation.

Clustered Deployment: All information in the following sections applies to a clustered deployment.

Large Deployment: All information in the following sections applies to a non-clustered large 
deployment except: 

 All storage recommendations and functions listed under Shared Storage (/vashare) apply 
instead to Hard Disk 2 (/vastorage), in “Filr Appliance Storage” on page 19.

Protocol Requirement

CIFS  Windows CIFS share

NFS Exported mount point on one of the following:

 SLES 11 SP4

 SLES 12

NFS on Windows is not supported.
18 Filr 2.0: Installation and Configuration Guide

http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1006427
http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1006427


Small Deployment: Only the information in “Filr Appliance Storage” on page 19 applies to a small 
deployment. All information in “Filr Appliance Storage” on page 19 applies to a small deployment 
except:

 All storage recommendations and functions listed under Shared Storage (/vashare) apply 
instead to Hard Disk 2 (/vastorage).

 “Filr Appliance Storage” on page 19

 “Search Index Appliance Storage” on page 21

 “MySQL Database Appliance Storage” on page 22

Filr Appliance Storage

Boot Partition (Hard Disk 1)

Recommended Storage: 20 GB of disk space

Function: Stores the operating system and all appliance-specific software (such as Apache Tomcat for the Filr 
appliance and Lucene for the search appliance).

VMware/Hyper-V/Xen/Citrix Xen Hard Disk (Hard Disk 2 - /vastorage)

In a small deployment, all storage recommendations and functions listed under Shared Storage (/vashare) 
are included in Hard Disk 2 (/vastorage).

Recommended Storage: Must have three times as much disk space as the sum of all files that will be 
uploaded concurrently to personal storage on the Filr site, and two times as much disk space as the sum of all 
files that will be uploaded concurrently to any Net Folders. 

For example, if 10 users each upload a 3GB file to their My Files area (personal storage) at the same time, you 
must have at least 30GB x 3 (90GB) of disk space allocated to /vastorage. If /vastorage does not have 
sufficient disk space, an error occurs.

Function: Stores the following types of files:

 Configuration files that are used for appliance upgrades

 Ganglia files that are used to store monitoring information

VMware/Hyper-V/Xen/Citrix Xen Disk (Hard Disk 3 - /var)

Recommended Storage: Disk size should be equal to the amount of memory given to the appliance, plus 
whatever is required for storage. It is a good idea to have enough storage to accommodate two memory 
dumps.

Function: Stores the following types of files:

 System event logs

 Memory dumps

Because log files are continually growing and can consume large amounts of disk space, the Filr administrator 
should regularly delete old log files.
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IMPORTANT: HTML renderings and text extractions have a significant impact on the amount of 
storage required per file for the Filr appliance. In a small deployment, index files and database files 
also have an impact on the amount of storage required per file for the Filr appliance.

 HTML Renderings: Each time a user renders a file as HTML (either by clicking View Details on 
the file from the web interface, by clicking View as HTML from the web interface, or by tapping on 
a file from the mobile app), that rendering occupies additional disk space. 

HTML renderings for files in both Personal Storage and files in Net Folders are stored in the /
vashare directory in a clustered environment and in the /vastorage directory in a non-clustered 
environment.

Only one HTML rendering can exist for a single document. If a user views a file as HTML and a 
rendering already exists, a second rendering is not created.

Shared Storage (/vashare)

Shared storage is used only in large Filr deployments that have been configured with shared storage. (It is 
always recommended to create shared storage in large deployments, even if the large deployment has only 
one Filr appliance.)

Large deployments with only one Filr appliance can be set up without shared storage. (This is not 
recommended because if shared storage is not configured during installation, it is not possible to add additional 
Filr appliances in the future if the need arises.)

In a small deployment, all storage recommendations and functions listed under Shared Storage (/vashare) 
are included in Hard Disk 2 (/vastorage).

Recommended Storage: Disk space must be equal to the size of all files that you anticipate users will add to 
their Personal Storage (My Files area), plus adequate space to account for the storing of HTML renderings and 
text extractions.

/vashare must have three times as much disk space as the sum of all files that will be uploaded concurrently 
to personal storage on the Filr site, and two times as much disk space as the sum of all files that will be 
uploaded concurrently to any Net Folders. 

For example, if 10 users each upload a 3GB file to their My Files area (personal storage) at the same time, you 
must have at least 30GB x 3 (90GB) of disk space allocated to /vashare. If /vashare does not have sufficient 
disk space, an error occurs.

IMPORTANT: HTML renderings and text extractions have a significant impact on the amount of storage 
required for a file. For more information about how these factors affect storage, see the IMPORTANT note 
following this table.

Function: Stores the following types of files:

 Configuration files that are used for appliance upgrades

 Personal Storage files (files that are located in users’ My Files area)

 Temporary files (uploads and conversions that are in progress)

 Cached files that have been previously rendered as HTML

Because cached files are not automatically deleted, the Filr administrator should clean up cached files in 
the /vashare/cachefilestore area on a regular basis. For more information about the amount of 
space required for HTML renderings, see the IMPORTANT note following this table.
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The amount of space the HTML rendering occupies differs depending on the type of file that is 
rendered:

 Office file renderings (such as Microsoft Office and OpenOffice) require the same amount of 
disk space as the original file. (For example, a 1 MB file requires an additional 1 MB of disk 
space for the HTML rendering.)

 PDF renderings require approximately 10 times the amount of disk space as the original file. 
(For example, a 1 MB file requires an additional 10 MB of disk space for the HTML 
rendering.)

 PowerPoint renderings require approximately 3 times the amount of disk space as the 
original file. (For example, a 1 MB file requires an additional 3 MB of disk space for the 
HTML rendering.)

If HTML renderings are consuming more than 10 GB of disk space on your system, you can 
delete all HTML renderings by restarting the Filr appliance. (For information about how to restart 
the Filr appliance, change any configuration option, then click Reconfigure Filr Server, as 
described in “Configuring and Maintaining the Filr Appliance” in the Filr 2.0: Administration 
Guide.)

 Text Extractions: When a file is added to Filr (either to Personal Storage or to a Net Folder), 
text from the file is extracted and added to the search index to be used for searching. By default, 
each text-extracted file is truncated to 1.1 MB.

 Index Files: (Applies only to a small deployment) In a large or clustered deployment, index files 
are stored in the search appliance.

 Database Files: (Applies only to a small deployment) In a large deployment or clustered 
deployment, database files are stored in the MySQL database appliance.

On the /vashare or /vastorage hard disks, inodes can be consumed on an ext-3 file system so that 
space still exists on the disk, but no more files can be added. To learn more about inodes and proper 
allocation based on the potential number of files that are created on the file system, see The File 
System in Reality (http://www.tldp.org/LDP/intro-linux/html/sect_03_01.html#sect_03_01_0), in the 
The Linux Documentation Project (http://www.tldp.org).

Search Index Appliance Storage

Boot Partition (Hard Disk 1)

Recommended Storage: 20 GB of disk space

Function: Linux operating system, Java, and Lucene search code

Because log files are continually growing and can consume large amounts of disk space, the Filr administrator 
should regularly delete old log files.
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MySQL Database Appliance Storage

VMware/Hyper-V/Xen/Citrix Xen (Hard Disk 2 - /vastorage) 

Recommended Storage: 

20 GB minimum for small systems

50 GB minimum for 2-3 node clustered systems

Or

10 GB of disk space, plus:

 Allocate 11 KB of disk space per file when indexing is enabled for Net Folders. The appliance optimizes 
and reclaims unneeded disk space after initial synchronization.

 Allocate 5 KB of disk space per file if indexing is not enabled for Net Folders.

For more information about file indexing, see “Searchability of Data” in the Filr 2.0: Administration Guide.

In order to optimize the index (as described in “Optimizing the Lucene Index” in the Filr 2.0: Administration 
Guide), at least 51% of /vastorage needs to be free space. Therefore, double the amount that you think you 
will need.

Function: Stores the following types of files:

 Configuration files that are used for appliance upgrades

 Ganglia files that are used to store monitoring information

 Search indexes

VMware/Hyper-V/Xen/Citrix Xen Hard Disk (Hard Disk 3 - /var)

Recommended Storage: 40 GB of disk space

Function: Stores the following types of files:

 System event logs and core dumps

Boot Partition (Hard Disk 1)

Recommended Storage: 20 GB of disk space

Function: Stores log files

Log files are automatically deleted after they consume 1GB of disk space.

You can delete log files before they reach the 1 GB threshold, as described in Section 6.2, “Maintaining the 
MySQL Database Appliance,” on page 99.
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1.2.3 Filr User Requirements

 “Browser Requirements” on page 23

 “Office Application Requirements” on page 24

Browser Requirements

Java v1.7.0_72 must be installed on the workstation in order for the following functionality to be 
available:

 Editing files with Edit-in-Place, as described in “Editing Files with Edit-in-Place” in the Filr 2.0: 
Web Application User Guide.

VMware/Hyper-V/Xen/Citrix Xen (Hard Disk 2 - /vastorage) 

Recommended Storage: 

25 GB of disk space, plus:

 Allocate 30 KB per file when indexing is enabled for Net Folders.

 Allocate 20 KB per file when indexing is not enabled for Net Folders.

For more information about file indexing, see “Searchability of Data” in the Filr 2.0: Administration Guide.

Allocate 10 KB per user.

Function: Stores the following types of files:

 Configuration files that are used for appliance upgrades

 Ganglia files that are used to store monitoring information

 MySQL database files

VMware/Hyper-V/Xen/Citrix Xen Disk (Hard Disk 3 - /var)

Recommended Storage: 40 GB of disk space

Function: Stores the following types of files:

 System event logs and core dumps

Platform Requirement

Linux Mozilla Firefox; Google Chrome (latest versions)

Windows Microsoft Edge

Microsoft Internet Explorer 11 

Mozilla Firefox; Google Chrome (latest versions)

Mac Safari (latest version)

Mozilla Firefox (latest version)
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 Uploading folders to Filr, as described in “Adding Folders” in the Filr 2.0: Web Application User 
Guide.

If the browser does not support HTML 5, uploading both files and folders requires this version of 
Java to be installed.

Accessing Filr through a web browser on a mobile device is not supported. Instead, download the Filr 
mobile app that is compatible with your mobile device. For more information, see Section 1.2.5, 
“Mobile App Requirements,” on page 25.

Office Application Requirements

One of the following office applications is required for editing documents on your workstation, as 
described in “Editing Files with Edit-in-Place” in the Filr 2.0: Web Application User Guide:

NOTE: OpenOffice and LibreOffice are used synonymously throughout the Novell Filr documentation. 
Functionality and issues that apply to OpenOffice also apply to LibreOffice.

1.2.4 Desktop Application Requirements

The Filr desktop application requires Filr 2.0 on the back-end and is supported on the following client 
operating systems:

Platform Requirement

Linux  OpenOffice.org (latest version)

 LibreOffice (latest version)

Windows  LibreOffice (latest version)

 OpenOffice (latest version)

 MS Office 2013

 MS Office 2010

 MS Office 365

Mac  LibreOffice (latest version)

 OpenOffice (latest version)

 MS Office 2011 for MAC

 MS Office 2013 for MAC

 MS Office 365 for MAC

Platform Requirement

Windows IMPORTANT: Always make sure that the latest 
patches and support packs are installed.

 Windows 7 SP1 (x86 & x64)

 Windows 8.1 (x64 only)

 Windows 10 (x64 only)
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For more information about the Filr desktop application, see the Novell Filr Desktop Application for 
Windows Quick Start (http://www.novell.com/documentation/novell-filr-2/filr-2-qs-desktop/data/filr-2-
qs-desktop.html) or the Novell Filr Desktop Application for Mac Quick Start (http://www.novell.com/
documentation/novell-filr-2/filr-2-qs-desktopmac/data/filr-2-qs-desktopmac.html).

1.2.5 Mobile App Requirements

The Novell Filr mobile app is supported on the following mobile devices:

 iOS phones and tablets for iOS 8.x or later

The native app is available as a free download in the Apple App Store.

 Android phones and tablets for Android 2.3 or later

The native app is available as a free download in the Google Play App Store, the Amazon 
Appstore for Android, and the Samsung Knox Apps store.

 Windows phones version 8.0 and 8.1

Windows tablets are not currently supported.

Supported only with a Filr 1.1 server or later.

 The BlackBerry PlayBook and Z10

The native application is available in the BlackBerry World app store.

In this document, the BlackBerry steps are the same as for Android devices.

For more information about the Filr mobile app, see the Novell Filr Mobile App Quick Start (http://
www.novell.com/documentation/novell-filr1/filr1_qs_mobile/data/filr1_qs_mobile.html).

1.2.6 File Viewer Information

In Novell Filr, file viewing capabilities are provided by Oracle Outside In viewer technology. See 
“Oracle Outside In Technology 8.3 Supported Formats” (http://www.oracle.com/us/026956.pdf) for a 
list of the supported file formats. See “Oracle Outside In Technology” (http://www.oracle.com/
technetwork/middleware/webcenter/content/oit-all-085236.html) for background information about 
the Oracle viewer technology included in Filr.

The file viewers also support data indexing by the search index.

1.2.7 Linux File System

Filr supports the following file systems on Linux: ext3, btrfs, and xfs.

Mac IMPORTANT: Always make sure that the latest 
patches and support packs are installed.

 10.10 (Yosemite)

 10.11 (El Capitan)

Platform Requirement
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2 2Planning Your Filr Installation

Consider the following planning information before deploying Novell Filr.

 Section 2.1, “Planning the Deployment Type,” on page 27

 Section 2.2, “Planning the File Repository,” on page 35

 Section 2.3, “Planning Net Folders,” on page 35

2.1 Planning the Deployment Type
The following sections describe guidelines for deploying either a small, large, or clustered Filr 
installation. 

 Section 2.1.1, “Small Deployment,” on page 27

 Section 2.1.2, “Large Deployment,” on page 28

 Section 2.1.3, “Multi-Server (Clustered) Deployment,” on page 29

2.1.1 Small Deployment

IMPORTANT: You cannot upgrade your Filr system from a small deployment to a large deployment. If 
your Filr system has the potential to grow, you should install Filr in a large deployment, as described 
in Section 2.1.2, “Large Deployment,” on page 28. Doing so ensures that you can scale your system 
in the future if the need arises by adding additional Filr appliances.

A small deployment, where all Filr components (Filr software, MySQL database, and the search 
index) are running on a single Filr appliance, is suitable for systems with the following:

 300 - 2,000 concurrent users, depending on the level of user activity.

Concurrent users are users accessing the Filr system at the same time, from any of the Filr 
clients.
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2.1.2 Large Deployment

For more details about the capabilities and benefits of a large deployment, see the Novell Filr 2.0 
Planning and Deployment Best Practices Guide.

The following sections describe large and clustered deployments in more detail:

 “Components of a Large or Clustered Environment” on page 28

 “Moving from a Large to a Clustered Deployment” on page 29

Components of a Large or Clustered Environment

In a large or clustered installation, the Filr components run separately. Following are the minimum 
requirements: 

Filr Appliance: You can run multiple instances of the Filr appliance (up to 10), which allows the Filr 
system to handle more users. For information about installing multiple Filr appliances, see 
Section 3.1, “Installing the Filr Appliance,” on page 37.

Location for Shared Storage (/vashare): The shared storage location can be on an NFS server or 
remote CIFS. For NFS, you must either configure the remote NFS location on a remote Linux server 
via NFS (SLES or OES; Windows is not supported) or on a remote Windows server via CIFS, as 
described in Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage 
Location,” on page 149. You must then configure each clustered Filr appliance to mount it as shared 
storage (/vashare), as described in Section 3.1, “Installing the Filr Appliance,” on page 37. (All Filr 
appliances in the cluster must have access to the designated mount point.)

Search Appliance: Novell recommends running two instances of the search appliance, which 
provides fault tolerance or backup in the event that one index server fails. Load balancing is not 
supported between index servers. For information about installing multiple search appliances, see 
Section 4.1, “Installing the Search Index Appliance,” on page 53.

Reverse proxy

Tomcat (Filr)

/vashare SQL database Lucene Indexe

Memcached
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MySQL Database Appliance: You can run only one instance of the MySQL database appliance. For 
information about installing a MySQL database appliance, see Section 4.2, “Installing the MySQL 
Database Appliance,” on page 65.

The MySQL database appliance is not intended for enterprise installations. If your organization has 
an existing MySQL database, it is recommended that you configure Filr to use the existing database, 
as described in Section 4.3, “Configuring an Existing Database Server,” on page 76.

For information about possible configuration setups and how many users are appropriate for each 
setup, see Section 2.1.2, “Large Deployment,” on page 28.

Moving from a Large to a Clustered Deployment

When you create a large Filr deployment, you have the option to include shared storage (/vashare) 
as the Filr storage location. If you create the shared storage location with your initial installation, 
adding additional Filr appliances in the future is easy (see “Adding a Filr Appliance to an Existing 
Deployment to Accommodate System Load” on page 33). 

If you do not create the shared storage location with your initial installation, you cannot create a 
clustered deployment in the future.

TIP: Increasing memory and CPU resources for an appliance can sometimes be more favorable than 
adding another appliance. You might need to adjust CPU and Memory settings for each appliance 
before you can determine the optimal setting for your environment.

2.1.3 Multi-Server (Clustered) Deployment

 “Components of a Large or Clustered Environment” on page 30

 “Advantages of Clustering” on page 30

Reverse proxy

Tomcat (Filr)

/vashare SQL database Lucene Indexes

Memcached
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 “Filr Clustering (Expanding a Deployment)” on page 31

 “Adding a Filr Appliance to an Existing Deployment to Accommodate System Load” on page 33

 “Setting Aside a Filr Appliance for Re-Indexing and Net Folder Synchronization in a Clustered 
Environment” on page 34

 “Clustering Limitations” on page 34

Components of a Large or Clustered Environment

In a large or clustered installation, the Filr components run separately. Following are the minimum 
requirements: 

Filr Appliance: You can run multiple instances of the Filr appliance (up to 10), which allows the Filr 
system to handle more users. For information about installing multiple Filr appliances, see 
Section 3.1, “Installing the Filr Appliance,” on page 37.

Location for Shared Storage (/vashare): The shared storage location can be on an NFS server or 
remote CIFS. For NFS, you must either configure the remote NFS location on a remote Linux server 
via NFS (SLES or OES; Windows is not supported) or on a remote Windows server via CIFS, as 
described in Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage 
Location,” on page 149. You must then configure each clustered Filr appliance to mount it as shared 
storage (/vashare), as described in Section 3.1, “Installing the Filr Appliance,” on page 37. (All Filr 
appliances in the cluster must have access to the designated mount point.)

Search Appliance: Novell recommends running two instances of the search appliance, which 
provides fault tolerance or backup in the event that one index server fails. Load balancing is not 
supported between index servers. For information about installing multiple search appliances, see 
Section 4.1, “Installing the Search Index Appliance,” on page 53.

MySQL Database Appliance: You can run only one instance of the MySQL database appliance. For 
information about installing a MySQL database appliance, see Section 4.2, “Installing the MySQL 
Database Appliance,” on page 65.

The MySQL database appliance is not intended for enterprise installations. If your organization has 
an existing MySQL database, it is recommended that you configure Filr to use the existing database, 
as described in Section 4.3, “Configuring an Existing Database Server,” on page 76.

For information about possible configuration setups and how many users are appropriate for each 
setup, see Section 2.1.2, “Large Deployment,” on page 28.

Advantages of Clustering

A large deployment with a cluster of Filr appliances and search appliances provides the following:

 Scalability

As more users begin using the system and more data is added, you can add more Filr 
appliances to accommodate the load. This is not an advantage with the search appliance. The 
purpose of adding a secondary search appliance is strictly for fault tolerance.

 Fault tolerance

In the event that one Filr appliance goes down, other Filr appliances are there to maintain the 
system. This is also true with the search appliance. It is optimal for your Filr system to have two 
search index.
30 Filr 2.0: Installation and Configuration Guide



Filr Clustering (Expanding a Deployment)

Filr clustering involves two or more Filr VAs sharing the same NFS or CIFS data storage location (/
vashare). You can only create a cluster if your Filr appliances were deployed pointing to the same /
vashare disk.

Basic steps for setting up Filr clustering are included in Figure 2-1.
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Figure 2-1   Clustered Filr VAs
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For step-by-step instructions, see “Setting Up a Large, Expandable (Clustered) Deployment” in the 
Novell Filr 2.0 Planning and Deployment Best Practices Guide.

For more information about clustering, see “Multi-Server (Clustered) Deployment” in the Filr 2.0: 
Installation and Configuration Guide. 

Adding a Filr Appliance to an Existing Deployment to Accommodate 
System Load

To accommodate additional load, you can add Filr appliances to the Filr system only if your original 
Filr system was configured with shared storage (/vashare). 

 “Prerequisites” on page 33

 “Adding Filr Appliances to an Existing Deployment” on page 33

Prerequisites

You can add a Filr appliance to an existing Filr deployment only if your Filr deployment meets the 
following prerequisites:

 It is a large deployment: Small (all-in-one) Filr deployments cannot be expanded.

 Shared storage is enabled: Ensure that a shared storage CIFS or NFS mount (/vashare) 
exists for the Filr deployment. You configure shared storage during the Filr appliance installation, 
as described in Section 4.4, “Installing the Filr Appliance,” on page 79. (For additional 
information about shared storage, see “Filr Appliance Storage” on page 19.)

IMPORTANT: If shared storage (/vashare) was not configured at the time you installed your 
original Filr system, you cannot add additional Filr appliances to the system.

 CIFS or NFS mount is accessible to all Filr appliances: All Filr appliances in the cluster need 
to have access to the CIFS or NFS mount.

 A load balancing solution is in place: When you add a Filr appliance and thereby create a 
clustered deployment (2 or more Filr appliances), you need to provide a solution for load 
balancing between the Filr appliances. Novell does not provide a load balancing appliance; 
however, there are many software solutions available, such as Apache, HAProxy, and NGinx. 
There are also hardware solutions available, such as F5 Networks, Juniper, Riverbend, and A10 
Networks. Searching on the web for Layer 4-7 switches or Application Delivery 
Controller is a good place to start in determining a solution suitable for your environment.

Adding Filr Appliances to an Existing Deployment

To add Filr appliances to an exiting large Filr deployment:

1 Ensure that your system meets the necessary prerequisites.

2 Install the additional Filr appliance. This is the same process as when you installed the original 
Filr appliance, as described in Section 4.4, “Installing the Filr Appliance,” on page 79.

IMPORTANT: Choose the same configuration options (including the same CIFS and NFS 
mount) that you chose when you installed the original Filr appliance.
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3 Run the installation wizard for a large deployment (at port 9443), as described in Section 4.5, 
“Configuring a Large Deployment for the First Time,” on page 92.

4 After the configuration is complete, select Clustering (as described in “Changing Clustering 
Configuration Settings” in the Filr 2.0: Administration Guide), then verify that clustering is 
enabled and that the Memcached configuration matches the configuration of the original Filr 
appliance.

Setting Aside a Filr Appliance for Re-Indexing and Net Folder 
Synchronization in a Clustered Environment

In a clustered environment, it is a good idea to set aside a single Filr appliance to perform specific 
resource-intensive tasks.

You can use the standalone Filr appliance to perform the following tasks:

 Synchronizing a Net Folder

 Re-indexing the search index (this is a manual task that you must perform directly from the Filr 
appliance)

To set aside a Filr appliance and to use it to perform resource-intensive tasks:

1 Configure one of the Filr appliances in the cluster to allow synchronization, as described in “Net 
Folder Configuration” in the Filr 2.0: Administration Guide.

This is the appliance that will perform the synchronization work.

1a Select Allow Synchronization on the Net Folders page for the Novell Filr configuration at 
port 9443.

2 Configure the load balancer to load balance between all the Filr appliances in the cluster, except 
the Filr appliance for which you configured Net Folder synchronization to take place, as 
described in Step 1.

Now when a Full synchronization occurs (either as a result of a scheduled or manual 
synchronization), the Filr appliance that you set aside is the one that handles the load.

3 (Optional) Rebuild the search index.

3a Access the standalone Filr appliance from a web browser by navigating to the URL of that 
particular Filr appliance.

Because the standalone appliance is separate from the load balancer, you must access it 
directly in order to use it for re-indexing. By accessing the appliance directly, you force the 
process to originate from this particular appliance.

3b Rebuild the search index as described in “Rebuilding the Search Index with Multiple Index 
Servers” in the Filr 2.0: Administration Guide.

Clustering Limitations

In a clustered environment, Filr appliances are not tolerant to latency, and should exist in the same 
subnet or near-subnet.

Ensure that all Filr appliances in the cluster are pointing to the same NTP time source. Failure to do 
so can significantly degrade overall system performance.
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2.2 Planning the File Repository
In a small deployment, the location for the Novell Filr file repository is /vastorage/filr. In a large 
deployment, the location for the Novell Filr file repository is /vashare/filr.

For information about sizing recommendations for the file repository, see Section 1.2.2, “Filr Storage 
Size Requirements,” on page 18.

The data files not stored in the Filr database are divided into several functional areas:

 Simple file repository: A large consumer of disk space.

All Personal Storage files are stored in the file repository.

 Cache store: Consumes less disk space than the file repository.

Information derived from the Personal Storage files, such as thumbnails, HTML renderings, 
scaled images, and word lists for indexing are stored in the cache store. 

 Search index: (Small deployment only; in a large deployment, the search index is maintained 
on the separate search appliance) Takes only a fraction of the space consumed by the file 
repository.

The search index contains only pointers to the actual data stored in the file repository. The index 
enables the Lucene search engine to perform very fast searches through large quantities of 
data.

2.3 Planning Net Folders
Net Folders in Filr provide access to files on your corporate OES, Windows, Share Point, or NetWare 
file servers. In essence, a Net Folder is simply a pointer or a reference to a specific folder on a 
specific file server.

Configuring Net Folders in a sub-optimal way can result in unsatisfactory performance of your Filr 
system. The ideal Net Folder configuration can vary greatly depending on the number of files that you 
want to synchronize to Filr, the frequency in which files are modified, and so forth. Before configuring 
Net Folders, become familiar with the various subtleties related to Net Folders, such as the various 
synchronization methods and the impact of indexing content. For more detailed information, see 
“Planning Net Folder Creation” in the Filr 2.0: Administration Guide.
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3 3Creating a Small Deployment

The following sections describe how to download, install, and configure the Filr software as a single 
appliance for a small deployment. For a small deployment, you install only the Filr appliance. The Filr 
appliance includes the Filr software, the MySQL database, and the search index.

NOTE: Before you begin the installation:

 Ensure that the server requirements in Section 1.2.1, “Filr Server Requirements,” on page 13 
have been met.

 Ensure that you have read and understand Chapter 1, “Overview,” on page 9.

The following sections describe how to create a small Filr deployment:

 Section 3.1, “Installing the Filr Appliance,” on page 37

 Section 3.2, “Configuring a Small Deployment for the First Time,” on page 50

3.1 Installing the Filr Appliance
 Section 3.1.1, “Downloading the Filr Appliance and Configuring the Virtual Environment,” on 

page 37

 Section 3.1.2, “Installing the Filr Appliance,” on page 47

3.1.1 Downloading the Filr Appliance and Configuring the Virtual 
Environment

You need to download the Filr appliance and configure the virtual environment where you plan to run 
the appliance. This includes configuring system resources and so forth.

The process of downloading the Filr appliance and configuring the virtual environment differs, 
depending on which virtual environment you plan to use to run the Filr appliance.

 “VMware Configuration” on page 37

 “Hyper-V Configuration” on page 41

 “Xen Configuration” on page 43

 “Citrix Xen Configuration” on page 46

VMware Configuration

1 Download the Filr software (Filr.x86_64-version.ovf.zip) to your management workstation.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).
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2 Extract the Filr.x86_64-version.ovf.zip file on your management workstation so that the 
Filr-version file folder appears.

3 In the vSphere client, click File > Deploy OVF Template.

4 Browse to and select the .ovf file in the Filr-version file folder.

5 Click Next.

6 Click Next again.

7 In the Name field, rename the Filr appliance to a name of your choosing, then click Next.

8 Select the datastore where you want to store the virtual machine files, then click Next.

9 Click Next to accept the default for the disk format.

10 Click Finish.

11 Create a separate VMware hard disk (Hard Disk 2) for the appliance. This is the location where 
you will store your Filr files (files that are located in users’ My Files area). 

IMPORTANT: If you do not create a separate VMware hard disk as described here, you cannot 
upgrade to a new version of Filr.

11a In the vSphere client, right-click the virtual machine that you just created, and for which you 
want to create secondary storage, then click Edit Settings.

The Virtual Machine Properties page is displayed.

11b On the Hardware tab, click Add.

The Add Hardware dialog box is displayed.

11c Select Hard Disk, then click Next.

11d Leave Create a new virtual disk selected, then click Next.

11e In the Disk Size field, specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

11f In the Disk Provisioning section, select either Thick Provision Eager Zeroed or Support 
clustering features such as Fault Tolerance, depending on the VMware version that you 
are running.

11g In the Location section, select Specify a datastore or datastore cluster, then click Browse.

11h Select a datastore, then click OK.

11i Click Next.

11j In the Virtual Device Node section, select SCSI (1:0) from the drop-down list.

IMPORTANT: Do not change the controller to VMware Paravirtual at this point of the 
installation process. 

If you want to change the SCSI controller to VMware Paravirtual: 

1. Finish the installation and power on the Filr system. 

2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, 
and log in as that user.)

3. Shut down each appliance in the Filr system. (For information about how to safely shut 
down an appliance, see “Shutting Down and Restarting the Novell Appliance” in the Filr 
2.0: Administration Guide.)
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4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the Filr system.

11k In the Mode section, select Independent, select Persistent, then click Next.

11l Click Finish.

12 Create a separate VMware hard disk (Hard Disk 3) for the appliance. This hard disk is used to 
store the /var directory for the appliance. (The /var directory is where system events for the 
Novell appliances are logged.)

12a In the Virtual Machine Properties window, on the Hardware tab, click Add.

12b Select Hard Disk, then click Next.

12c Leave Create a new virtual disk selected, then click Next.

12d In the Disk Size field, specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 20 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

12e In the Disk Provisioning section, select either Thick Provision Eager Zeroed or Support 
clustering features such as Fault Tolerance, depending on the VMware version that you 
are running.

12f In the Location section, select Specify a datastore or datastore cluster, then click Browse.

12g Select a datastore, then click OK.

12h Click Next.

12i In the Virtual Device Node section, select SCSI (2:0) from the drop-down list.

IMPORTANT: Do not change the controller to VMware Paravirtual at this point of the 
installation process. 

If you want to change the SCSI controller to VMware Paravirtual: 

1. Finish the installation and power on the Filr system. 

2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, 
and log in as that user.)

3. Shut down each appliance in the Filr system. (For information about how to safely shut 
down an appliance, see “Shutting Down and Restarting the Novell Appliance” in the Filr 
2.0: Administration Guide.)

4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the Filr system.

12j Leave the Mode section blank, then click Next.

You do not need to select anything in this section, because unlike Hard Disk 2, this hard 
disk does not need to be carried over on an upgrade.

12k Click Finish.

13 For a clustered Filr deployment, you must create a shared storage location (/vashare) for 
shared storage among all Filr appliances in the cluster.

For a large Filr deployment with only one Filr appliance, it is still recommended that you create 
a shared storage location, because having a shared storage location allows you to easily scale 
your system in the future if the need arises by adding additional Filr appliances.

For a small Filr deployment, you do not configure shared storage.
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You can configure Shared storage either on a remote Linux server via NFS or on a remote 
Windows server via CIFS.

For information about how to set up remote NFS for the Filr shared storage location, see 
Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage Location,” on 
page 149.

14 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

14a In the Virtual Machine Properties window, on the Hardware tab, click Add.

The Add Hardware dialog box is displayed.

14b Select Ethernet Adapter, then click Next.

14c In the Network Connection section, select the secondary network associated with the Filr 
installation.

14d Click Next > Finish.

15 Increase the amount of memory that VMware allocates for the Filr appliance. 

The default of 8 GB is the recommended minimum amount of memory for a large deployment. 
Novell also recommends 2 CPUs. 

For an all-in-one deployment, you should increase the default to at least 12 GB of memory and 4 
CPUs.

Small deployments require more CPUs and memory because in a small deployment, all 
components are running on a single virtual machine.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in “Changing 
the JVM Configuration Settings” in the Filr 2.0: Administration Guide.

At least half of the memory should be dedicated to the Java heap. You cannot adjust the Java 
heap until after the appliance is installed.

15a In the Virtual Machine Properties window, select Memory, then increase the setting to a 
suitable size for your environment.

15b Click OK to exit the Virtual Machine Properties window.

16 (Optional) Upgrade the virtual machine hardware version to the latest that your infrastructure can 
support. To do so, in the vSphere client, right-click the virtual machine that you just created, and 
for which you want to upgrade the hardware, then click Upgrade Virtual Hardware.

17 Power on the appliance (virtual machine).

IMPORTANT: Do not power on the appliance until you have created a separate VMware hard 
disk for the appliance, as described in Step 11.

18 (Optional) Install VMware Tools on the host server.

19 Continue with Section 3.1.2, “Installing the Filr Appliance,” on page 47.
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Hyper-V Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use Windows Remote Desktop to log in to the host server from a remote workstation.

2 Create a new directory in the location where you want each virtual machine to reside (for 
example, C:\Users\Public\Documents\Hyper-V\Virtual Hard Disks). In a later step, you 
will download the Filr software to this directory. 

As a best practice, give this directory the same name as the name that you plan to use for your 
Filr virtual appliance. For example, if you plan to name the Filr appliance Filr1, the name of this 
new directory should also be Filr1.

3 Download the Filr software (Filr.x86_64-version.vhd.zip) to the directory on the host server 
that you created in Step 2.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

4 Extract the Filr.x86_64-version.vhd.zip file to the directory on the host server that you 
created in Step 2.

5 Open the Hyper-V Manager.

6 In Hyper-V Manager, right-click the disk name in the Action Pane in the left column of the Hyper-
V Manager window. This is the disk where you want to create the new virtual machine. Then 
click New > Virtual Machine.

The New Virtual Machine Wizard is displayed.

7 Review the Before You Begin page, then click Next.

8 In the Name field, specify a name for the new virtual machine. For example, Filr1.

9 Click Next.

10 (Conditional) If your host server is Windows Server 2012 R2, the Specify Generation page is 
displayed. This page allows specify the generation of the virtual machine. You must select 
Generation 1, then click Next.

IMPORTANT: If you do not select Generation 1 and you select Generation 2 instead, the Filr 
virtual machine cannot be deployed.

11 In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual 
machine. 8 GB (8192 MB) is the recommended minimum for a large deployment of Filr. Novell 
also recommends 2 CPUs.

For an all-in-one (small) deployment, you should increase the default to at least 12 GB (12288 
MB) of memory and 4 CPUs.

Small deployments require more CPUs and memory because in a small deployment, all 
components are running on a single virtual machine.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in “Changing 
the JVM Configuration Settings” in the Filr 2.0: Administration Guide. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the Java 
heap until after the appliance is installed.

12 Click Next.

13 On the Configure Networking page, select the networking card of your choice, then click Next.
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14 Configure the bootable disk image:

14a On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then 
browse to the .vhd file that was in the downloaded .zip file that you extracted in Step 4.

14b Click Open to select the file, then click Next.

15 Click Finish.

16 Create a separate Hyper-V hard disk (Hard Disk 2) for the appliance. This is the location where 
you will store your Filr files (files that are located in users’ My Files area).

IMPORTANT: If you do not create a separate Hyper-V hard disk as described here, you cannot 
upgrade to a new version of Filr.

16a In Hyper-V Manager, right-click the virtual machine that you just created, then click 
Settings.

16b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

16c Select Virtual hard disk, then click New.

16d Review the Before You Begin page, then click Next.

16e On the Choose Disk Format page, select VHD, then click Next.

16f On the Choose Disk Type page, select Fixed size, then click Next.

16g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, FilrDisk2.

Location: Specify the location where you want the hard drive to be located. 

16h On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size 
for the hard disk. The recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

16i Click Next.

16j Review the summary information, then click Finish > OK.

17 Create a separate Hyper-V hard disk (Hard Disk 3) for the appliance. This hard disk is used to 
store the /var directory for the appliance. (The /var directory is where system events for the 
Novell appliances are logged.)

17a In Hyper-V Manager, right-click the virtual machine for which you want to create a new hard 
disk, then click Settings.

17b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

17c Select Virtual hard disk, then click New.

17d Review the Before You Begin page, then click Next.

17e On the Choose Disk Format page, select VHD, then click Next.

17f On the Choose Disk Type page, select Fixed size, then click Next.

17g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, FilrDisk3.

Location: Specify the location where you want the hard drive to be located. 

17h On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size 
for the hard disk. The recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.
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17i Click Next.

17j Review the summary information, then click Finish > OK.

18 For a clustered Filr deployment, you must create a shared storage location (/vashare) for 
shared storage among all Filr appliances in the cluster.

For a large Filr deployment with only one Filr appliance, it is still recommended that you create 
a shared storage location, because having a shared storage location allows you to easily scale 
your system in the future if the need arises by adding additional Filr appliances.

For a small Filr deployment, you do not configure shared storage.

You can configure Shared storage either on a remote Linux server via NFS or on a remote 
Windows server via CIFS.

For information about how to set up remote NFS for the Filr shared storage location, see 
Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage Location,” on 
page 149.

19 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

19a In Hyper-V Manager, right-click the virtual machine for which you want to create an 
additional NIC, then click Settings.

19b In the Hardware section, select Add Hardware, select Network Adapter, then click Add.

19c Specify the desired settings for the new network adapter.

Select the secondary network associated with the Filr installation.

19d Click OK.

20 Right-click the virtual machine, then click Start.

IMPORTANT: Do not start the appliance until you have created a separate Hyper-V hard disk for 
the appliance, as described in Step 16.

21 Right-click the virtual machine, then click Connect.

22 Continue with Section 3.1.2, “Installing the Filr Appliance,” on page 47.

Xen Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on 
Linux:

ssh -X root@host_ip_address

You must use the -X in the command in order to display the GUI installation program. The steps 
in this section use the GUI installation program to configure the server.

2 Navigate to the /var/lib/xen/images directory on the host server.

3 Create a new directory inside the images directory where you can download the Filr software. 
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The name of this directory must be the same as the name that you plan to use for your Filr virtual 
appliance. For example, if you plan to name the Filr appliance Filr1, the name of this new 
directory must also be Filr1.

4 Change to the directory that you just created. For example, /var/lib/xen/images/Filr1.

5 Download the Filr software (Filr.x86_64-version.xen.tar.gz) to the current directory on the 
host server. For example: /var/lib/xen/images/Filr1.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

6 Untar the Filr.x86_64-version.xen.tar.gz file in the directory where you downloaded it.

You can use the following command to untar the file:

tar -Sxvzf Filr.x86_64-version.xen.tar.gz

A filr-version directory is created; it contains a .raw file that you will use to run the virtual 
image. This process can take a few minutes.

7 From the host server, run the following command to launch the GUI configuration menu:

vm-install

The Create a Virtual Machine wizard is displayed.

8 Click Forward.

9 Select I have a disk or disk image with an installed operating system, then click Forward.

10 Leave SUSE Linux Enterprise Server 11 selected, then click Forward.

11 Rename the virtual machine by clicking Name of Virtual Machine and specifying a new name in 
the Name field. Then click Apply. For example, Filr1.

12 Configure the amount of memory and number of CPUs that Xen allocates for the Filr appliance. 

12a On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of memory that is available on the host server.

Initial Memory: 8 GB is the recommended minimum amount of memory for a large 
deployment.

For an all-in-one deployment, you should increase the default to at least 12 GB of memory.

Small deployments require more memory because in a small deployment, all components 
are running on a single virtual machine.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in 
“Changing the JVM Configuration Settings” in the Filr 2.0: Administration Guide. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the 
Java heap until after the appliance is installed.

Maximum Memory: Set this to the same value that you set for Initial Memory.

Available Processors: Displays the number of available processors on the host server.

Virtual Processors: Specify 2 CPUs for a large deployment and 4 CPUs for a small 
deployment. At least half of the memory should be dedicated to the Java heap. (Java heap 
is set in the Filr configuration.)

Small deployments require more CPUs because in a small deployment, all components are 
running on a single virtual machine.

12b Click Apply.
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13 Configure the bootable disk image:

13a On the Summary page, click Disks.

13b Click Harddisk.

13c On the Virtual Disk page, specify the following information:

Source: Click Browse, then browse to the .raw file that you untarred in Step 6.

Protocol: Select file:.

Size (GB): The default size is 20 GB. This cannot be changed.

Create Sparse Image File: This option is not available.

Read-Only Access: Do not select this option.

13d Click OK.

14 Create a separate Xen hard disk (Hard Disk 2) for the appliance. This is the location where you 
will store your Filr files (files that are located in users’ My Files area).

IMPORTANT: If you do not create a separate Xen hard disk as described here, you cannot 
upgrade to a new version of Filr.

14a On the Disks page, click Harddisk.

14b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the .raw file that will be created when 
the virtual machine is created. If desired, you can rename the disk in the source field from 
disk0 to a name of your choosing.

Protocol: Select file:.

Size (GB): Specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

14c Click OK.

15 Create a separate Xen hard disk (Hard Disk 3) for the appliance. This hard disk is used to store 
the /var directory for the appliance. (The /var directory is where system events for the Novell 
appliances are logged.)

15a On the Disks page, click Harddisk.

15b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the .raw file that will be created when 
the virtual machine is created. If desired, you can rename the disk in the source field from 
disk0 to a name of your choosing.

Protocol: Select file:.

Size (GB): Specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

16 Click OK > Apply.
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17 For a clustered Filr deployment, you must create a shared storage location (/vashare) for 
shared storage among all Filr appliances in the cluster.

For a large Filr deployment with only one Filr appliance, it is still recommended that you create 
a shared storage location, because having a shared storage location allows you to easily scale 
your system in the future if the need arises by adding additional Filr appliances.

For a small Filr deployment, you do not configure shared storage.

You can configure Shared storage either on a remote Linux server via NFS or on a remote 
Windows server via CIFS.

For information about how to set up remote NFS for the Filr shared storage location, see 
Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage Location,” on 
page 149.

18 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

18a On the Summary page, click Network Adapters.

18b Click New, then specify the desired settings for the new network adapter.

Select the secondary network associated with the Filr installation.

18c Click Apply > Apply.

19 Click OK to save your changes and to create and power on the virtual machine.

IMPORTANT: Do not power on the appliance until you have created a separate Xen hard disk 
for the appliance, as described in Step 14.

20 Continue with Section 3.1.2, “Installing the Filr Appliance,” on page 47.

Citrix Xen Configuration

Do the following in order.

1 Expand the .xva.tar.gz file.

2 From the Citrix XenCenter, connect to a Citrix 6.5 or 6.5 SP1 XenServer.

3 Import the .xva file.

4 Assign two disks to the imported virtual appliance.

5 Modify the CPU and memory settings as required for your environment.

6 Start the VA.

7 Install the xs-tools and optimize according to the needs of your environment.

8 Continue with Section 3.1.2, “Installing the Filr Appliance,” on page 47.
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3.1.2 Installing the Filr Appliance

1 After you have downloaded the Filr appliance, configured the virtual environment, and powered 
on the appliance, click the Console tab. 

2 After the appliance starts, select your preferred keyboard layout in the Keyboard Language 
drop-down, then accept the license agreement. (You can change the language that the license 
agreement is displayed in from the License Language drop-down.)

The Appliance Passwords and Time Zone page appears.

3 On the configuration page, specify the following information:

Root password and confirmation: The root password for your Filr appliance. The root user 
name is case sensitive and should not be capitalized.

Vaadmin password and confirmation: The preferred user to use when logging in to the 
appliance. The user name is case sensitive and should not be capitalized.

When configuring passwords for the vaadmin user for multiple appliances in a large installation, 
consider using different passwords between appliances for enhanced security.

NTP Server: The IP address or DNS name of the reliable external Network Time Protocol (NTP) 
server that your OES server uses. For example, time.example.com.

For the best results, set up NTP in accordance with the VMware best practices guidelines (http:/
/kb.vmware.com/selfservice/microsites/
search.do?language=en_US&cmd=displayKC&externalId=1006427).

Region: Your local region.

Time Zone: Your local time zone.

The time zone of your Filr server should match the time zone of all file servers that Filr will point 
to via Net Folders.

After installation, if you are not able to access the appliance and you need to change any of 
these settings, you can use the VACONFIG utility from the Filr command prompt. For more 
information, see “Using VACONFIG to Modify Network Information” in the Filr 2.0: Administration 
Guide.

4 Click Next.
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5 On the Network Settings page, specify the following network information:

Hostname: The fully qualified DNS host name associated with the appliance’s IP address. For 
example, myFilr.mynetwork.example.com.

IP Address: The static IP address for the appliance. For example, 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP address. For example, 
255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your Filr virtual appliance is 
located. For example, 172.17.2.254.

In a clustered environment, Filr appliances are not tolerant to latency, and should exist in the 
same subnet or near-subnet.

DNS Servers: The IP address of a primary DNS server for your network. For example, 
172.17.1.1.

Domain Search: The domain that is associated with the Filr host name.

6 Click Next.

7 (Conditional) If you configured multiple NICs (as described in Section 3.1.1, “Downloading the 
Filr Appliance and Configuring the Virtual Environment,” on page 37), select from the following 
options, then click Next:

 Do Not Configure: Select this option to configure this network at a later time. If you do not 
currently know your network information, you can configure the network after installation, as 
described in “Changing Network Settings” in the Filr 2.0: Administration Guide.

 DHCP Dynamic Address: Select this option to dynamically assign an IP address to this 
network.

 Statically Assigned IP Address: Select this option to assign a static IP address to this 
network, then specify the IP address, network mask, and host name.

8 The secondary hard disk for /vastorage that you created for this appliance is automatically 
detected and sdb is displayed as the hard drive. Accept the defaults for the other options on this 
page, then click Next.

This is the location (/vastorage) where information specific to the appliance is stored and is 
used when the appliance is upgraded. Each appliance has its own /vastorage location.

If you have not already assigned a second hard disk to the virtual machine (as described in 
“Downloading the Filr Appliance and Configuring the Virtual Environment” on page 37), power off 
the virtual machine, modify the virtual machine settings to add a hard disk, then power on the 
virtual machine.

For more information about the type of data that is stored here, see “Data Storage for the 
Appliance” on page 11.

9 The third hard disk for /var that you created for this appliance is automatically detected and sdc 
is displayed as the hard drive. Accept the defaults for the other options on this page, then click 
Next.

This is the location where the /var directory for the appliance is stored. (The /var directory is 
where system events for the Novell appliances are logged.)

If you have not already assigned a third hard disk to the virtual machine (as described in 
“Downloading the Filr Appliance and Configuring the Virtual Environment” on page 37), power off 
the virtual machine, modify the virtual machine settings to add a hard disk, then power on the 
virtual machine.

For more information about the type of data that is stored here, see “Data Storage for the 
Appliance” on page 11.
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10 In a large or clustered deployment, select the shared storage location (remote NFS or remote 
CIFS). This storage (/vashare) is shared storage among all of the Filr appliances in the cluster. 
There is only one /vashare storage location that is used by all Filr appliances in the cluster. 

IMPORTANT: You must select a shared storage location in a clustered deployment (if your Filr 
system contains multiple Filr appliances). 

It is recommended that you select a shared storage location in a large deployment with only one 
Filr appliance. This ensures that you can scale your system in the future if the need arises by 
adding additional Filr appliances.

In a small deployment, select Do Not Configure Shared Storage.

 Remote NFS: Select this option for all large or clustered deployments for which you want to 
configure shared storage on remote NFS. You must export the remote directory before you 
choose this option. Also, set the rw and no_root_squash options on the remote directory.

IMPORTANT: Before you choose this option, understand the following: 

 You must configure NFS on the remote linux server by setting the rw and 
no_root_squash options on the remote directory.

For detailed information about how to configure NFS, see Section C.1, “Setting Up 
Remote NFS for the Filr Shared Storage Location,” on page 149.

 Filr does not support using an NSS volume as an exported NFS mount point.

 Remote NFS is not supported when hosted on a Windows server.

 Remote CIFS: Select this option for all large or clustered deployments for which you want 
to configure shared storage on a remote Windows share. If you select this option, skip to 
Step 12.

For detailed information about how to configure CIFS, see Section C.2, “Setting Up Remote 
CIFS for the Filr Shared Storage Location,” on page 150.

 Do Not Configure Shared Storage: You must choose this option if you are creating a 
small deployment where all components are part of a single appliance, then skip to Step 13.

Do not select this option with a clustered Filr deployment. This option is recommended only 
for a small deployment, but can be selected for a large (non-clustered) deployment if you do 
not plan to add Filr appliances in the future.

For more information about possible configurations when running Filr in a clustered environment, 
see Section 2.1.2, “Large Deployment,” on page 28.

11 (Conditional) If you are configuring Filr for a clustered environment with remote NFS: 

11a Click Next.

11b Specify the following options:

NFS Server Hostname: Specify the host name of the NFS server. This is the remote Linux 
server or the MySQL appliance that you previously configured for NFS (as described in 
Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage 
Location,” on page 149). Windows servers are not supported.

Remote Directory: Specify the path to the remote directory.

When using a remote Linux server for the NFS location (as described in Appendix C, 
“Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage Location,” on 
page 149), specify the path on the remote NFS server.
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12 (Conditional) If you are configuring Filr for a clustered environment with remote CIFS: 

12a Click Next.

12b Specify the following options:

CIFS Folder: Specify the path to the CIFS share.

For example, \\server\share.

CIFS User Name: Specify the user name for accessing the CIFS share.

CIFS User Password: Specify the password for the user that is accessing the CIFS share.

13 Click Configure.

A message indicating that the installation was successful is displayed.

14 (Conditional) If you are performing a large deployment with multiple Filr appliances, install 
another Filr appliance as described in this section, until you have installed your desired number 
of Filr appliances.

You cannot install multiple Filr appliances in a small deployment.

15 Continue with the first-time configuration, as described in the following section.

3.2 Configuring a Small Deployment for the First Time
After you install the Novell Filr appliance and configure the network settings as described earlier, you 
are ready to configure the Filr appliance for the first time. This configuration process uses a quick 
wizard that gets your Filr system up and running. You can then make further configuration decisions, 
as described in “Configuring and Maintaining the Filr Appliance” in the Filr 2.0: Administration Guide.

To configure the Filr appliance for a small deployment:

1 After you have installed the Novell Filr appliance, as described in Section 3.1, “Installing the Filr 
Appliance,” on page 37, navigate to the following URL from a web browser:

https://ip_address_or_DNS:9443

Use the IP address or DNS name of the server that you specified during the appliance 
installation.

2 Log in to the appliance using the vaadmin user and the password that you set.

The Novell Filr Appliance landing page is displayed.
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3 Click the Filr Appliance Configuration icon.

The Filr Configuration Wizard displays.

4 Select Small Deployment, then click Next.

5 On the Database page, create a password for the MySQL administrator.

If you need to change this password at a later time, you must use the native MySQL tools to do 
so.

6 Click Next.

7 In the Default Locale field, select the default locale for your Filr site. This is the language and 
locale that Filr uses when users first log in to the Filr site.

Users can change the individual locale after they log in by modifying the user profile, as 
described in “Modifying Your Profile” in the Filr 2.0: Web Application User Guide.

Some aspects of the Filr interface, such as group names and the login page, are always 
displayed in the default language, regardless of individual user settings. For more information, 
see “Understanding the Filr Site Default Language” in the Filr 2.0: Administration Guide.

The default language that the Filr mobile app and the Filr desktop application are displayed in is 
defined by the language set on the mobile device and the user workstation where the application 
is running.

8 (Optional) As a security precaution, it might make sense to change the administrator’s user ID 
from the default admin. The administrator user ID is used only when logging in to the Filr system 
at port 8443.

In the Administrator User ID field, specify a new user ID for the Filr administrator.

IMPORTANT: If you change the administrator user ID, the password that you use to log in to the 
Filr system for the first time is also changed to match the user ID that you specify.
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9 Click Finish.

After the configuration is complete, a summary is displayed. 

This configuration summary contains information such as network, database, and so forth. You 
can modify these configuration settings at any time from the Configuration column on the left 
side of this page.

For information about each configuration option, see “Configuring and Maintaining the Filr 
Appliance” in the Filr 2.0: Administration Guide.

10 Continue with Chapter 7, “Setting Up the Filr Site,” on page 101 to make your site ready for user 
access.
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4 4Creating a Large Deployment

In a large deployment, the Filr software, the MySQL database, and the search index each runs as a 
separate appliance. This allows each component to have access to more server memory, disk space, 
and CPU resources.

For a large deployment, you need to do the following:

1. Install two search index appliances, as described in Section 4.1, “Installing the Search Index 
Appliance,” on page 53. (Two search index appliances are recommended in order to provide 
fault tolerance or backup in the event that one index server fails.)

2. Install either the MySQL database appliance or configure Filr to use your organization’s existing 
MySQL, MariaDB, or Microsoft SQL database server. (Using your organization’s existing SQL 
database server is recommended for enterprise installations.)

For information about how to configure Filr to use an existing database, see Section 4.3, 
“Configuring an Existing Database Server,” on page 76.

For information about how to install the MySQL database appliance, see Section 4.2, “Installing 
the MySQL Database Appliance,” on page 65.

3. Install one or more Filr appliances, as described in Section 4.4, “Installing the Filr Appliance,” on 
page 79.

4. Configure the large deployment, as described in Section 4.5, “Configuring a Large Deployment 
for the First Time,” on page 92.

NOTE: Before you begin the installation:

 Ensure that the server requirements in Section 1.2.1, “Filr Server Requirements,” on page 13 
have been met.

 Ensure that you have read and understand Chapter 1, “Overview,” on page 9.

The following sections describe how to create a large Filr deployment:

 Section 4.1, “Installing the Search Index Appliance,” on page 53

 Section 4.2, “Installing the MySQL Database Appliance,” on page 65

 Section 4.3, “Configuring an Existing Database Server,” on page 76

 Section 4.4, “Installing the Filr Appliance,” on page 79

 Section 4.5, “Configuring a Large Deployment for the First Time,” on page 92

4.1 Installing the Search Index Appliance
 Section 4.1.1, “Downloading the Search Index Appliance and Configuring the Virtual 

Environment,” on page 54

 Section 4.1.2, “Installing the Search Index Appliance,” on page 62
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4.1.1 Downloading the Search Index Appliance and Configuring 
the Virtual Environment

You need to download the search index appliance and configure the virtual environment where you 
plan to run the appliance. This includes configuring system resources and so forth.

The process of downloading the search index appliance and configuring the virtual environment 
differs depending on which virtual environment you plan to use to run the search index appliance.

 “VMware Configuration” on page 54

 “Hyper-V Configuration” on page 56

 “Xen Configuration” on page 59

 “Citrix Xen Configuration” on page 61

VMware Configuration

1 Download the search appliance software (Filrsearch-version.ovf.zip) to your management 
workstation.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

2 Extract the Filrsearch.x86-64-version.ovf.zip file on your management workstation until 
the Filrsearch-version file folder appears.

3 In the vSphere client, click File > Deploy OVF Template.

4 Browse to and select the .ovf file in the Filrsearch.x86-64-version file folder.

5 Click Next.

6 Click Next again.

7 In the Name field, rename the Filr appliance to a name of your choosing, then click Next.

8 Select the datastore where you want to store the virtual machine files, then click Next.

9 Click Next to accept the default for the disk format.

10 Click Finish.

11 Create a separate VMware hard disk (Hard Disk 2) for the appliance. This hard disk is used to 
store configuration files that are used for appliance upgrades. 

IMPORTANT: If you do not create a separate VMware hard disk as described here, you cannot 
upgrade to a new version of the appliance.

11a In the vSphere client, right-click the virtual machine that you just created, and for which you 
want to create secondary storage, then click Edit Settings.

The Virtual Machine Properties page is displayed.

11b On the Hardware tab, click Add.

The Add Hardware dialog box is displayed.

11c Select Hard Disk, then click Next.

11d Leave Create a new virtual disk selected, then click Next.

11e Specify the amount of hard disk space that you want to allocate. The recommended 
minimum differs depending on the nature of your Filr environment.
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To see a formula to calculate the storage requirement for your environment, see “Search 
Index Appliance Storage” on page 21.

11f In the Disk Provisioning section, select either Thick Provision Eager Zeroed or Support 
clustering features such as Fault Tolerance, depending on the VMware version that you 
are running.

11g In the Location section, select Specify a datastore or datastore cluster, then click Browse.

11h Select a datastore, then click OK.

11i Click Next.

11j In the Virtual Device Node section, select SCSI (1:0) from the drop-down list.

IMPORTANT: Do not change the controller to VMware Paravirtual at this point of the 
installation process. 

If you want to change the SCSI controller to VMware Paravirtual: 

1. Finish the installation and power on the Filr system. 

2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, 
and log in as that user.)

3. Shut down each appliance in the Filr system. (For information about how to safely shut 
down an appliance, see “Shutting Down and Restarting the Novell Appliance” in the Filr 
2.0: Administration Guide.)

4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the Filr system.

11k In the Mode section, select Independent, select Persistent, then click Next.

11l Click Finish.

12 Create a separate VMware hard disk (Hard Disk 3) for the appliance. This hard disk is used to 
store the /var directory for the appliance. (The /var directory is where system events for the 
Novell appliances are logged.)

12a In the Virtual Machine Properties window, on the Hardware tab, click Add.

12b Select Hard Disk, then click Next.

12c Leave Create a new virtual disk selected, then click Next.

12d In the Disk Size field, specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 20 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

12e In the Disk Provisioning section, select either Thick Provision Eager Zeroed or Support 
clustering features such as Fault Tolerance, depending on the VMware version that you 
are running.

12f In the Location section, select Specify a datastore or datastore cluster, then click Browse.

12g Select a datastore, then click OK.

12h Click Next.

12i In the Virtual Device Node section, select SCSI (2:0) from the drop-down list.

IMPORTANT: Do not change the controller to VMware Paravirtual at this point of the 
installation process. 

If you want to change the SCSI controller to VMware Paravirtual: 

1. Finish the installation and power on the Filr system. 
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2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, 
and log in as that user.)

3. Shut down each appliance in the Filr system. (For information about how to safely shut 
down an appliance, see “Shutting Down and Restarting the Novell Appliance” in the Filr 
2.0: Administration Guide.)

4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the Filr system.

12j Leave the Mode section blank, then click Next.

You do not need to select anything in this section, because unlike Hard Disk 2, this hard 
disk does not need to be carried over on an upgrade.

12k Click Finish.

13 (Optional) Add an additional Network Interface Controller (NIC).

13a In the Virtual Machine Properties window, on the Hardware tab, click Add.

The Add Hardware dialog box is displayed.

13b Select Ethernet Adapter, then click Next.

13c In the Network Connection section, select the secondary network associated with the Filr 
installation.

13d Click Next > Finish.

14 Increase the amount of memory that VMware allocates for the appliance. 

The default is 8 GB. Novell also recommends 2 CPUs.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in “Changing 
the JVM Configuration Settings” in the Filr 2.0: Administration Guide. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the Java 
heap until after the appliance is installed.

14a In the Virtual Machine Properties window, select Memory, then increase the setting to a 
suitable size for your environment.

14b Click OK to exit the Virtual Machine Properties window.

15 Power on the appliance (virtual machine).

IMPORTANT: If you are planning to use a separate VMware hard disk to store your Filr files, do 
not power on the appliance until you have created the hard disk, as described in Step 11.

16 Continue with “Installing the Search Index Appliance” on page 62.

Hyper-V Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use Windows Remote Desktop to log in to the host server from a remote workstation.

2 Create a new directory in the location where you want each virtual machine to reside (for 
example, C:\Users\Public\Documents\Hyper-V\Virtual Hard Disks). In a later step, you 
will download the Filr software to this directory. 

As a best practice, give this directory the same name as the name that you plan to use for your 
Filr virtual appliance. For example, if you plan to name the Filr appliance FilrSearch1, the 
name of this new directory should also be FilrSearch1.
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3 Download the Filr software (Filrsearch.x86-64-version.vhd.zip) to the directory on the 
host server that you created in Step 2.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

4 Extract the Filrsearch.x86-64-version.vhd.zip file to the directory on the host server that 
you created in Step 2.

5 Open the Hyper-V Manager.

6 In Hyper-V Manager, right-click the disk name in the Action Pane where you want to create the 
new virtual machine, then click New > Virtual Machine.

The New Virtual Machine Wizard is displayed.

7 Click Next after you have reviewed the Before You Begin page.

8 In the Name field, specify a name for the new virtual machine. For example, FilrSearch1.

9 Click Next.

10 In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual 
machine. The default is 8 GB. Novell also recommends 2 CPUs.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in “Changing 
the JVM Configuration Settings” in the Filr 2.0: Administration Guide. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the Java 
heap until after the appliance is installed.

11 Click Next.

12 On the Configure Networking page, select the networking card of your choice, then click Next.

13 Configure the bootable disk image:

13a On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then 
browse to the .vhd file that was in the downloaded .zip file that you extracted in Step 4.

13b Click Open to select the file, then click Next.

14 Click Finish.

15 Create a separate Hyper-V hard disk (Hard Disk 2) for the appliance. This hard disk is used to 
store configuration files that are used for appliance upgrades. 

IMPORTANT: If you do not create a separate Hyper-V hard disk as described here, you cannot 
upgrade to a new version of Filr.

15a In Hyper-V Manager, right-click the disk that you just created, then click Settings.

15b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

15c Select Virtual hard disk, then click New.

15d Review the Before You Begin page, then click Next.

15e On the Choose Disk Format page, select VHD, then click Next.

15f On the Choose Disk Type page, select Fixed size, then click Next.

15g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, FilrDisk2.

Location: Specify the location where you want the hard drive to be located. 
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15h On the Configure Disk page, select Create a new blank virtual hard disk, then specify the 
amount of hard disk space that you want to allocate. The recommended minimum differs 
depending on the nature of your Filr environment.

To see a formula to calculate the storage requirement for your environment, see “Search 
Index Appliance Storage” on page 21.

15i Click Next.

15j Review the summary information, then click Finish > OK.

16 Create a separate Hyper-V hard disk (Hard Disk 3) for the appliance. This hard disk is used to 
store the /var directory for the appliance. (The /var directory is where system events for the 
Novell appliances are logged.)

16a In Hyper-V Manager, right-click the virtual machine for which you want to create a new hard 
disk, then click Settings.

16b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

16c Select Virtual hard disk, then click New.

16d Review the Before You Begin page, then click Next.

16e On the Choose Disk Format page, select VHD, then click Next.

16f On the Choose Disk Type page, select Fixed size, then click Next.

16g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, FilrDisk3.

Location: Specify the location where you want the hard drive to be located. 

16h On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size 
for the hard disk. The recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

16i Click Next.

16j Review the summary information, then click Finish > OK.

17 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

17a In Hyper-V Manager, right-click the virtual machine for which you want to create an 
additional NIC, then click Settings.

17b In the Hardware section, select Add Hardware, select Network Adapter, then click Add.

17c Specify the desired settings for the new network adapter.

Select the secondary network associated with the Filr installation.

17d Click OK.

18 Right-click the virtual machine, then click Start.
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IMPORTANT: Do not start the appliance until you have created a separate Hyper-V hard disk for 
the appliance, as described in Step 15.

19 Right-click the virtual machine, then click Connect.

20 Continue with “Installing the Search Index Appliance” on page 62.

Xen Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on 
Linux:

ssh -X root@host_ip_address

You must use the -X in the command in order to display the GUI installation program. The steps 
in this section use the GUI installation program to configure the server.

2 Navigate to the /var/lib/xen/images directory on the host server.

3 Create a new directory inside the images directory where you can download the Filr software.

The name of this directory must be the same as the name that you plan to use for your Filr virtual 
appliance. For example, if you plan to name the Filr appliance FilrSearch1, the name of this 
new directory must also be FilrSearch1.

4 Change to the directory that you just created. For example, /var/lib/xen/images/
FilrSearch1.

5 Download the Filr software (Filrsearch.x86-64-version.xen.tar.gz) to the following 
directory on the host server:

/var/lib/xen/images

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

6 Untar the Filrsearch-version.xen.tar.gz file in the directory where you downloaded the file, 
as described in Step 5.

You can use the following command to untar the file:

tar -Sxvzf Filrsearch.x86-64-version.xen.tar.gz

A filr -version directory is created; it contains a .raw file that you will use to run the virtual 
image.

7 From the host server, run the following command to launch the GUI configuration menu:

vm-install

The Create a Virtual Machine wizard is displayed.

8 Click Forward.

9 Select I have a disk or disk image with an installed operating system, then click Forward.

10 Leave SUSE Linux Enterprise Server 11 selected, then click Forward.

11 Rename the virtual machine by clicking Name of Virtual Machine and specifying a new name in 
the Name field. Then click Apply. For example, FilrSearch1.

12 Configure the amount of memory that Xen allocates for the Filr appliance. 

12a On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of memory that is available on the host server.
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Maximum Memory: The default is 8 GB. Novell also recommends 2 CPUs.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in 
“Changing the JVM Configuration Settings” in the Filr 2.0: Administration Guide. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the 
Java heap until after the appliance is installed.

Virtual Processors: Specify 2 CPUs. At least half of the memory should be dedicated to 
the Java heap.

12b Click Apply.

13 Configure the bootable disk image:

13a On the Summary page, click Disks.

13b Click Harddisk.

13c On the Virtual Disk page, specify the following information:

Source: Click Browse, then browse to the .raw file that you untared in Step 6.

Protocol: Select file:.

Size (GB): The default size is 20 GB. This cannot be changed.

Create Sparse Image File: This option is not available.

Read-Only Access: Do not select this option.

13d Click OK.

14 Create a separate Xen hard disk (Hard Disk 2) for the appliance. This hard disk is used to store 
configuration files that are used for appliance upgrades. 

IMPORTANT: If you do not create a separate Xen hard disk as described here, you cannot 
upgrade to a new version of Filr.

14a On the Summary page, click Disks.

14b Click Harddisk.

14c On the Virtual Disk page, specify the following information:

Source: Click Browse, then browse to the location of a datastore where you want Filr files 
to be stored.

Protocol: Select file:.

Size (GB): Specify the amount of hard disk space that you want to allocate. The 
recommended minimum differs depending on the nature of your Filr environment.

To see a formula to calculate the storage requirement for your environment, see “Search 
Index Appliance Storage” on page 21.

For more detailed information about the type of information that is stored here, see “Search 
Index Appliance Storage” on page 21.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

14d Click OK.
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15 Create a separate Xen hard disk (Hard Disk 3) for the appliance. This hard disk is used to store 
the /var directory for the appliance. (The /var directory is where system events for the Novell 
appliances are logged.)

15a On the Disks page, click Harddisk.

15b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the .raw file that will be created when 
the virtual machine is created. If desired, you can rename the disk in the source field from 
disk0 to a name of your choosing.

Protocol: Select file:.

Size (GB): Specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

16 Click OK > Apply.

17 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

17a On the Summary page, click Network Adapters.

17b Click New, then specify the desired settings for the new network adapter.

Select the secondary network associated with the Filr installation.

17c Click Apply > Apply.

18 Click OK to save your changes and to create the virtual machine.

19 Power on the appliance (virtual machine).

IMPORTANT: Do not power on the appliance until you have created a separate Xen hard disk 
for the appliance, as described in Step 14.

20 Continue with “Installing the Search Index Appliance” on page 62.

Citrix Xen Configuration

Do the following in order.

1 Expand the .xva.tar.gz file.

2 From the Citrix XenCenter, connect to a Citrix 6.5 or 6.5 SP1 XenServer.

3 Import the .xva file.

4 Assign two disks to the imported virtual appliance.

5 Modify the CPU and memory settings as required for your environment.
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6 Start the VA.

7 Install the xs-tools and optimize according to the needs of your environment.

8 Continue with “Installing the Search Index Appliance” on page 62.

4.1.2 Installing the Search Index Appliance

 “Configuring and Starting the Search Appliance” on page 62

 “Creating a Search Appliance Cluster (Recommended)” on page 63

 “Setting a Password on Each Search Appliance” on page 63

Configuring and Starting the Search Appliance

1 After you have downloaded the search index appliance, configured the virtual environment, and 
powered on the appliance, click the Console tab. 

2 After the appliance starts, select your preferred keyboard layout in the Keyboard Language 
drop-down, then accept the license agreement. (You can change the language that the license 
agreement is displayed in from the License Language drop-down.)

3 Specify the following information:

Root password and confirmation: The root password for your search index appliance.

Vaadmin password and confirmation: The password for the vaadmin user.

NTP Server: The IP address or DNS name of the reliable external Network Time Protocol (NTP) 
server your OES server uses. For example, time.example.com.

Region: Your local region.

Time Zone: Your local time zone.

After installation, if you are not able to access the appliance through a browser and you need to 
change any of these settings, you can use the VACONFIG utility from the command prompt. For 
more information, see “Using VACONFIG to Modify Network Information” in the Filr 2.0: 
Administration Guide.

4 Click Next.

5 Specify the following network information:

Hostname: The fully qualified DNS host name associated with the appliance’s IP address. For 
example, myFilr.mynetwork.example.com.

IP Address: The static IP address for the appliance. For example, 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP address. For example, 
255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your Filr virtual appliance is 
located. For example, 172.17.2.254.

DNS Servers: The IP address of a primary DNS server for your network. For example, 
172.17.1.1.

Domain Search: The domain that is associated with the Filr host name.

6 Click Next.
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7 (Conditional) If you configured multiple NICs (as described in Section 4.1.1, “Downloading the 
Search Index Appliance and Configuring the Virtual Environment,” on page 54), select from the 
following options, then click Next:

 Do Not Configure: Select this option to configure this network at a later time. If you do not 
currently know your network information, you can configure the network after installation, as 
described in “Changing Network Settings” in the Filr 2.0: Administration Guide.

 DHCP Dynamic Address: Select this option to dynamically assign an IP address.

 Statically Assigned IP Address: Select this option to assign a static IP address to this 
appliance, then specify the IP address, network mask, and host name.

8 The secondary hard disk for /vastorage that you created for this appliance is automatically 
detected and sdb is displayed as the hard drive. Accept the defaults for the other options on this 
page, then click Next.

This is the location (/vastorage) where information specific to the appliance is stored and is 
used when the appliance is upgraded. Each appliance has its own /vastorage location.

If you have not already assigned a second hard disk to the virtual machine (as described in 
“Downloading the Search Index Appliance and Configuring the Virtual Environment” on 
page 54), click Power Off Virtual Machine, modify the virtual machine settings to add a hard 
disk, then power on the virtual machine.

For more information about the type of data that is stored here, see “Data Storage for the 
Appliance” on page 11.

9 The third hard disk for /var that you created for this appliance is automatically detected and sdc 
is displayed as the hard drive. Accept the defaults for the other options on this page, then click 
Configure.

This is the location where the /var directory for the appliance is stored. (The /var directory is 
where system events for the Novell appliances are logged.)

If you have not already assigned a third hard disk to the virtual machine (as described in 
“Downloading the Search Index Appliance and Configuring the Virtual Environment” on 
page 54), click Power Off Virtual Machine, modify the virtual machine settings to add a hard 
disk, then power on the virtual machine.

For more information about the type of data that is stored here, see “Data Storage for the 
Appliance” on page 11.

The appliance might take a few minutes to install. When the installation is complete, you see a 
message indicating that the appliance is now ready to configure.

Creating a Search Appliance Cluster (Recommended)

1 Create a two-node cluster of Search appliances (no more than two is recommended). Having 
two Search appliances provides fault tolerance or backup in the event that one index server fails.

Install another search appliance, as described in Section 4.1, “Installing the Search Index 
Appliance,” on page 53).

Setting a Password on Each Search Appliance

Set a password for each search appliance. You can also change other configuration settings if 
desired. 

1 After installing the search index appliance, open a browser and navigate to the following URL:

https://ip_address:9443

Replace ip_address with the IP address of your search index appliance.
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2 Sign in to the search index appliance using the vaadmin user and the password that you set 
during installation.

The Novell Filr Search Appliance landing page is displayed.

3 Click the Filr Search Configuration icon.

The Filr Search Configuration Wizard is displayed.

4 (Conditional) If this is the first time you have accessed the Filr search appliance, you must do the 
following:

4a Select New or Upgrade, depending on whether this is a new installation or an upgrade from 
a previous installation, then click Next.

4b Create a password for the default search appliance user.

IMPORTANT: In an environment where you are running multiple search index appliances, 
ensure that the password is the same for each search index appliance.

It is recommended that you have two search index appliances in a large or clustered Filr 
environment.

4c Click Finish.

The password for the search appliance user is now set.

The Search Settings page is displayed. 
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5 On the Search Settings page, refer to the on-screen instructions for information about the fields 
that you can modify. 

NOTE: You can change the Username from lucene service at this point if you want to. The 
only requirement is that you specify exactly the same name across the Filr deployment you are 
creating or updating. 

6 Click Submit after you have made the desired modifications for your search settings.

7 After both search appliances are configured, continue with installing the database appliance, as 
described in Section 4.2, “Installing the MySQL Database Appliance,” on page 65.

4.2 Installing the MySQL Database Appliance

IMPORTANT: The MySQL database appliance is not intended for enterprise installations. If your 
organization has an existing MySQL, MariaDB, or Microsoft SQL database, it is recommended that 
you configure Filr to use the existing database.

If you already have a MySQL, MariaDB, or Microsoft SQL database server that you want Filr to use, 
you can skip this section and continue with Section 4.3, “Configuring an Existing Database Server,” 
on page 76.

 Section 4.2.1, “Downloading the MySQL Database Appliance and Configuring the Virtual 
Environment,” on page 65

 Section 4.2.2, “Installing the MySQL Database Appliance,” on page 73

4.2.1 Downloading the MySQL Database Appliance and 
Configuring the Virtual Environment

You need to download the MySQL database appliance and configure the virtual environment where 
you plan to run the appliance. This includes configuring system resources and so forth.

The process of downloading the MySQL database appliance and configuring the virtual environment 
differs depending on which virtual environment you plan to use to run the MySQL database 
appliance.

 “VMware Configuration” on page 65

 “Hyper-V Configuration” on page 68

 “Xen Configuration” on page 70

 “Citrix Xen Configuration” on page 73

VMware Configuration

1 Download the MySQL database software (MySQL.x86_64-version.ovf.zip) to your 
management workstation.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

2 Extract the MySQL.x86_64-version.ovf.zip file on your management workstation until the 
MySQL-version file folder appears.
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3 In the vSphere client, click File > Deploy OVF Template.

4 Browse to and select the .ovf file in the MySQL-version file folder.

5 Click Next.

6 Click Next again.

7 In the Name field, rename the Filr appliance to a name of your choosing, then click Next.

8 Select the datastore where you want to store the virtual machine files, then click Next.

9 Click Next to accept the default for the disk format.

10 Click Finish.

11 Create a separate VMware hard disk (Hard Disk 2) for the appliance. This hard disk is used to 
store configuration files that are used for appliance upgrades.

IMPORTANT: If you do not create a separate VMware hard disk as described here, you cannot 
upgrade to a new version of Filr.

11a In the vSphere client, right-click the virtual machine that you just created, and for which you 
want to create secondary storage, then click Edit Settings.

The Virtual Machine Properties page is displayed.

11b On the Hardware tab, click Add.

The Add Hardware dialog box is displayed.

11c Select Hard Disk, then click Next.

11d Leave Create a new virtual disk selected, then click Next.

11e In the Capacity section, specify the amount of hard disk space that you want to allocate.

To see a formula to calculate the storage requirement for your environment, see “MySQL 
Database Appliance Storage” on page 22.

11f In the Disk Provisioning section, select either Thick Provision Eager Zeroed or Support 
clustering features such as Fault Tolerance, depending on the VMware version that you 
are running.

11g In the Location section, select Specify a datastore or datastore cluster, then click Browse.

11h Select a datastore, then click OK.

11i Click Next.

11j In the Virtual Device Node section, select SCSI (1:0) from the drop-down list.

IMPORTANT: Do not change the controller to VMware Paravirtual at this point of the 
installation process. 

If you want to change the SCSI controller to VMware Paravirtual: 

1. Finish the installation and power on the Filr system. 

2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, 
and log in as that user.)

3. Shut down each appliance in the Filr system. (For information about how to safely shut 
down an appliance, see “Shutting Down and Restarting the Novell Appliance” in the Filr 
2.0: Administration Guide.)

4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the Filr system.
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11k In the Mode section, select Independent, select Persistent, then click Next.

11l Click Finish.

12 Create a separate VMware hard disk (Hard Disk 3) for the appliance. This hard disk is used to 
store the /var directory for the appliance. (The /var directory is where system events for the 
Novell appliances are logged.)

12a In the Virtual Machine Properties window, on the Hardware tab, click Add.

12b Select Hard Disk, then click Next.

12c Leave Create a new virtual disk selected, then click Next.

12d In the Disk Size field, specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 20 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

12e In the Disk Provisioning section, select either Thick Provision Eager Zeroed or Support 
clustering features such as Fault Tolerance, depending on the VMware version that you 
are running.

12f In the Location section, select Specify a datastore or datastore cluster, then click Browse.

12g Select a datastore, then click OK.

12h Click Next.

12i In the Virtual Device Node section, select SCSI (2:0) from the drop-down list.

IMPORTANT: Do not change the controller to VMware Paravirtual at this point of the 
installation process. 

If you want to change the SCSI controller to VMware Paravirtual: 

1. Finish the installation and power on the Filr system. 

2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, 
and log in as that user.)

3. Shut down each appliance in the Filr system. (For information about how to safely shut 
down an appliance, see “Shutting Down and Restarting the Novell Appliance” in the Filr 
2.0: Administration Guide.)

4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the Filr system.

12j Leave the Mode section blank, then click Next.

You do not need to select anything in this section, because unlike Hard Disk 2, this hard 
disk does not need to be carried over on an upgrade.

12k Click Finish.

13 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

13a In the Virtual Machine Properties window, on the Hardware tab, click Add.
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The Add Hardware dialog box is displayed.

13b Select Ethernet Adapter, then click Next.

13c In the Network Connection section, select the secondary network associated with the Filr 
installation.

13d Click Next > Finish.

14 Increase the amount of memory that VMware allocates for the appliance. 

The default is 4 GB. This default is appropriate for a system that has a few hundred to 1,000 
users. You should increase this if your user count exceeds 1,000. Novell also recommends 2 
CPUs.

Increasing the memory for the appliance does not automatically provide MySQL with more 
resources. In addition to increasing the memory in VMware, you also need to increase the 
memory within MySQL itself. For information about how to accomplish this, see the MySQL 
documentation (http://dev.mysql.com/doc/).

14a In the Virtual Machine Properties window, select Memory, then increase this setting to a 
suitable size for your environment.

14b Click OK to exit the Virtual Machine Properties window.

15 Power on the appliance (virtual machine).

IMPORTANT: Do not power on the appliance until you have created the hard disk, as described 
in Step 11.

16 Continue with “Installing the MySQL Database Appliance” on page 73.

Hyper-V Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use Windows Remote Desktop to log in to the host server from a remote workstation.

2 Create a new directory in the location where you want the virtual machine to reside (for example, 
C:\Users\Public\Documents\Hyper-V\Virtual Hard Disks). In a later step, you will 
download the Filr software to this directory. 

As a best practice, give this directory the same name as the name that you plan to use for your 
Filr virtual appliance. For example, if you plan to name the Filr appliance FilrDatabase1, the 
name of this new directory should also be FilrDatabase1.

3 Download the Filr software (MySQL.x86_64-version.vhd.zip) to the directory on the host 
server that you created in Step 2.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

4 Extract the MySQL.x86_64-version.vhd.zip file to the directory on the host server that you 
created in Step 2.

5 Open the Hyper-V Manager.

6 In Hyper-V Manager, right-click the disk name in the Action Pane where you want to create the 
new virtual machine, then click New > Virtual Machine.

The New Virtual Machine Wizard is displayed.

7 Review the Before You Begin page, then click Next.

8 In the Name field, specify a name for the new virtual machine. For example, FilrDatabase1.
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9 Click Next.

10 In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual 
machine. 4 GB is the recommended minimum for a system that has a few hundred to 1,000 
users. You should increase this if your user count exceeds 1,000. Novell also recommends 2 
CPUs.

11 Click Next.

12 On the Configure Networking page, select the networking card of your choice, then click Next.

13 Configure the bootable disk image:

13a On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then 
browse to the .vhd file that was in the downloaded .zip file that you extracted in Step 4.

13b Click Open to select the file, then click Next.

14 Click Finish.

15 Create a separate Hyper-V hard disk (Hard Disk 2) for the appliance. This hard disk is used to 
store configuration files that are used for appliance upgrades. 

IMPORTANT: If you do not create a separate Hyper-V hard disk as described here, you cannot 
upgrade to a new version of Filr.

15a In Hyper-V Manager, right-click the disk that you just created, then click Settings.

15b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

15c Select Virtual hard disk, then click New.

15d Review the Before You Begin page, then click Next.

15e On the Choose Disk Format page, select VHD, then click Next.

15f On the Choose Disk Type page, select Fixed size, then click Next.

15g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, FilrDisk2.

Location: Specify the location where you want the hard drive to be located. 

15h On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size 
for the hard disk. The recommended minimum is 100 GB. A minimum of 100 GB is 
recommended, but this might be more for your environment.

To see a formula to calculate the storage requirement for your environment, see “MySQL 
Database Appliance Storage” on page 22.

15i Click Next.

15j Review the summary information, then click Finish.

16 Create a separate Hyper-V hard disk (Hard Disk 3) for the appliance. This hard disk is used to 
store the /var directory for the appliance. (The /var directory is where system events for the 
Novell appliances are logged.)

16a In Hyper-V Manager, right-click the virtual machine for which you want to create a new hard 
disk, then click Settings.

16b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

16c Select Virtual hard disk, then click New.

16d Review the Before You Begin page, then click Next.

16e On the Choose Disk Format page, select VHD, then click Next.

16f On the Choose Disk Type page, select Fixed size, then click Next.

16g On the Specify Name and Location page, specify the following information, then click Next:
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Name: Specify a name for the hard disk. For example, FilrDisk3.

Location: Specify the location where you want the hard drive to be located. 

16h On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size 
for the hard disk. The recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

16i Click Next.

16j Review the summary information, then click Finish > OK.

17 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

17a In Hyper-V Manager, right-click the virtual machine for which you want to create an 
additional NIC, then click Settings.

17b In the Hardware section, select Add Hardware, select Network Adapter, then click Add.

17c Specify the desired settings for the new network adapter.

Select the secondary network associated with the Filr installation.

17d Click OK.

18 Right-click the virtual machine, then click Start.

IMPORTANT: Do not start the appliance until you have created a separate Hyper-V hard disk for 
the appliance, as described in Step 15.

19 Right-click the virtual machine, then click Connect.

20 Continue with “Installing the MySQL Database Appliance” on page 73.

Xen Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on 
Linux:

ssh -X root@host_ip_address

You must use the -X in the command in order to display the GUI installation program. The steps 
in this section use the GUI installation program to configure the server.

2 Navigate to the /var/lib/xen/images directory on the host server.

3 Create a new directory inside the images directory where you can download the Filr software. 
The name of this directory must be the same as the name that you plan to use for your Filr virtual 
appliance. For example, if you plan to name the Filr appliance FilrDatabase1, the name of this 
new directory must also be FilrDatabase1.

4 Change to the directory that you just created. For example, /var/lib/xen/images/
FilrDatabase1.
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5 Download the Filr software (MySQL.x86_64-version.xen.tar.gz) to the following directory on 
the host server:

/var/lib/xen/images

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

6 Untar the MySQL.x86_64-version.xen.tar.gz file in the directory where you downloaded the 
file, as described in Step 5.

You can use the following command to untar the file:

tar -Sxvzf MySQL.x86_64-version.xen.tar.gz

A filr -version directory is created; it contains a .raw file that you will use to run the virtual 
image.

7 From the host server, run the following command to launch the GUI configuration menu:

vm-install

The Create a Virtual Machine wizard is displayed.

8 Click Forward.

9 Select I have a disk or disk image with an installed operating system, then click Forward.

10 Leave SUSE Linux Enterprise Server 11 selected, then click Forward.

11 Rename the virtual machine by clicking Name of Virtual Machine and specifying a new name in 
the Name field. Then click Apply. For example, FilrDatabase1.

12 Configure the amount of memory that Xen allocates for the Filr appliance. 

12a On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of memory that is available on the host server.

Maximum Memory: 4 GB is the recommended minimum for a system that has a few 
hundred to 1,000 users. You should increase this if your user count exceeds 1,000.

Virtual Processors: Specify 2 CPUs. At least half of the memory should be dedicated to 
the Java heap.

12b Click Apply.

13 Configure the bootable disk image:

13a On the Summary page, click Disks.

13b Click Harddisk.

13c On the Virtual Disk page, specify the following information:

Source: Click Browse, then browse to the .raw file that you untarred in Step 6.

Protocol: Select file:.

Size (GB): The default size is 20 GB. This cannot be changed.

Create Sparse Image File: This option is not available.

Read-Only Access: Do not select this option.

13d Click OK.

14 Create a separate Xen hard disk (Hard Disk 2) for the appliance. This hard disk is used to store 
configuration files that are used for appliance upgrades.
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IMPORTANT: If you do not create a separate Xen hard disk as described here, you cannot 
upgrade to a new version of Filr.

14a On the Summary page, click Disks.

14b Click Harddisk.

14c On the Virtual Disk page, specify the following information:

Source: Click Browse, then browse to the location of a datastore where you want Filr files 
to be stored.

Protocol: Select file:.

Size (GB): Specify the amount of hard disk space that you want to allocate. A minimum of 
100 GB is recommended, but you might need more for your environment.

To see a formula to calculate the storage requirement for your environment, see “MySQL 
Database Appliance Storage” on page 22.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

14d Click OK.

15 Create a separate Xen hard disk (Hard Disk 3) for the appliance. This hard disk is used to store 
the /var directory for the appliance. (The /var directory is where system events for the Novell 
appliances are logged.)

15a On the Disks page, click Harddisk.

15b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the .raw file that will be created when 
the virtual machine is created. If desired, you can rename the disk in the source field from 
disk0 to a name of your choosing.

Protocol: Select file:.

Size (GB): Specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

16 Click OK > Apply.

17 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

17a On the Summary page, click Network Adapters.

17b Click New, then specify the desired settings for the new network adapter.

Select the secondary network associated with the Filr installation.

17c Click Apply > Apply.
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18 Click OK to save your changes and to create the virtual machine.

19 Power on the appliance (virtual machine).

IMPORTANT: Do not power on the appliance until you have created a separate Xen hard disk 
for the appliance, as described in Step 14.

20 Continue with “Installing the MySQL Database Appliance” on page 73.

Citrix Xen Configuration

Do the following in order.

1 Expand the .xva.tar.gz file.

2 From the Citrix XenCenter, connect to a Citrix 6.5 or 6.5 SP1 XenServer.

3 Import the .xva file.

4 Assign two disks to the imported virtual appliance.

5 Modify the CPU and memory settings as required for your environment.

6 Start the VA.

7 Install the xs-tools and optimize according to the needs of your environment.

8 Continue with “Installing the MySQL Database Appliance” on page 73.

4.2.2 Installing the MySQL Database Appliance

1 After you have downloaded the MySQL database appliance, configured the virtual environment, 
and powered on the appliance, click the Console tab. 

2 After the appliance starts, select your preferred keyboard layout in the Keyboard Language 
drop-down, then accept the license agreement. (You can change the language that the license 
agreement is displayed in from the License Language drop-down.)

3 On the configuration page, specify the following information:

Root password and confirmation: The root password for your database appliance. The root 
user name is case sensitive and should not be capitalized.

Vaadmin password and confirmation: The preferred user to use when logging in to the 
appliance. The user name is case sensitive and should not be capitalized.

NTP Server: The IP address or DNS name of the reliable external Network Time Protocol (NTP) 
server that your OES server uses. For example, time.example.com.

Region: Your local region.

Time Zone: Your local time zone.

After installation, if you are not able to access the appliance and you need to change any of 
these settings, you can use the VACONFIG utility from the Filr command prompt. For more 
information, see “Using VACONFIG to Modify Network Information” in the Filr 2.0: Administration 
Guide.

4 Click Next.

5 On the configuration page, specify the following network information:

Hostname: The fully qualified DNS host name associated with the appliance’s IP address. For 
example, myFilr.mynetwork.example.com.

IP Address: The static IP address for the appliance. For example, 172.17.2.3.
Creating a Large Deployment 73

https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#b14d5s1a
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo


Network Mask: The network mask associated with the appliance’s IP address. For example, 
255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your database appliance is 
located. For example, 172.17.2.254.

DNS Servers: The IP address of a primary DNS server for your network. For example, 
172.17.1.1.

Domain Search: The domain that is associated with the Filr host name.

6 Click Next.

7 (Conditional) If you configured multiple NICs (as described in Section 4.2.1, “Downloading the 
MySQL Database Appliance and Configuring the Virtual Environment,” on page 65), select from 
the following options, then click Next:

 Do Not Configure: Select this option to configure this network at a later time. If you do not 
currently know your network information, you can configure the network after installation, as 
described in “Changing Network Settings” in the Filr 2.0: Administration Guide.

 DHCP Dynamic Address: Select this option to dynamically assign an IP address to this 
network.

 Statically Assigned IP Address: Select this option to assign a static IP address to this 
network, then specify the IP address, network mask, and host name.

8 The secondary hard disk for /vastorage that you created for this appliance is automatically 
detected and sdb is displayed as the hard drive. Accept the defaults for the other options on this 
page, then click Next.

This is the location (/vastorage) where information specific to the appliance is stored and is 
used when the appliance is upgraded. Each appliance has its own /vastorage location.

If you have not already assigned a second hard disk to the virtual machine (as described in 
“Downloading the MySQL Database Appliance and Configuring the Virtual Environment” on 
page 65), click Power Off Virtual Machine, modify the virtual machine settings to add a hard 
disk, then power on the virtual machine.

For more information about the type of data that is stored here, see “Data Storage for the 
Appliance” on page 11.

9 The third hard disk for /var that you created for this appliance is automatically detected and sdc 
is displayed as the hard drive. Accept the defaults for the other options on this page, then click 
Configure.

This is the location where the /var directory for the appliance is stored. (The /var directory is 
where system events for the Novell appliances are logged.)

If you have not already assigned a third hard disk to the virtual machine (as described in 
“Downloading the MySQL Database Appliance and Configuring the Virtual Environment” on 
page 65), click Power Off Virtual Machine, modify the virtual machine settings to add a hard 
disk, then power on the virtual machine.

For more information about the type of data that is stored here, see “Data Storage for the 
Appliance” on page 11.

The appliance might take a few minutes to install. When the installation is complete, you see a 
message telling you that the appliance is now ready to configure.

10 Configure the MySQL database appliance to change the database administrator password.

IMPORTANT: You must do this before you configure the Filr appliance for the first time.

10a Navigate to the following URL:

https://ip_address:9443
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Replace ip_address with the IP address of your database appliance.

10b Sign in to the database appliance as vaadmin with the password that you set during 
installation.

The Novell MySQL Appliance landing page is displayed.

10c Click the phpMyAdmin icon, then click Go to log in to phpMyAdmin.

10d Log in to the phpMyAdmin tool as root with password root. (You change the password in a 
future step.)

10e Create the filr user to administer the MySQL database:

10e1 At the top of the page, click Users.

10e2 Click Add user.

10e3 In the User name field, specify filr as the new user.

10e4 In the Host field, select Use text field in the drop-down list, then specify the IP address 
or host name of the Filr appliance.

10e5 In the Password field, specify a new password for the user, then confirm it in the Re-
type field.

10e6 In the Database for user section:

 If you are installing the MySQL database for the first time: select Create 
database with same name and grant all privileges.
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 If you are upgrading the MySQL database: select Grant all privileges on 
wildcard name.

10e7 In the Global privileges section, select Check All, then deselect all privileges in the 
Administration section.

10e8 Click Go. Note the user name and password of this user. This is the user you will use to 
access the MySQL database when you configure the Filr appliance. 

You can now administer the Filr MySQL database by using this new user.

10f (Conditional) If you have a clustered Filr system with multiple Filr appliances, edit the 
privileges of the Filr user that you created in the previous step so that each of the Filr 
appliances is granted remote access to the database.

10f1 On the Users overview page, click Edit Privileges next to the user that you created in 
Step 5.

10f2 Click the Login Information button. In the Host field, specify the IP address or host 
name of the next Filr appliance in the cluster.

10f3 In the Create a new user with the same privileges and... section, ensure that keep the 
old one is selected, then click Go.

10f4 Repeat this process for each Filr appliance in the cluster.

10g (Recommended) Change your MySQL root password if you have not done so already:

10g1 At the top of the page, click Users.

10g2 In the Users Overview table, locate the root user with localhost in the Host column, 
then click Edit Privileges for that user in the Action column.

10g3 Scroll to the Change password section. In the Password field, specify your password, 
then confirm it in the Re-type field.

10g4 Click Go.

10h Make any other configuration changes.

11 Continue with Section 4.4, “Installing the Filr Appliance,” on page 79.

4.3 Configuring an Existing Database Server
You can configure Filr to use an existing MySQL, MariaDB, or Microsoft SQL database server. In an 
enterprise deployment, using your existing corporate database server is recommended over using 
the MySQL appliance.

You configure Filr to leverage your existing database server when running the Filr configuration 
wizard for the first time, as described in Section 4.5, “Configuring a Large Deployment for the First 
Time,” on page 92. During this time (the initial Filr configuration), the Filr configuration wizard creates 
and configures the Filr database on the existing server. 

IMPORTANT: Do not create the Filr database on your existing server before running the Filr 
configuration wizard. Instead, allow the Filr configuration wizard to create the Filr database to ensure 
that the database is properly configured for Filr.

During the Filr configuration, you need the following information for accessing your database server:

 The host name or IP address of the database

 The user name and password of the account you use to administer the MySQL, MariaDB, or 
Microsoft SQL database
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If you are leveraging an existing Microsoft SQL database server, you need the following additional 
information:

 Access to a user account configured with SQL Server Authentication and with sufficient rights to 
manage the Filr database. This user must have the necessary rights to administer the database. 
(You might need to create a new user to administer the Filr database.)

The following sections describe tasks that need to be performed on the existing database before you 
configure Filr to use the database:

 Section 4.3.1, “Configuring an Existing MySQL or MariaDB Database Server,” on page 77

 Section 4.3.2, “Configuring an Existing Microsoft SQL Database Server,” on page 78

4.3.1 Configuring an Existing MySQL or MariaDB Database 
Server

When configuring Filr to use an existing MySQL database server rather than the database appliance, 
Filr supports MySQL 5.0.96 and later. 

 “Configuring the Existing MySQL or MariaDB Database Server” on page 77

 “Configuring Ganglia to Monitor the Existing Database” on page 78

Configuring the Existing MySQL or MariaDB Database Server

IMPORTANT: Do not create the Filr database on your existing server before running the Filr 
configuration wizard. Instead, allow the Filr configuration wizard to create the Filr database to ensure 
that the database is properly configured for Filr.

If you want to use an existing MySQL or MariaDB database server as the Filr database, you must 
make some changes on the database server to configure it to work with Filr.

1 Make the following changes to the /etc/my.cnf file on the server:

[client] 
default-character-set = utf8

[mysqld]
character-set-server = utf8
max_connections = 900
transaction-isolation = READ-COMMITTED
expire_logs_days = 7

The expire_logs_days setting is optional, but is recommended. It is used to clean up mysql-
bin-* files. If these files are not cleaned up on a regular basis, they can begin to consume a 
significant amount of disk space in the vastorage directory.

2 Uncomment the InnoDB tables section. 

3 Increase the buffer pool size to approximately 60 percent of the amount of RAM that has been 
allocated to the dedicated server. 

For example, a dedicated server with 4 GB of RAM should have a buffer pool size of 2560 MB, 
as follows:

innodb_buffer_pool_size = 2560M
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4 Identify a user account with sufficient rights to manage the Filr database.

5 Continue with “Configuring Ganglia to Monitor the Existing Database” on page 78.

Configuring Ganglia to Monitor the Existing Database

If you want to use Ganglia to monitor the existing database, you need to change the database name 
on the Filr appliance that Ganglia is configured to monitor to match the name of your database:

1 Edit the following file:

/opt/novell/ganglia/monitor/lib64/ganglia/python_modules/mysql.py

2 Modify the value of the following parameter (filr) to match the name of your database:

param dbname {
       value = "filr"
              }

3 Save and close the file.

4 Restart the Ganglia service by using the following command:

rcnovell-gmond restart

rcnovell-gmetad restart

5 Continue with Section 4.4.1, “Downloading the Filr Appliance and Configuring the Virtual 
Environment,” on page 79.

4.3.2 Configuring an Existing Microsoft SQL Database Server

IMPORTANT: Do not create the Filr database on your existing Microsoft SQL server (by using 
Microsoft Management Studio) before running the Filr configuration wizard. Instead, allow the Filr 
configuration wizard to create the Filr database to ensure that the database is properly configured for 
Filr.

For information regarding which versions of the Microsoft SQL database Filr supports, see 
Section 1.2.1, “Filr Server Requirements,” on page 13.

To configure an existing Microsoft SQL database server to be used with your Filr system:

1 Enable remote access to the Microsoft SQL database server.

2 Open port 1433 on the Windows firewall where the database server is running.

3 Identify a user account configured with SQL Server Authentication and that this user has 
sufficient rights to manage the Filr database.

Filr supports only SQL Server Authentication. Filr does not support Windows Authentication or 
Windows Domain User Authentication to Microsoft SQL.

4 Run the following queries against the database:

ALTER DATABASE database-name SET READ_COMMITTED_SNAPSHOT ON         
ALTER DATABASE database-name COLLATE Latin1_General_CI_AS_KS_WS 

5 Continue with Section 4.4.1, “Downloading the Filr Appliance and Configuring the Virtual 
Environment,” on page 79.
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4.4 Installing the Filr Appliance
 Section 4.4.1, “Downloading the Filr Appliance and Configuring the Virtual Environment,” on 

page 79

 Section 4.4.2, “Installing the Filr Appliance,” on page 88

4.4.1 Downloading the Filr Appliance and Configuring the Virtual 
Environment

You need to download the Filr appliance and configure the virtual environment where you plan to run 
the appliance. This includes configuring system resources and so forth.

The process of downloading the Filr appliance and configuring the virtual environment differs, 
depending on which virtual environment you plan to use to run the Filr appliance.

 “VMware Configuration” on page 79

 “Hyper-V Configuration” on page 82

 “Xen Configuration” on page 85

 “Citrix Xen Configuration” on page 88

VMware Configuration

1 Download the Filr software (Filr.x86_64-version.ovf.zip) to your management workstation.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

2 Extract the Filr.x86_64-version.ovf.zip file on your management workstation so that the 
Filr-version file folder appears.

3 In the vSphere client, click File > Deploy OVF Template.

4 Browse to and select the .ovf file in the Filr-version file folder.

5 Click Next.

6 Click Next again.

7 In the Name field, rename the Filr appliance to a name of your choosing, then click Next.

8 Select the datastore where you want to store the virtual machine files, then click Next.

9 Click Next to accept the default for the disk format.

10 Click Finish.

11 Create a separate VMware hard disk (Hard Disk 2) for the appliance. This is the location where 
you will store your Filr files (files that are located in users’ My Files area). 

IMPORTANT: If you do not create a separate VMware hard disk as described here, you cannot 
upgrade to a new version of Filr.

11a In the vSphere client, right-click the virtual machine that you just created, and for which you 
want to create secondary storage, then click Edit Settings.

The Virtual Machine Properties page is displayed.

11b On the Hardware tab, click Add.
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The Add Hardware dialog box is displayed.

11c Select Hard Disk, then click Next.

11d Leave Create a new virtual disk selected, then click Next.

11e In the Disk Size field, specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

11f In the Disk Provisioning section, select either Thick Provision Eager Zeroed or Support 
clustering features such as Fault Tolerance, depending on the VMware version that you 
are running.

11g In the Location section, select Specify a datastore or datastore cluster, then click Browse.

11h Select a datastore, then click OK.

11i Click Next.

11j In the Virtual Device Node section, select SCSI (1:0) from the drop-down list.

IMPORTANT: Do not change the controller to VMware Paravirtual at this point of the 
installation process. 

If you want to change the SCSI controller to VMware Paravirtual: 

1. Finish the installation and power on the Filr system. 

2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, 
and log in as that user.)

3. Shut down each appliance in the Filr system. (For information about how to safely shut 
down an appliance, see “Shutting Down and Restarting the Novell Appliance” in the Filr 
2.0: Administration Guide.)

4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the Filr system.

11k In the Mode section, select Independent, select Persistent, then click Next.

11l Click Finish.

12 Create a separate VMware hard disk (Hard Disk 3) for the appliance. This hard disk is used to 
store the /var directory for the appliance. (The /var directory is where system events for the 
Novell appliances are logged.)

12a In the Virtual Machine Properties window, on the Hardware tab, click Add.

12b Select Hard Disk, then click Next.

12c Leave Create a new virtual disk selected, then click Next.

12d In the Disk Size field, specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 20 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

12e In the Disk Provisioning section, select either Thick Provision Eager Zeroed or Support 
clustering features such as Fault Tolerance, depending on the VMware version that you 
are running.

12f In the Location section, select Specify a datastore or datastore cluster, then click Browse.

12g Select a datastore, then click OK.

12h Click Next.
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12i In the Virtual Device Node section, select SCSI (2:0) from the drop-down list.

IMPORTANT: Do not change the controller to VMware Paravirtual at this point of the 
installation process. 

If you want to change the SCSI controller to VMware Paravirtual: 

1. Finish the installation and power on the Filr system. 

2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, 
and log in as that user.)

3. Shut down each appliance in the Filr system. (For information about how to safely shut 
down an appliance, see “Shutting Down and Restarting the Novell Appliance” in the Filr 
2.0: Administration Guide.)

4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the Filr system.

12j Leave the Mode section blank, then click Next.

You do not need to select anything in this section, because unlike Hard Disk 2, this hard 
disk does not need to be carried over on an upgrade.

12k Click Finish.

13 For a clustered Filr deployment, you must create a shared storage location (/vashare) for 
shared storage among all Filr appliances in the cluster.

For a large Filr deployment with only one Filr appliance, it is still recommended that you create 
a shared storage location, because having a shared storage location allows you to easily scale 
your system in the future if the need arises by adding additional Filr appliances.

For a small Filr deployment, you do not configure shared storage.

You can configure Shared storage either on a remote Linux server via NFS or on a remote 
Windows server via CIFS.

For information about how to set up remote NFS for the Filr shared storage location, see 
Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage Location,” on 
page 149.

14 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

14a In the Virtual Machine Properties window, on the Hardware tab, click Add.

The Add Hardware dialog box is displayed.

14b Select Ethernet Adapter, then click Next.

14c In the Network Connection section, select the secondary network associated with the Filr 
installation.

14d Click Next > Finish.

15 Increase the amount of memory that VMware allocates for the Filr appliance. 
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The default of 8 GB is the recommended minimum amount of memory for a large deployment. 
Novell also recommends 2 CPUs. 

For an all-in-one deployment, you should increase the default to at least 12 GB of memory and 4 
CPUs.

Small deployments require more CPUs and memory because in a small deployment, all 
components are running on a single virtual machine.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in “Changing 
the JVM Configuration Settings” in the Filr 2.0: Administration Guide.

At least half of the memory should be dedicated to the Java heap. You cannot adjust the Java 
heap until after the appliance is installed.

15a In the Virtual Machine Properties window, select Memory, then increase the setting to a 
suitable size for your environment.

15b Click OK to exit the Virtual Machine Properties window.

16 (Optional) Upgrade the virtual machine hardware version to the latest that your infrastructure can 
support. To do so, in the vSphere client, right-click the virtual machine that you just created, and 
for which you want to upgrade the hardware, then click Upgrade Virtual Hardware.

17 Power on the appliance (virtual machine).

IMPORTANT: Do not power on the appliance until you have created a separate VMware hard 
disk for the appliance, as described in Step 11.

18 (Optional) Install VMware Tools on the host server.

19 Continue with Section 4.4.2, “Installing the Filr Appliance,” on page 88.

Hyper-V Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use Windows Remote Desktop to log in to the host server from a remote workstation.

2 Create a new directory in the location where you want each virtual machine to reside (for 
example, C:\Users\Public\Documents\Hyper-V\Virtual Hard Disks). In a later step, you 
will download the Filr software to this directory. 

As a best practice, give this directory the same name as the name that you plan to use for your 
Filr virtual appliance. For example, if you plan to name the Filr appliance Filr1, the name of this 
new directory should also be Filr1.

3 Download the Filr software (Filr.x86_64-version.vhd.zip) to the directory on the host server 
that you created in Step 2.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

4 Extract the Filr.x86_64-version.vhd.zip file to the directory on the host server that you 
created in Step 2.

5 Open the Hyper-V Manager.

6 In Hyper-V Manager, right-click the disk name in the Action Pane in the left column of the Hyper-
V Manager window. This is the disk where you want to create the new virtual machine. Then 
click New > Virtual Machine.
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The New Virtual Machine Wizard is displayed.

7 Review the Before You Begin page, then click Next.

8 In the Name field, specify a name for the new virtual machine. For example, Filr1.

9 Click Next.

10 (Conditional) If your host server is Windows Server 2012 R2, the Specify Generation page is 
displayed. This page allows specify the generation of the virtual machine. You must select 
Generation 1, then click Next.

IMPORTANT: If you do not select Generation 1 and you select Generation 2 instead, the Filr 
virtual machine cannot be deployed.

11 In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual 
machine. 8 GB (8192 MB) is the recommended minimum for a large deployment of Filr. Novell 
also recommends 2 CPUs.

For an all-in-one (small) deployment, you should increase the default to at least 12 GB (12288 
MB) of memory and 4 CPUs.

Small deployments require more CPUs and memory because in a small deployment, all 
components are running on a single virtual machine.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in “Changing 
the JVM Configuration Settings” in the Filr 2.0: Administration Guide. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the Java 
heap until after the appliance is installed.

12 Click Next.

13 On the Configure Networking page, select the networking card of your choice, then click Next.

14 Configure the bootable disk image:

14a On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then 
browse to the .vhd file that was in the downloaded .zip file that you extracted in Step 4.

14b Click Open to select the file, then click Next.

15 Click Finish.

16 Create a separate Hyper-V hard disk (Hard Disk 2) for the appliance. This is the location where 
you will store your Filr files (files that are located in users’ My Files area).

IMPORTANT: If you do not create a separate Hyper-V hard disk as described here, you cannot 
upgrade to a new version of Filr.

16a In Hyper-V Manager, right-click the virtual machine that you just created, then click 
Settings.

16b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

16c Select Virtual hard disk, then click New.

16d Review the Before You Begin page, then click Next.

16e On the Choose Disk Format page, select VHD, then click Next.

16f On the Choose Disk Type page, select Fixed size, then click Next.

16g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, FilrDisk2.
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Location: Specify the location where you want the hard drive to be located. 

16h On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size 
for the hard disk. The recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

16i Click Next.

16j Review the summary information, then click Finish > OK.

17 Create a separate Hyper-V hard disk (Hard Disk 3) for the appliance. This hard disk is used to 
store the /var directory for the appliance. (The /var directory is where system events for the 
Novell appliances are logged.)

17a In Hyper-V Manager, right-click the virtual machine for which you want to create a new hard 
disk, then click Settings.

17b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

17c Select Virtual hard disk, then click New.

17d Review the Before You Begin page, then click Next.

17e On the Choose Disk Format page, select VHD, then click Next.

17f On the Choose Disk Type page, select Fixed size, then click Next.

17g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, FilrDisk3.

Location: Specify the location where you want the hard drive to be located. 

17h On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size 
for the hard disk. The recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

17i Click Next.

17j Review the summary information, then click Finish > OK.

18 For a clustered Filr deployment, you must create a shared storage location (/vashare) for 
shared storage among all Filr appliances in the cluster.

For a large Filr deployment with only one Filr appliance, it is still recommended that you create 
a shared storage location, because having a shared storage location allows you to easily scale 
your system in the future if the need arises by adding additional Filr appliances.

For a small Filr deployment, you do not configure shared storage.

You can configure Shared storage either on a remote Linux server via NFS or on a remote 
Windows server via CIFS.

For information about how to set up remote NFS for the Filr shared storage location, see 
Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage Location,” on 
page 149.

19 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment
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Bonding or teaming NICs is not supported with Filr.

19a In Hyper-V Manager, right-click the virtual machine for which you want to create an 
additional NIC, then click Settings.

19b In the Hardware section, select Add Hardware, select Network Adapter, then click Add.

19c Specify the desired settings for the new network adapter.

Select the secondary network associated with the Filr installation.

19d Click OK.

20 Right-click the virtual machine, then click Start.

IMPORTANT: Do not start the appliance until you have created a separate Hyper-V hard disk for 
the appliance, as described in Step 16.

21 Right-click the virtual machine, then click Connect.

22 Continue with Section 4.4.2, “Installing the Filr Appliance,” on page 88.

Xen Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on 
Linux:

ssh -X root@host_ip_address

You must use the -X in the command in order to display the GUI installation program. The steps 
in this section use the GUI installation program to configure the server.

2 Navigate to the /var/lib/xen/images directory on the host server.

3 Create a new directory inside the images directory where you can download the Filr software. 

The name of this directory must be the same as the name that you plan to use for your Filr virtual 
appliance. For example, if you plan to name the Filr appliance Filr1, the name of this new 
directory must also be Filr1.

4 Change to the directory that you just created. For example, /var/lib/xen/images/Filr1.

5 Download the Filr software (Filr.x86_64-version.xen.tar.gz) to the current directory on the 
host server. For example: /var/lib/xen/images/Filr1.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
download.novell.com/Download?buildid=SjqIZZ28ka8~) on the Novell Downloads page (http://
download.novell.com).

6 Untar the Filr.x86_64-version.xen.tar.gz file in the directory where you downloaded it.

You can use the following command to untar the file:

tar -Sxvzf Filr.x86_64-version.xen.tar.gz

A filr-version directory is created; it contains a .raw file that you will use to run the virtual 
image. This process can take a few minutes.

7 From the host server, run the following command to launch the GUI configuration menu:

vm-install

The Create a Virtual Machine wizard is displayed.

8 Click Forward.

9 Select I have a disk or disk image with an installed operating system, then click Forward.
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10 Leave SUSE Linux Enterprise Server 11 selected, then click Forward.

11 Rename the virtual machine by clicking Name of Virtual Machine and specifying a new name in 
the Name field. Then click Apply. For example, Filr1.

12 Configure the amount of memory and number of CPUs that Xen allocates for the Filr appliance. 

12a On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of memory that is available on the host server.

Initial Memory: 8 GB is the recommended minimum amount of memory for a large 
deployment.

For an all-in-one deployment, you should increase the default to at least 12 GB of memory.

Small deployments require more memory because in a small deployment, all components 
are running on a single virtual machine.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in 
“Changing the JVM Configuration Settings” in the Filr 2.0: Administration Guide. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the 
Java heap until after the appliance is installed.

Maximum Memory: Set this to the same value that you set for Initial Memory.

Available Processors: Displays the number of available processors on the host server.

Virtual Processors: Specify 2 CPUs for a large deployment and 4 CPUs for a small 
deployment. At least half of the memory should be dedicated to the Java heap. (Java heap 
is set in the Filr configuration.)

Small deployments require more CPUs because in a small deployment, all components are 
running on a single virtual machine.

12b Click Apply.

13 Configure the bootable disk image:

13a On the Summary page, click Disks.

13b Click Harddisk.

13c On the Virtual Disk page, specify the following information:

Source: Click Browse, then browse to the .raw file that you untarred in Step 6.

Protocol: Select file:.

Size (GB): The default size is 20 GB. This cannot be changed.

Create Sparse Image File: This option is not available.

Read-Only Access: Do not select this option.

13d Click OK.

14 Create a separate Xen hard disk (Hard Disk 2) for the appliance. This is the location where you 
will store your Filr files (files that are located in users’ My Files area).

IMPORTANT: If you do not create a separate Xen hard disk as described here, you cannot 
upgrade to a new version of Filr.

14a On the Disks page, click Harddisk.

14b On the Virtual Disk page, specify the following information:
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Source: This field should already contain the path to the .raw file that will be created when 
the virtual machine is created. If desired, you can rename the disk in the source field from 
disk0 to a name of your choosing.

Protocol: Select file:.

Size (GB): Specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

14c Click OK.

15 Create a separate Xen hard disk (Hard Disk 3) for the appliance. This hard disk is used to store 
the /var directory for the appliance. (The /var directory is where system events for the Novell 
appliances are logged.)

15a On the Disks page, click Harddisk.

15b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the .raw file that will be created when 
the virtual machine is created. If desired, you can rename the disk in the source field from 
disk0 to a name of your choosing.

Protocol: Select file:.

Size (GB): Specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

16 Click OK > Apply.

17 For a clustered Filr deployment, you must create a shared storage location (/vashare) for 
shared storage among all Filr appliances in the cluster.

For a large Filr deployment with only one Filr appliance, it is still recommended that you create 
a shared storage location, because having a shared storage location allows you to easily scale 
your system in the future if the need arises by adding additional Filr appliances.

For a small Filr deployment, you do not configure shared storage.

You can configure Shared storage either on a remote Linux server via NFS or on a remote 
Windows server via CIFS.

For information about how to set up remote NFS for the Filr shared storage location, see 
Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage Location,” on 
page 149.

18 (Optional) Add an additional Network Interface Controller (NIC).

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment
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Bonding or teaming NICs is not supported with Filr.

18a On the Summary page, click Network Adapters.

18b Click New, then specify the desired settings for the new network adapter.

Select the secondary network associated with the Filr installation.

18c Click Apply > Apply.

19 Click OK to save your changes and to create and power on the virtual machine.

IMPORTANT: Do not power on the appliance until you have created a separate Xen hard disk 
for the appliance, as described in Step 14.

20 Continue with Section 4.4.2, “Installing the Filr Appliance,” on page 88.

Citrix Xen Configuration

Do the following in order.

1 Expand the .xva.tar.gz file.

2 From the Citrix XenCenter, connect to a Citrix 6.5 or 6.5 SP1 XenServer.

3 Import the .xva file.

4 Assign two disks to the imported virtual appliance.

5 Modify the CPU and memory settings as required for your environment.

6 Start the VA.

7 Install the xs-tools and optimize according to the needs of your environment.

8 Continue with Section 4.4.2, “Installing the Filr Appliance,” on page 88.

4.4.2 Installing the Filr Appliance

1 After you have downloaded the Filr appliance, configured the virtual environment, and powered 
on the appliance, click the Console tab. 

2 After the appliance starts, select your preferred keyboard layout in the Keyboard Language 
drop-down, then accept the license agreement. (You can change the language that the license 
agreement is displayed in from the License Language drop-down.)

The Appliance Passwords and Time Zone page appears.
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3 On the configuration page, specify the following information:

Root password and confirmation: The root password for your Filr appliance. The root user 
name is case sensitive and should not be capitalized.

Vaadmin password and confirmation: The preferred user to use when logging in to the 
appliance. The user name is case sensitive and should not be capitalized.

When configuring passwords for the vaadmin user for multiple appliances in a large installation, 
consider using different passwords between appliances for enhanced security.

NTP Server: The IP address or DNS name of the reliable external Network Time Protocol (NTP) 
server that your OES server uses. For example, time.example.com.

For the best results, set up NTP in accordance with the VMware best practices guidelines (http:/
/kb.vmware.com/selfservice/microsites/
search.do?language=en_US&cmd=displayKC&externalId=1006427).

Region: Your local region.

Time Zone: Your local time zone.

The time zone of your Filr server should match the time zone of all file servers that Filr will point 
to via Net Folders.

After installation, if you are not able to access the appliance and you need to change any of 
these settings, you can use the VACONFIG utility from the Filr command prompt. For more 
information, see “Using VACONFIG to Modify Network Information” in the Filr 2.0: Administration 
Guide.

4 Click Next.

5 On the Network Settings page, specify the following network information:

Hostname: The fully qualified DNS host name associated with the appliance’s IP address. For 
example, myFilr.mynetwork.example.com.

IP Address: The static IP address for the appliance. For example, 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP address. For example, 
255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your Filr virtual appliance is 
located. For example, 172.17.2.254.
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In a clustered environment, Filr appliances are not tolerant to latency, and should exist in the 
same subnet or near-subnet.

DNS Servers: The IP address of a primary DNS server for your network. For example, 
172.17.1.1.

Domain Search: The domain that is associated with the Filr host name.

6 Click Next.

7 (Conditional) If you configured multiple NICs (as described in Section 4.4.1, “Downloading the 
Filr Appliance and Configuring the Virtual Environment,” on page 79), select from the following 
options, then click Next:

 Do Not Configure: Select this option to configure this network at a later time. If you do not 
currently know your network information, you can configure the network after installation, as 
described in “Changing Network Settings” in the Filr 2.0: Administration Guide.

 DHCP Dynamic Address: Select this option to dynamically assign an IP address to this 
network.

 Statically Assigned IP Address: Select this option to assign a static IP address to this 
network, then specify the IP address, network mask, and host name.

8 The secondary hard disk for /vastorage that you created for this appliance is automatically 
detected and sdb is displayed as the hard drive. Accept the defaults for the other options on this 
page, then click Next.

This is the location (/vastorage) where information specific to the appliance is stored and is 
used when the appliance is upgraded. Each appliance has its own /vastorage location.

If you have not already assigned a second hard disk to the virtual machine (as described in 
“Downloading the Filr Appliance and Configuring the Virtual Environment” on page 79), power off 
the virtual machine, modify the virtual machine settings to add a hard disk, then power on the 
virtual machine.

For more information about the type of data that is stored here, see “Data Storage for the 
Appliance” on page 11.

9 The third hard disk for /var that you created for this appliance is automatically detected and sdc 
is displayed as the hard drive. Accept the defaults for the other options on this page, then click 
Next.

This is the location where the /var directory for the appliance is stored. (The /var directory is 
where system events for the Novell appliances are logged.)

If you have not already assigned a third hard disk to the virtual machine (as described in 
“Downloading the Filr Appliance and Configuring the Virtual Environment” on page 79), power off 
the virtual machine, modify the virtual machine settings to add a hard disk, then power on the 
virtual machine.

For more information about the type of data that is stored here, see “Data Storage for the 
Appliance” on page 11.

10 In a large or clustered deployment, select the shared storage location (remote NFS or remote 
CIFS). This storage (/vashare) is shared storage among all of the Filr appliances in the cluster. 
There is only one /vashare storage location that is used by all Filr appliances in the cluster. 

IMPORTANT: You must select a shared storage location in a clustered deployment (if your Filr 
system contains multiple Filr appliances). 

It is recommended that you select a shared storage location in a large deployment with only one 
Filr appliance. This ensures that you can scale your system in the future if the need arises by 
adding additional Filr appliances.
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In a small deployment, select Do Not Configure Shared Storage.

 Remote NFS: Select this option for all large or clustered deployments for which you want to 
configure shared storage on remote NFS. You must export the remote directory before you 
choose this option. Also, set the rw and no_root_squash options on the remote directory.

IMPORTANT: Before you choose this option, understand the following: 

 You must configure NFS on the remote linux server by setting the rw and 
no_root_squash options on the remote directory.

For detailed information about how to configure NFS, see Section C.1, “Setting Up 
Remote NFS for the Filr Shared Storage Location,” on page 149.

 Filr does not support using an NSS volume as an exported NFS mount point.

 Remote NFS is not supported when hosted on a Windows server.

 Remote CIFS: Select this option for all large or clustered deployments for which you want 
to configure shared storage on a remote Windows share. If you select this option, skip to 
Step 12.

For detailed information about how to configure CIFS, see Section C.2, “Setting Up Remote 
CIFS for the Filr Shared Storage Location,” on page 150.

 Do Not Configure Shared Storage: You must choose this option if you are creating a 
small deployment where all components are part of a single appliance, then skip to Step 13.

Do not select this option with a clustered Filr deployment. This option is recommended only 
for a small deployment, but can be selected for a large (non-clustered) deployment if you do 
not plan to add Filr appliances in the future.

For more information about possible configurations when running Filr in a clustered environment, 
see Section 2.1.2, “Large Deployment,” on page 28.

11 (Conditional) If you are configuring Filr for a clustered environment with remote NFS: 

11a Click Next.

11b Specify the following options:

NFS Server Hostname: Specify the host name of the NFS server. This is the remote Linux 
server or the MySQL appliance that you previously configured for NFS (as described in 
Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage 
Location,” on page 149). Windows servers are not supported.

Remote Directory: Specify the path to the remote directory.

When using a remote Linux server for the NFS location (as described in Appendix C, 
“Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage Location,” on 
page 149), specify the path on the remote NFS server.

12 (Conditional) If you are configuring Filr for a clustered environment with remote CIFS: 

12a Click Next.

12b Specify the following options:

CIFS Folder: Specify the path to the CIFS share.

For example, \\server\share.

CIFS User Name: Specify the user name for accessing the CIFS share.

CIFS User Password: Specify the password for the user that is accessing the CIFS share.

13 Click Configure.

A message indicating that the installation was successful is displayed.
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14 (Conditional) If you are performing a large deployment with multiple Filr appliances, install 
another Filr appliance as described in this section, until you have installed your desired number 
of Filr appliances.

You cannot install multiple Filr appliances in a small deployment.

15 Continue with the first-time configuration, as described in the following section.

4.5 Configuring a Large Deployment for the First Time
When you configure Filr for the first time for a large organization, you configure the Filr appliance to 
point to the MySQL database appliance and the search index appliance that you installed previously.

IMPORTANT: Ensure that you have installed the search index appliance and the MySQL database 
appliance before configuring the Filr appliance. The search index appliance and the MySQL database 
appliance must be running when you configure the Filr appliance.

1 After you have installed the Novell Filr appliance, as described in Section 4.4, “Installing the Filr 
Appliance,” on page 79, navigate to the following URL:

https://ip_address:9443

Use the IP address or DNS name of the server that you specified during the appliance 
installation.

2 Log in to the appliance using the vaadmin user and the password that you set during installation.

The Novell Filr Appliance landing page is displayed.

3 Click the Filr Server Configuration icon.
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The Filr Server Configuration Wizard is displayed.

4 Select Large Deployment, then click Next.

5 Specify the following configuration options for the database:

IMPORTANT: If you are using an existing MySQL MariaDB, or Microsoft SQL database, ensure 
that you have performed the tasks described in Section 4.3, “Configuring an Existing Database 
Server,” on page 76.

Database Type: Select the type of database. The supported databases are MySQL (which 
includes MariaDB) and Microsoft SQL Server.

Host Name: The host name or IP address of your existing MySQL or Microsoft SQL server.

Or, the host name or IP address of the appliance where the MySQL database is running.

Port: The port that is used to access the appliance where the database is running.

Database Name: The name of the database.

User Name: The administrative user name used to access the database. 

If you are using your existing MySQL or Microsoft SQL database, this is the administrative user 
name that you use to log in to the database.

If you are using the MySQL appliance, the default user name is filr. 

Password: The administrative password used to access the database.

If you are using your existing MySQL or Microsoft SQL database, this is the administrative user 
name that you use to log in to the database.

If you are using the MySQL appliance, this is the password that you set when configuring the 
MySQL appliance, as described in Chapter 6, “Configuring and Maintaining the MySQL 
Database Appliance,” on page 97. (This is separate from the root password that you set for 
appliance access in Step 3 of Section 4.2, “Installing the MySQL Database Appliance,” on 
page 65.)

6 Click Next.

7 Specify the following configuration options for the search index:

Host Name: The host name of the appliance where the search index is running.

RMI Port: The port that is used to access the search appliance.

Do not change this setting from port 1199 unless your network uses a different RMI port number.

Lucene User Name: The user name for your search appliance. By default, the user name is 
lucene service, but you had the option to change it while you were configuring the service. 
The only requirement is that you use the same name throughout your deployment.

Lucene User Password: Specify the password for the search appliance user. This is the 
password that you created when installing the search appliance.
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NOTE: If you have multiple search index appliances, specify the information for one of the 
search index appliances on this page, then after the configuration is complete, you must modify 
the search index settings to High Availability, as described in “Changing Search Index 
Configuration Settings” in the Filr 2.0: Administration Guide.

8 Click Next.

9 In the Default Locale field, select the default locale for your Filr site. This is the language and 
locale that Filr uses when users first log in to the Filr site.

Users can change the individual locale after they log in by modifying the user profile, as 
described in “Modifying Your Profile” in the Filr 2.0: Web Application User Guide.

Some aspects of the Filr interface, such as group names and the login page, are always 
displayed in the default language, regardless of individual user settings. For more information, 
see “Understanding the Filr Site Default Language” in the Filr 2.0: Administration Guide.

The default language that the Filr mobile app and the Filr desktop application are displayed in is 
defined by the language set on the mobile device and the user workstation where the application 
is running.

10 (Optional) As a security precaution, you might want to change the administrator’s user ID from 
the default admin. The administrator user ID is used only when logging in to the Filr system on 
port 8443.

If you want to change the Administrator User ID, type a different name in the field. 

IMPORTANT: The password that you use to log in to the Filr system for the first time is the same 
as the user ID that you specify here. You will be prompted to change it the first time you log in.

11 Click Finish.

After the configuration is complete, a summary is displayed. 

This configuration summary contains information such as network, database, and so forth. You 
can modify these configuration settings at any time from the Configuration column on the left 
side of this page.

For information about each configuration option, see “Configuring and Maintaining the Filr 
Appliance” in the Filr 2.0: Administration Guide.

12 Continue with Chapter 7, “Setting Up the Filr Site,” on page 101 to make your site ready for user 
access.
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5 5Configuring and Maintaining the Search 
Index Appliance

 Section 5.1, “Configuring the Search Index Appliance,” on page 95

 Section 5.2, “Maintaining the Search Index Appliance,” on page 96

5.1 Configuring the Search Index Appliance
This section describes how to change additional configuration options for the search index appliance 
for a large deployment. If your search index is configured on the same appliance as your Filr 
application, you make configuration changes on the Filr appliance, as described in “Configuring and 
Maintaining the Filr Appliance” in the Filr 2.0: Administration Guide.

1 After installing the search index appliance, as described in Section 4.1, “Installing the Search 
Index Appliance,” on page 53, navigate to the following URL:

https://ip_address:9443

Replace ip_address with the IP address of your search index appliance.

2 Sign in to the search index appliance using the vaadmin user and the password that you set 
during installation.

The Novell Filr Search Appliance landing page is displayed.

3 Click the Filr Search Configuration icon.
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The Filr Search Configuration Wizard is displayed.

4 (Conditional) If this is the first time you have accessed the Filr search appliance, you must do the 
following:

4a Select New or Upgrade, depending on whether this is a new installation or an upgrade from 
a previous installation, then click Next.

4b Create a password for the default search appliance user.

IMPORTANT: In an environment where you are running multiple search index appliances, 
ensure that the password is the same for each search index appliance.

It is recommended that you have two search index appliances in a large or clustered Filr 
environment.

4c Click Finish.

The password for the search appliance user is now set.

The Search Settings page is displayed. 

5 On the Search Settings page, refer to the on-screen instructions for information about the fields 
that you can modify. 

NOTE: You can change the Username from lucene service at this point if you want to. The 
only requirement is that you specify exactly the same name across the Filr deployment you are 
creating or updating. 

6 Click Submit after you have made the desired modifications for your search settings.

5.2 Maintaining the Search Index Appliance
As time passes, you might need to optimize or rebuild your search index. High availability search 
indexes allow you to take one search appliance out of service for required maintenance while the 
other search appliance continues to operate.

For more information about how to perform needed maintenance on the search index, see “Managing 
the Lucene Index” in the Filr 2.0: Administration Guide. 

For information about an example setup, see “Completing the Cluster Setup” (https://
www.novell.com/documentation/novell-filr-1-1/filr-1-1_plan_deploy_bp/data/b19jgg94.html) in the 
Planning and Deployment Best Practices Guide (https://www.novell.com/documentation/novell-filr1/
filr1_plan_deploy_bp/data/bookinfo.html).
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6 6Configuring and Maintaining the MySQL 
Database Appliance

The MySQL database appliance is not intended for enterprise installations. If your organization has 
an existing MySQL or Microsoft SQL database, it is recommended that you configure Filr to use the 
existing database.

The following sections describe how to configure and maintain the MySQL database appliance if you 
decide to use the MySQL database appliance that ships with Filr as the Filr database.

 Section 6.1, “Configuring the MySQL Database Appliance,” on page 97

 Section 6.2, “Maintaining the MySQL Database Appliance,” on page 99

6.1 Configuring the MySQL Database Appliance
This section describes how to change configuration options for the MySQL database appliance for a 
large deployment, including how to change the credentials for the MySQL database. 

If you already have a MySQL database server that you want the Filr appliance to use, you can skip 
this section and update the configuration as described in Section 4.3, “Configuring an Existing 
Database Server,” on page 76.

IMPORTANT: In a production environment, it is a best practice to change the credentials for the 
MySQL database when the MySQL database is running as a separate appliance. If you do not 
change the credentials, you at least need to change the root password for the MySQL database.

If your MySQL database is configured on the same appliance as your Filr application, you make 
configuration changes on the Filr appliance, as described in “Configuring and Maintaining the Filr 
Appliance” in the Filr 2.0: Administration Guide.

1 After installing the database appliance, as described in Section 4.2, “Installing the MySQL 
Database Appliance,” on page 65, navigate to the following URL:

https://ip_address:9443

Replace ip_address with the IP address of your database appliance.

2 Sign in to the database appliance as vaadmin with the password that you set during installation.

The Novell MySQL Appliance landing page is displayed.
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3 Click the phpMyAdmin icon, then click Go to log in to phpMyAdmin.

4 Log in to the phpMyAdmin tool as root with password root. (You change the password in a 
future step.)

5 Create the filr user to administer the MySQL database:

5a At the top of the page, click Users.

5b Click Add user.

5c In the User name field, specify filr as the new user.

5d In the Host field, select Use text field in the drop-down list, then specify the IP address or 
host name of the Filr appliance.

5e In the Password field, specify a new password for the user, then confirm it in the Re-type 
field.

5f In the Database for user section:

 If you are installing the MySQL database for the first time: select Create database 
with same name and grant all privileges.

 If you are upgrading the MySQL database: select Grant all privileges on wildcard 
name.

5g In the Global privileges section, select Check All, then deselect all privileges in the 
Administration section.
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5h Click Go. Note the user name and password of this user. This is the user you will use to 
access the MySQL database when you configure the Filr appliance. 

You can now administer the Filr MySQL database by using this new user.

6 (Conditional) If you have a clustered Filr system with multiple Filr appliances, edit the privileges 
of the Filr user that you created in the previous step so that each of the Filr appliances is granted 
remote access to the database.

6a On the Users overview page, click Edit Privileges next to the user that you created in Step 
5.

6b Click the Login Information button. In the Host field, specify the IP address or host name of 
the next Filr appliance in the cluster.

6c In the Create a new user with the same privileges and... section, ensure that keep the old 
one is selected, then click Go.

6d Repeat this process for each Filr appliance in the cluster.

7 (Recommended) Change your MySQL root password if you have not done so already:

7a At the top of the page, click Users.

7b In the Users Overview table, locate the root user with localhost in the Host column, then 
click Edit Privileges for that user in the Action column.

7c Scroll to the Change password section. In the Password field, specify your password, then 
confirm it in the Re-type field.

7d Click Go.

8 Make any other configuration changes.

6.2 Maintaining the MySQL Database Appliance
The size of the MySQL log files (mysqld.log*) is checked every 7 days. If the log files consume more 
than 1 GB of total disk space at the time they are checked, the files are deleted.

If you want to delete the log files before the automatic check runs on day 7 or before the files reach 
the 1 GB threshold, you can manually trigger the log files to be deleted:

1 Restart the MySQL database appliance (as described in “Shutting Down and Restarting the 
Novell Appliance” in the Filr 2.0: Administration Guide).

or

Run the flush logs command from the MySQL appliance (mysqladmin flush-logs).
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7 7Setting Up the Filr Site

After you have installed and started Novell Filr, you will need to perform certain administrative tasks 
before your Filr site is ready for users to log in and start using Filr efficiently. 

Filr ships with most settings disabled by default, so you must enable each piece of functionality. This 
ensures that your data is not unknowingly exposed to users who do not usually have access to 
certain information. For example, users cannot share files until you give them the ability to do so. 

Some pieces of functionality, such as configuring Net Folders, must be enabled in the correct way in 
order to avoid unintended issues.

Complete the following steps to make your Filr site ready and available for users:

1 Add a valid license for each Filr appliance in your system. For more information, see “Viewing 
and Updating the Filr License” in the Filr 2.0: Administration Guide.

2 Change any appliance-specific configuration settings, such as network settings, email 
configuration, and so forth.

Appliance-specific configuration settings require that the Filr appliance be restarted in order for 
the configuration setting to take effect. Therefore, it is best to make any changes now, before you 
make your Filr site available to users.

For information about the settings you can change and how to change them, see “Changing 
Appliance Configuration Options” in the Filr 2.0: Administration Guide.

3 Add users and groups to your Filr site, either through an LDAP synchronization process or by 
manually creating users.

If the search context of your LDAP synchronization contains an OES or Windows server that has 
a Home folder attribute associated with at least one user, a Net Folder Server is ready to be 
configured immediately after running the LDAP synchronization process. You need to consider 
the amount of data in users’ Home folder directories when performing an LDAP synchronization. 
For information about the amount of time it takes to perform a full synchronization on a Net 
Folder, see “Planning the Amount of Data to Synchronize” in the Filr 2.0: Administration Guide. 

For more information about LDAP synchronization, see “Synchronizing Users and Groups from 
an LDAP Directory” or “Creating a New Local User” in the Filr 2.0: Administration Guide.

4 Configure email integration for the Filr site, as described in “Enabling and Customizing Filr’s 
Email Services” in the Filr 2.0: Administration Guide.

5 Set up sharing for the Filr site. You can enable users to share files and folders with internal users 
only, or with both internal and external users.

For more information about allowing users to share documents within Filr, see “Setting Up 
Sharing” in the Filr 2.0: Administration Guide.

6 Enable personal storage for the Filr site if you want users to upload files directly to the Filr site for 
their own personal use. These files are available in users’ My Files area.

For more information about personal storage, as well as how personal storage relates to users’ 
Home folders, see “Setting Up Personal Storage” in the Filr 2.0: Administration Guide.

7 Configure Net Folders for your Filr site. Net Folders in Filr provide access to files on your 
corporate OES, Windows, or NetWare file servers by synchronizing file metadata. In essence, a 
Net Folder is simply a pointer or a reference to a specific folder on a specific file server. 

Filr can be configured to index the content of Net Folders to make the content searchable.
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For more information about Net Folders, see “Setting Up Net Folders” the Filr 2.0: Administration 
Guide.

IMPORTANT: Configuring Net Folders in a sub-optimal way can result in unsatisfactory 
performance of your Filr system. The ideal Net Folder configuration can vary greatly depending 
on the number of files that you want to synchronize to Filr, the frequency in which files are 
modified, and so forth. Before configuring Net Folders, become familiar with the various 
subtleties related to Net Folders, as described in “Planning Net Folder Creation” the Filr 2.0: 
Administration Guide.

8 (Optional) Allow access to the Filr site through NetIQ Access Manager.

For more information about using NetIQ Access Manager with Filr, see “Allowing Access to the 
Filr Site through NetIQ Access Manager” in the Filr 2.0: Administration Guide.

IMPORTANT: When you use NetIQ Access Manager with Filr, external users cannot access 
your Filr site. This means that the following features are not functional:

 Users are not able to share with external users, as described in “Sharing with People 
Outside Your Organization” in the Filr 2.0: Web Application User Guide.

 Users cannot make items accessible to the public, as described in “Making Files Accessible 
to the Public” in the Filr 2.0: Web Application User Guide.

This means that public users cannot access the Filr site as the Guest user. For more 
information about the Guest user, see “Allowing Guest Access to Your Filr Site” in the Filr 
2.0: Administration Guide.

For more information about external users in Filr, see “Allowing External Users Access to Your 
Filr Site” in the Filr 2.0: Administration Guide.

9 Configure mobile device access to the Filr site, as described in “Configuring Mobile Device 
Access to the Filr Site” in the Filr 2.0: Administration Guide.

10 Configure the Filr desktop application to access files from the Filr site.

For more information about configuring the Filr desktop application, see “Setting Up the Filr 
Desktop Application” in the Filr 2.0: Administration Guide.

IMPORTANT: For optimal performance of the Filr system when using the Filr desktop 
application, consider the following: 

 Users should not configure the Filr desktop application to synchronize more than 1,000 total 
files, or to synchronize individual files that are larger than 1 GB to their workstations. For 
information about how users can configure the Filr desktop application to synchronize files 
to their workstations, see the Novell Filr 2.0 Desktop Application for Windows Quick Start 
(https://www.novell.com/documentation/novell-filr-2/filr-2-qs-desktop/data/filr-2-qs-
desktop.html) and the Novell Filr 2.0 Desktop Application for Mac Quick Start (https://
www.novell.com/documentation/novell-filr-2/filr-2-qs-desktopmac/data/filr-2-qs-
desktopmac.html).

 Depending on your environment and the settings that you choose for the Filr desktop 
application, the Filr desktop application can put a significant load on your Filr system. For 
information about the factors that affect load, see “Planning Filr Desktop Application Usage 
for Your Filr Site” in the Filr 2.0: Administration Guide.

11 Configure Filr to support WebDAV on a Windows 7 environment, as described in “Configuring 
Filr to Support WebDAV on Windows 7” in the Filr 2.0: Administration Guide.

12 If your Filr site needs to support multiple languages, configure the site as described in “Managing 
a Multiple-Language Filr Site” in the Filr 2.0: Administration Guide.
102 Filr 2.0: Installation and Configuration Guide

https://www.novell.com/documentation/novell-filr-2/filr-2-qs-desktop/data/filr-2-qs-desktop.html
https://www.novell.com/documentation/novell-filr-2/filr-2-qs-desktopmac/data/filr-2-qs-desktopmac.html
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#netfolders
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#b13mfom8
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#btk7698
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#btk7698
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-user-web/filr-2-user-web.pdf#b11v1e8b
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-user-web/filr-2-user-web.pdf#b11v1e8b
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-user-web/filr-2-user-web.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-user-web/filr-2-user-web.pdf#b11z77gg
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-user-web/filr-2-user-web.pdf#b11z77gg
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-user-web/filr-2-user-web.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#b11za1yv
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#accessexternal
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#accessexternal
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#b13ga8ho
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#b13ga8ho
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#desktopapp
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#desktopapp
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#b179myc8
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#b179myc8
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#br2qg1d
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#br2qg1d
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bjth41r
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bjth41r
https://www.novell.com/documentation/novell-filr-2/pdfdoc/filr-2-admin/filr-2-admin.pdf#bookinfo


13 Before your site is ready for use, ensure that you have reviewed all other topics discussed in 
“Setting Up the Filr Site before Users Log In” in the Filr 2.0: Administration Guide.

14 After you have completed all of the topics that are relevant to your Filr environment, as 
discussed in the Filr 2.0: Administration Guide, you can invite users to use the Filr site. For 
information about how to use the Filr site, see Filr 2.0: Web Application User Guide.
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8 8Upgrading Filr

Critical Prerequisites and Cautions for Successful Upgrades

Failure to comply with any of the following critical points can result in a non-functional Filr system.

NOTE: As an additional resource to the information in this section, TID 7017288 has a “Pre-Flight 
Checklist” that can help you ensure a successful upgrade.

Critical Points Details

 You cannot upgrade directly from Filr 1.0 or 1.0.1 
to Filr 2.0

You must first upgrade to Filr 1.2, apply all patches, 
ensure that all desktop clients are updated, and then 
upgrade to Filr 2.0.

 You cannot upgrade from Small to Large If you have a small, all-in-one deployment, and you 
need a large, separate-appliance deployment, you 
must install new appliances.

 You cannot upgrade from non-clustered Large to 
clustered Large

If you have a large non-clustered deployment, and you 
need a large clustered deployment, you must install a 
new system. (The shared storage location, /vashare, 
must be configured during the initial installation.)

Or, contact Novell Consulting to assist you with the 
migration.

 Meet all hardware and software requirements See Section 1.2, “Filr System Requirements,” on 
page 12

IMPORTANT: Memory requirements for the Filr and 
database appliances have increased with Filr 1.2 (see 
“Memory Requirements” on page 15).

 Ensure that each appliance has unformatted disk 
space available for a new /var disk

For each appliance you are upgrading, you must plan 
to create a third disk for storing system event log files.

 Ensure that each Filr 1.2 system is fully patched 
before upgrading to Filr 2.0

See “Managing Field Test Patches” in the Filr 2.0: 
Administration Guide.

 Do not copy the entire VM when upgrading Copying the entire VM causes various problems, 
including the reassignment of the Eth0 interface to 
Eth1. Filr supports only Eth0 as the primary network 
interface.

Copy only the datastore disk to the new VM location, 
as specified in Section 8.3, “Copying the Appliance 
Data Storage Location to Prepare for the Upgrade,” on 
page 107.

 (VMware) Remove all snapshots prior to 
upgrading an appliance

This is required to ensure that the correct disk file and 
the latest configuration settings get migrated.
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Complete the instructions in the following sections as applicable to upgrade from Filr 1.1 or 1.2 to Filr 
2.0.

 Section 8.1, “Upgrade Caveats,” on page 106

 Section 8.2, “Preparing Network Interface Controllers to Be Upgraded,” on page 107

 Section 8.3, “Copying the Appliance Data Storage Location to Prepare for the Upgrade,” on 
page 107

 Section 8.4, “Upgrading the Filr, Search, or Database Appliances,” on page 108

 Section 8.5, “Performing Post-Upgrade Tasks,” on page 128

8.1 Upgrade Caveats
Before you upgrade your Filr installation, be aware of the following:

 MySQL Port Setting Changes Are Not Retained: If you have changed the port for MYSQL 
communications, be aware that your changes are not retained and must be reset after the 
upgrade.

 You must upgrade the appliances in the proper 
order.

Successful upgrades require that appliances be 
upgraded in the order of dependency upon each other, 
as follows:

1. Upgrade the MySQL appliance first.

2. Upgrade the Filr Search appliances next, one at 
a time.

3. When the upgraded MySQL and Filr search 
appliances are up and running, upgrade the first 
Filr appliance in the cluster. Then upgrade the 
additional Filr appliances, one at a time.

IMPORTANT: All of the Filr and Filr Search appliances 
in a Large clustered deployment must run the same 
version. 

 If you are migrating the Filr database to Microsoft 
SQL ...

Carefully follow the instructions in Appendix B, 
“Migrating the Filr Database from MySQL to Microsoft 
SQL,” on page 141, including running the Post-
Migration script.

 If your appliances have multiple Network 
Adapters ...

Carefully follow the instructions in Section 8.2, 
“Preparing Network Interface Controllers to Be 
Upgraded,” on page 107, including running the 
networkprep script.

 Fully patch any OES 11 SP1 target servers Ensure that any Filr target servers running OES 11 
SP1 have at least the December 2012 Scheduled 
Maintenance Update applied. This ensures that the 
NCP server can keep up with the increased service 
requests of Filr 2.0.

Failure to update your OES 11 SP1 servers can cause 
the configured eDirectory (LDAP) servers to fail.

Critical Points Details
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For more issues associated with appliance upgrades, see “Upgrade Notes” in the Novell Filr 2.0 
Release Notes.

8.2 Preparing Network Interface Controllers to Be 
Upgraded
If your Filr 1.1 or 1.2 system has been configured with additional Network Interface Controllers 
(NICs), you need to run a script that prepares the additional NICs to be upgraded to Filr 2.0. If you fail 
to run the script, your NICs might not work properly after being upgraded to the Filr 2.0 system.

1 Download the networkprep.zip file from the same location where you downloaded the Filr 
software in the Novell Customer Center (NCC) (https://www.novell.com/center).

2 Enable SSH on the Filr appliance, as described in “Changing System Services Configuration” in 
the Filr 2.0: Administration Guide.

3 Using an SSH client (such as WinSCP), log in to the Filr appliance as the root user.

4 Copy the networkprep.zip file that you downloaded in Step 1 to the /root/ directory on the Filr 
appliance.

5 Unzip the networkprep.zip file:

unzip networkprep.zip

The networkprep folder is created.

6 Change to the network prep folder:

cd /root/networkprep

7 Run the following script to prepare the Filr 1.1 or 1.2 system for the upgrade to Filr 2.0:

sh run-networkprep.sh

8 Shut down the remote SSH connection to the Filr appliance.

9 Continue with Section 8.4, “Upgrading the Filr, Search, or Database Appliances,” on page 108.

8.3 Copying the Appliance Data Storage Location to 
Prepare for the Upgrade
Before upgrading your existing Filr system, you should create a copy of the appliance data storage 
location (/vastorage). You use this copy when configuring the new Filr system.

1 On each Filr, database, and search index appliance in the existing Filr system, use the Datastore 
Browser to create a copy of the appliance data storage location (/vastorage).

In order to create a copy of the data storage location, your hypervisor might require that the 
appliance is first shut down.

2 Continue with Section 8.2, “Preparing Network Interface Controllers to Be Upgraded,” on 
page 107.
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8.4 Upgrading the Filr, Search, or Database 
Appliances
The method of upgrading is the same for the Filr appliance, search appliance, and the database 
appliance. 

Although it is possible to install a new search index appliance and subsequently re-index your data, 
Novell recommends that in a production environment you upgrade your existing search index 
appliances rather than install new appliances and re-index your data.

The data location for the original appliance that you are upgrading from must be independent of the 
appliance on a separate VMware, Xen, or Hyper-V hard disk, as described in Section 1.2, “Filr 
System Requirements,” on page 12.

The upgrade process differs depending on your virtual platform.

IMPORTANT: You can upgrade only to the same virtual platform as the platform where you deployed 
your original Filr system. For example, if your original Filr system was deployed on VMware, you can 
upgrade only to VMware. 

 Section 8.4.1, “VMware,” on page 108

 Section 8.4.2, “Xen,” on page 114

 Section 8.4.3, “Hyper-V,” on page 121

8.4.1 VMware

1 Download the software to your management workstation:

 Filr Appliance: Filr.x86_64-version.ovf.zip

 Search Appliance: Filrsearch-version.ovf.zip

 Database Appliance: MySQL.x86_64-version.ovf.zip

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the on the Novell Downloads page (http://
download.novell.com).

2 Extract the file that you downloaded in Step 1 on your management workstation until one of the 
following folders appears, depending on which appliance you are upgrading:

 Filr-version

 Filrsearch-version

 MySQL-version

3 In the vSphere client, click File > Deploy OVF Template.

4 Browse to and select the .ovf file in the Filr-version file folder.

5 Click Next.

6 Click Next again.

7 In the Name field, rename the Filr appliance to a name of your choosing, then click Next.

8 Select the datastore where you want to store the virtual machine files, then click Next.

9 Click Next to accept the default for the disk format.

10 Click Finish.

11 Shut down the appliance you are upgrading from.
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IMPORTANT: When shutting down the appliance, be aware of the following limitations: 

 In a large deployment with one or more Filr appliances, always bring down the Filr 
appliances first before you bring down the search appliances or database appliance. When 
restarting, start the Filr appliances last.

 In a large deployment with one or more Filr appliances, complete the search appliance 
upgrades before attempting to upgrade the Filr appliances. If the source Filr system 
contains multiple search index appliances, all search appliances must be upgraded and 
available before you run the Upgrade wizard for the Filr appliances. If not, the upgrade is 
not successful. 

Rolling upgrades (upgrading one Filr or search index server while another continues to 
serve clients) are not supported when upgrading Filr in a clustered environment. This issue 
does not affect small or non-clustered large deployments.

 When you shut down the appliance, use the Shutdown button from the Novell Appliance 
Configuration screen (as described in “Shutting Down and Restarting the Novell Appliance” 
in the Filr 2.0: Administration Guide). You can also use the init 0 command from the 
appliance console when you are logged in as root.

12 Before you power on the new appliance, point it to a copy of the VMware data disk that your 
previous appliance used (Hard Disk 2). (This is the copy that you created in Section 8.3, 
“Copying the Appliance Data Storage Location to Prepare for the Upgrade,” on page 107.)

For example, for ESX 5.x:

12a In the vSphere client, right-click the virtual machine that you just created, and for which you 
want to create secondary storage, then click Edit Settings.

The Virtual Machine Properties page is displayed.

12b On the Hardware tab, click Add.

The Add Hardware dialog box is displayed.

12c Select Hard Disk, then click Next.

12d Select Use an existing virtual disk, then click Next.

12e Next to the Disk File Path field, click Browse, browse to and select the datastore or 
datastore cluster where you copied the VMware data disk that your previous appliance used 
(Hard Disk 2). (This is the copy that you created in Section 8.3, “Copying the Appliance 
Data Storage Location to Prepare for the Upgrade,” on page 107.) Then click OK.

12f Click Next.

12g In the Virtual Device Node section, select SCSI (1:0) from the drop-down list.

12h (Optional) In the Mode section, select Independent, select Persistent.

This is a recommended best practice to prevent snapshots, which must be removed before 
any future upgrades are performed.

12i Click Next.

12j Click Finish.

13 Create another separate VMware hard disk for the appliance. This hard disk is used to store the 
/var directory for the appliance. (The /var directory is where system events for the Novell 
appliances are logged.)

13a In the Virtual Machine Properties window, on the Hardware tab, click Add.

13b Select Hard Disk, then click Next.

13c Leave Create a new virtual disk selected, then click Next.
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13d In the Disk Size field, specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 40 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

13e In the Location section, select Specify a datastore or datastore cluster, then click Browse.

13f Select a datastore, then click OK.

13g Click Next.

13h In the Virtual Device Node section, select SCSI (2:0) from the drop-down list.

13i Leave the Mode section blank, then click Next.

You do not need to select anything in this section, because unlike Hard Disk 2, this hard 
disk does not need to be carried over on an upgrade.

13j Click Finish.

14 (Conditional) If you added an additional Network Interface Controller (NIC) when you installed 
the Filr appliance, point the new appliance to the secondary NIC.

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

14a In the Virtual Machine Properties window, on the Hardware tab, click Add.

The Add Hardware dialog box is displayed.

14b Select Ethernet Adapter, then click Next.

14c In the Network Label drop-down list, select the name of the secondary NIC.

14d Click Next > Finish.

15 Increase the amount of memory that VMware allocates for the Filr appliance. 

The default of 8 GB is the recommended minimum amount of memory for a large deployment. 
Novell also recommends 2 CPUs. 

For an all-in-one deployment, you should increase the default to at least 12 GB of memory and 4 
CPUs.

Small deployments require more CPUs and memory because in a small deployment, all 
components are running on a single virtual machine.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in “Changing 
the JVM Configuration Settings” in the Filr 2.0: Administration Guide, and in Section 5.1, 
“Configuring the Search Index Appliance,” on page 95. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the Java 
heap until after the appliance is installed.

15a In the Virtual Machine Properties window, select Memory, then increase the setting to a 
suitable size for your environment.

15b Click OK to exit the Virtual Machine Properties window.
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16 Before powering on the appliance that you are upgrading, ensure that the appliance has all the 
required disks:

17 Power on the appliance (virtual machine).

IMPORTANT: In a large deployment, you must power on the search index and database 
appliances before you power on the Filr appliance. These appliances must be running at the 
time you power on the Filr appliance.

18 Click the Console tab. 

A dialog box is displayed, prompting for the root and vaadmin passwords. 

If this dialog box is not displayed after powering on the appliance, begin the upgrade process 
again and ensure that you have configured the new Filr system to point to the data storage 
location of the source Filr system.

19 Specify and confirm the root and vaadmin passwords for the appliance you are upgrading from, 
then click OK.

A message indicating that the upgrade was successful is displayed.

Appliance Type Appliance Disk (Disk 1)

(Created new in Filr 2.0 
System)

/vastorage (Disk 2)

(Copied from original 
system)

/var (Disk 3)

(Created new in Filr 2.0 
System)

MySQL Required

New

Required

Copied

See Step 12.

Required

New

See Step 13.

Search Index Required

New

Required

Copied

See Step 12.

Required

New

See Step 13.

Filr Required

New

Required

Copied

See Step 12.

Required

New

See Step 13.
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IMPORTANT: At this stage of the upgrade process, consider the following:

 When upgrading multiple Filr appliances in a large installation, you must wait for the 
upgrade to succeed on one Filr appliance before beginning the upgrade process for another 
Filr appliance in the cluster.

 When upgrading the Filr database, the upgrade process can take a significant amount of 
time with no visual indication that upgrade is in process. It is typical for the upgrade to take 
10 minutes for every 1 GB of information in the database. For example, upgrading a 6 GB 
database takes about one hour to complete.

20 In a browser, navigate to the following URL:

https://ip_address:9443

Use the IP address or DNS name of the server that you specified during the appliance 
installation.

21 You can now log in to the appliance using the vaadmin user and the password that you set.

The Novell Filr Appliance, Novell MySQL Appliance, or Novell Filr Search Appliance landing 
page is displayed, depending on which appliance you are upgrading.

22 (Conditional) If you are upgrading the search appliance:

22a Click the Filr Search Appliance Configuration icon.

The Search Settings page is displayed.
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22b (Conditional) If the Filr Configuration wizard is displayed rather than the Settings, there was 
a problem with the configuration. Resolve any configuration issues, then click Finish to 
reconfigure the system.

22c Ensure that all of the settings are set to your desired specifications.

23 (Conditional) If you are upgrading the database appliance:

23a Click the phpMyAdmin icon.

23b Verify that the database is populated.

24 (Conditional) If you are upgrading the Filr appliance in a large deployment:

24a Click the Filr Appliance Configuration icon.

The Filr Settings page is displayed.

24b (Conditional) If the Filr Configuration wizard is displayed rather than the Settings page, 
there was a problem with the configuration. Resolve any configuration issues, then click 
Finish to reconfigure the system.

Following are common configuration issues:

 If your system is not using DNS, this is most likely a problem due to unresolvable DNS 
names and missing /etc/hosts entries.

 The Filr appliance does not have access to the database.

24c Ensure that all of the settings are set to your desired specifications.

25 (Conditional) If you are upgrading the Filr appliance in a small deployment:

25a Click the Filr Appliance Configuration icon.
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The Filr Settings page is displayed.

25b (Conditional) If the Filr Configuration wizard is displayed rather than the Settings page, 
there was a problem with the configuration. Resolve any configuration issues, then click 
Finish to reconfigure the system.

25c Ensure that all of the settings are set to your desired specifications.

25d Click Home, then click the phpMyAdmin icon.

25e Verify that the database is populated.

26 In a large deployment, repeat this process for each appliance in the Filr system.

For information about how to add additional Filr appliances to the Filr system, see “Adding a Filr 
Appliance to an Existing Deployment to Accommodate System Load” on page 33.

27 Continue with Section 8.5, “Performing Post-Upgrade Tasks,” on page 128.

8.4.2 Xen

IMPORTANT: You can upgrade only to the same virtual platform as the platform where you deployed 
your original Filr system. For example, if your original Filr system was deployed on VMware, you can 
upgrade only to VMware.

1 Log in to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on 
Linux:

ssh -X root@host_ip_address

You must use the -X in the command in order to display the GUI installation program. The steps 
in this section use the GUI installation program to configure the server.

2 Navigate to the /var/lib/xen/images directory on the host server.

3 Create a new directory inside the images directory where you can download the Filr software. 
The name of this directory must be the same as the name that you plan to use for your Filr virtual 
appliance. For example, if you plan to name the Filr appliance Filr1, the name of this new 
directory must also be Filr1.

4 Change to the directory that you just created. For example, /var/lib/xen/images/Filr1.

5 Download the software to the current directory on the host server. For example:

/var/lib/xen/images/Filr1

 Filr Appliance: Filr.x86_64-version.xen.tar.gz
114 Filr 2.0: Installation and Configuration Guide



 Search Appliance: Filrsearch-version.xen.tar.gz

 Database Appliance: MySQL.x86_64-version.xen.tar.gz

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version on the Novell Downloads page (http://
download.novell.com).

6 Untar the file that you downloaded in Step 5 in the directory where you downloaded it.

You can use the following command to untar the file:

tar -Sxvzf Filr.x86_64-version.xen.tar.gz

A filr-version directory is created; it contains a .raw file that you will use to run the virtual 
image. This process can take a few minutes.

7 From the host server, run the following command to launch the GUI configuration menu:

vm-install

The Create a Virtual Machine wizard is displayed.

8 Click Forward.

9 Select I have a disk or disk image with an installed operating system, then click Forward.

10 Leave SUSE Linux Enterprise Server 11 selected, then click Forward.

11 Rename the virtual machine by clicking Name of Virtual Machine and specifying a new name in 
the Name field. Then click Apply. For example, Filr1.

12 Configure the amount of memory and number of CPUs that Xen allocates for the Filr appliance. 

12a On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of memory that is available on the host server.

Initial Memory: 8 GB is the recommended minimum for a large deployment.

For an all-in-one deployment, you should increase the default to at least 12 GB of memory.

Small deployments require more memory because in a small deployment, all components 
are running on a single virtual machine.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in 
“Changing the JVM Configuration Settings” in the Filr 2.0: Administration Guide, and in 
Section 5.1, “Configuring the Search Index Appliance,” on page 95. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the 
Java heap until after the appliance is installed.

Maximum Memory: Set this to the same value as you set for Initial Memory.

Available Processors: Displays the number of available processors on the host server.

Virtual Processors: Specify 2 CPUs for a large deployment and 4 CPUs for a small 
deployment. At least half of the memory should be dedicated to the Java heap. (Java heap 
is set in the Filr configuration.)

Small deployments require more CPUs because in a small deployment, all components are 
running on a single virtual machine.

12b Click Apply.

13 Configure the bootable disk image:

13a On the Summary page, click Disks.

13b Click Harddisk.

13c On the Virtual Disk page, specify the following information:
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Source: Click Browse, then browse to the .raw file that you untared in Step 6.

Protocol: Select file:.

Size (GB): The default size is 40.1 GB. This cannot be changed.

Create Sparse Image File: This option is not available.

Read-Only Access: Do not select this option.

13d Click OK.

14 Shut down the appliance that you are upgrading.

IMPORTANT: When shutting down the appliance, be aware of the following limitations: 

 In a large deployment with one or more Filr appliances, always bring down the Filr 
appliances first before you bring down the search appliances or database appliance. When 
restarting, start the Filr appliances last.

 In a large deployment with one or more Filr appliances, complete the search appliance 
upgrades before attempting to upgrade the Filr appliances. If the source Filr system 
contains multiple search index appliances, all search appliances must be upgraded and 
available before you run the Upgrade wizard for the Filr appliances. If not, the upgrade is 
not successful. 

Rolling upgrades (upgrading one Filr or search index server while another continues to 
serve clients) are not supported when upgrading Filr in a clustered environment. This issue 
does not affect small or non-clustered large deployments.

 When you shut down the appliance, use the Shutdown button from the Novell Appliance 
Configuration screen (as described in “Shutting Down and Restarting the Novell Appliance” 
in the Filr 2.0: Administration Guide). You can also use the init 0 command from the 
appliance console when you are logged in as root.

15 Before you power on the new appliance, point it to a copy of the Xen data disk (Hard Disk 2) that 
your previous appliance used. (This is the copy that you created in Section 8.3, “Copying the 
Appliance Data Storage Location to Prepare for the Upgrade,” on page 107.)

15a On the Disks page, click Harddisk.

15b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the .raw file that will be created when 
the virtual machine is created. If desired, you can rename the disk in the source field from 
disk0 to a name of your choosing.

Protocol: Select file:.

Size (GB): Specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 100 GB.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

16 Create another separate Xen hard disk for the appliance. This hard disk is used to store the /var 
directory for the appliance. (The /var directory is where system events for the Novell appliances 
are logged.)

16a On the Disks page, click Harddisk.

16b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the .raw file that will be created when 
the virtual machine is created. If desired, you can rename the disk in the source field from 
disk0 to a name of your choosing.

Protocol: Select file:.
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Size (GB): Specify the amount of hard disk space that you want to allocate. The 
recommended minimum is 40 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

Create Sparse Image File: Select this option.

Read-Only Access: Do not select this option.

17 (Conditional) If you added an additional Network Interface Controller (NIC) when you installed 
the Filr appliance, point the new appliance to the secondary NIC.

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration

 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

17a From the virtual machine page, click Add Hardware.

17b Select Network.

17c In the Host device drop-down list, select the name of the secondary NIC.

17d Click Finish.

18 Before powering on the appliance that you are upgrading, ensure that the appliance has all the 
required disks:

19 Power on the appliance (virtual machine).

IMPORTANT: In a large deployment, you must power on the search index and database 
appliances before you power on the Filr appliance. These appliances must be running at the 
time you power on the Filr appliance.

20 Click the Console tab.

A dialog box is displayed, prompting for the root and vaadmin passwords. 

Appliance Type Appliance Disk 
(Disk 1)

/vastorage (Disk 2)

(Copied from 
original system)

/var (Disk 3)

(Created new in Filr 
2.0 System)

MySQL Required

New

Required

Copied

See Step 15.

Required

New

See Step 16.

Search Index Required

New

Required

Copied

See Step 15.

Required

New

See Step 16.

Filr Required

New

Required

Copied

See Step 15.

Required

New

See Step 16.
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If this dialog box is not displayed after powering on the appliance, begin the upgrade process 
again and ensure that you have configured the new Filr system to point to the data storage 
location of the source Filr system.

21 Specify and confirm the root and vaadmin passwords for the appliance you are upgrading from, 
then click OK.

A message indicating that the upgrade was successful is displayed.

IMPORTANT: At this stage of the upgrade process, consider the following:

 When upgrading multiple Filr appliances in a large installation, you must wait for the 
upgrade to succeed on one Filr appliance before beginning the upgrade process for another 
Filr appliance in the cluster.

 When upgrading the Filr database, the upgrade process can take a significant amount of 
time with no visual indication that upgrade is in process. It is typical for the upgrade to take 
10 minutes for every 1 GB of information in the database. For example, upgrading a 6 GB 
database takes about one hour to complete.

22 Click Configure.

A message indicating that the installation was successful is displayed.

23 In a browser, navigate to the following URL:

https://ip_address:9443

Use the IP address or DNS name of the server that you specified during the appliance 
installation.

24 Log in to the appliance using the vaadmin user and the password that you set.

The Novell Filr Appliance, Novell MySQL Appliance, or Novell Filr Search Appliance landing 
page is displayed, depending on which appliance you are upgrading.
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25 (Conditional) If you are upgrading the search appliance:

25a Click the Filr Search Appliance Configuration icon.

The Search Settings page is displayed.

25b (Conditional) If the Filr Configuration wizard is displayed rather than the Settings page, 
there was a problem with the configuration. Resolve any configuration issues, then click 
Finish to reconfigure the system.

25c Ensure that all of the settings are set to your desired specifications.

26 (Conditional) If you are upgrading the database appliance:

26a Click the phpMyAdmin icon.
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26b Verify that the database is populated.

27 (Conditional) If you are upgrading the Filr appliance in a large deployment:

27a Click the Filr Appliance Configuration icon.

The Filr Settings page is displayed.

27b (Conditional) If the Filr Configuration wizard is displayed rather than the Settings page, 
there was a problem with the configuration. Resolve any configuration issues, then click 
Finish to reconfigure the system.

Following are common configuration issues:

 If your system is not using DNS, this is most likely a problem due to unresolvable DNS 
names and missing /etc/hosts entries.

 The Filr appliance does not have access to the database.

27c Ensure that all of the settings are set to your desired specifications.

28 (Conditional) If you are upgrading the Filr appliance in a small deployment:

28a Click the Filr Appliance Configuration icon.

The Search Settings page is displayed.

28b (Conditional) If the Filr Configuration wizard is displayed rather than the Settings page, 
there was a problem with the configuration. Resolve any configuration issues, then click 
Finish to reconfigure the system.

28c Ensure that all of the settings are set to your desired specifications.

28d Click Home, then click the phpMyAdmin icon.
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28e Verify that the database is populated.

29 In a large deployment, repeat this process for each appliance in the Filr system.

For information about how to add additional Filr appliances to the Filr system, see “Adding a Filr 
Appliance to an Existing Deployment to Accommodate System Load” on page 33.

30 Continue with Section 8.5, “Performing Post-Upgrade Tasks,” on page 128.

8.4.3 Hyper-V

IMPORTANT: You can upgrade only to the same virtual platform as the platform where you deployed 
your original Filr system. For example, if your original Filr system was deployed on VMware, you can 
upgrade only to VMware. 

1 Log in to the host server either locally or from a remote workstation.

You can use Windows Remote Desktop to log in to the host server from a remote workstation.

2 Create a new directory in the location where you want each virtual machine to reside (for 
example, C:\Users\Public\Documents\Hyper-V\Virtual Hard Disks). In a later step, you 
will download the Filr software to this directory. 

As a best practice, give this directory the same name that you plan to use for your Filr virtual 
appliance. For example, if you plan to name the Filr appliance Filr1, the name of this new 
directory should also be Filr1.

3 Download the software to your management workstation:

 Filr Appliance: Filr.x86_64-version.ovf.zip

 Search Appliance: Filrsearch-version.ovf.zip

 Database Appliance: MySQL.x86_64-version.ovf.zip

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version on the Novell Downloads page (http://
download.novell.com).

4 Extract the file that you downloaded in Step 3 to a the directory on the host server that you 
created in Step 2.

5 Open the Hyper-V Manager.

6 In Hyper-V Manager, right-click the disk name in the Action Pane where you want to create the 
new virtual machine, then click New > Virtual Machine.

The New Virtual Machine Wizard is displayed.

7 Review the Before You Begin page, then click Next.
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8 In the Name field, specify a name for the new virtual machine. For example, Filr1.

9 Click Next.

10 In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual 
machine. 8 GB (8192 MB) is the recommended minimum for a large deployment of Filr.

For an all-in-one (small) deployment, you should increase the default to at least 12 GB (12288 
MB) of memory. Small deployments require more memory because in a small deployment, all 
components are running on a single virtual machine.

IMPORTANT: When you increase or decrease server memory for the Filr appliance or the 
search index appliance, you should also modify the Java heap size, as described in “Changing 
the JVM Configuration Settings” in the Filr 2.0: Administration Guide, and in Section 5.1, 
“Configuring the Search Index Appliance,” on page 95. 

At least half of the memory should be dedicated to the Java heap. You cannot adjust the Java 
heap until after the appliance is installed.

11 Click Next.

12 On the Configure Networking page, select the networking card of your choice, then click Next.

13 Configure the bootable disk image:

13a On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then 
browse to the .vhd file that was in the downloaded .zip file that you extracted in Step 4.

13b Click Open to select the file, then click Next.

14 Click Finish.

WARNING: If for any reason you need to delete the new or the previous appliance, you must 
unlink (remove) the disk. Otherwise, the disk is deleted. Having the disk linked to the original or 
to the new appliance does not provide the expected safeguard. In other words, if the disk is 
linked to multiple appliances and you delete one of them, the disk is deleted despite the 
remaining link.

15 Shut down the appliance that you are upgrading.

IMPORTANT: When shutting down the appliance, be aware of the following limitations: 

 In a large deployment with one or more Filr appliances, always bring down the Filr 
appliances first before you bring down the search appliances or database appliance. When 
restarting, start the Filr appliances last.

 In a large deployment with one or more Filr appliances, complete the search appliance 
upgrades before attempting to upgrade the Filr appliances. If the source Filr system 
contains multiple search index appliances, all search appliances must be upgraded and 
available before you run the Upgrade wizard for the Filr appliances. If not, the upgrade is 
not successful. 

Rolling upgrades (upgrading one Filr or search index server while another continues to 
serve clients) are not supported when upgrading Filr in a clustered environment. This issue 
does not affect small or non-clustered large deployments.

 When you shut down the appliance, use the Shutdown button from the Novell Appliance 
Configuration screen (as described in “Shutting Down and Restarting the Novell Appliance” 
in the Filr 2.0: Administration Guide). You can also use the init 0 command from the 
appliance console when you are logged in as root.
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16 Before you power on the new appliance, point it to a copy of the Hyper-V data disk that your 
previous appliance used (Hard Disk 2). (This is the copy that you created in Section 8.3, 
“Copying the Appliance Data Storage Location to Prepare for the Upgrade,” on page 107.)

16a In Hyper-V Manager, right-click the virtual machine that you just created, then click 
Settings.

16b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

16c Select Virtual hard disk, then click New.

16d Review the Before You Begin page, then click Next.

16e On the Choose Disk Format page, select VHD, then click Next.

16f On the Choose Disk Type page, select Fixed size, then click Next.

16g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, FilrDisk2.

Location: Specify the location where you want the hard drive to be located. 

16h On the Configure Disk page, select Use an existing blank virtual hard disk, then specify a 
size for the hard disk. The recommended minimum is 25 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

16i Click Next.

16j Review the summary information, then click Finish > OK.

17 Create another separate Hyper-V hard disk for the appliance. This hard disk is used to store the 
/var directory for the appliance. (The /var directory is where system events for the Novell 
appliances are logged.)

17a In Hyper-V Manager, right-click the virtual machine for which you want to create a new hard 
disk, then click Settings.

17b In the Add Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

17c Select Virtual hard disk, then click New.

17d Review the Before You Begin page, then click Next.

17e On the Choose Disk Format page, select VHD, then click Next.

17f On the Choose Disk Type page, select Fixed size, then click Next.

17g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, FilrDisk3.

Location: Specify the location where you want the hard drive to be located. 

17h On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size 
for the hard disk. The recommended minimum is 40 GB.

For more detailed information about the type of information that is stored here, see “Filr 
Appliance Storage” on page 19.

17i Click Next.

17j Review the summary information, then click Finish > OK.

18 (Conditional) If you added an additional Network Interface Controller (NIC) when you installed 
the Filr appliance, point the new appliance to the secondary NIC.

IMPORTANT: An additional NIC should be used only if you have multiple networks associated 
with the Filr site for one or more of the following purposes:

 Appliance administration
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 An NFS mount or CIFS share for the /vashare mount point

 Security of memcached in a Filr-clustered deployment

Bonding or teaming NICs is not supported with Filr.

18a In Hyper-V Manager, right-click the virtual machine for which you want to create a new hard 
disk, then click Settings.

18b In the Add Hardware section, select Networks Adapter, then click Add.

18c In the Virtual Switch drop-down list, select the name of the secondary NIC.

18d Make any other relevant configuration changes, then click OK.

19 Before powering on the appliance that you are upgrading, ensure that the appliance has all the 
required disks:

20 Power on the appliance (virtual machine).

IMPORTANT: In a large deployment, you must power on the search index and database 
appliances before you power on the Filr appliance. These appliances must be running at the 
time you power on the Filr appliance.

21 Click the Console tab.

A dialog box is displayed, prompting for the root and vaadmin passwords. 

If this dialog box is not displayed after powering on the appliance, begin the upgrade process 
again and ensure that you have configured the new Filr system to point to the data storage 
location of the source Filr system.

Appliance Type Appliance Disk 
(Disk 1)

/vastorage (Disk 2)

(Copied from 
original system)

/var (Disk 3)

(Created new in Filr 
2.0 system)

MySQL Required

New

Required

Copied

See Step 16.

Required

New

See Step 17.

Search Index Required

New

Required

Copied

See Step 16.

Required

New

See Step 17.

Filr Required

New

Required

Copied

See Step 16.

Required

New

See Step 17.
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22 Specify and confirm the root and vaadmin passwords for the appliance you are upgrading from, 
then click OK.

A message indicating that the upgrade was successful is displayed.

IMPORTANT: At this stage of the upgrade process, consider the following:

 When upgrading multiple Filr appliances in a large installation, you must wait for the 
upgrade to succeed on one Filr appliance before beginning the upgrade process for another 
Filr appliance in the cluster.

 When upgrading the Filr database, the upgrade process can take a significant amount of 
time with no visual indication that upgrade is in process. It is typical for the upgrade to take 
10 minutes for every 1 GB of information in the database. For example, upgrading a 6 GB 
database takes about one hour to complete.

23 In a browser, navigate to the following URL:

https://ip_address:9443

Use the IP address or DNS name of the server that you specified during the appliance 
installation.

24 Log in to the appliance using the vaadmin user and the password that you set.

The Novell Filr Appliance, Novell MySQL Appliance, or Novell Filr Search Appliance landing 
page is displayed, depending on which appliance you are upgrading.
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25 (Conditional) If you are upgrading the search appliance:

25a Click the Filr Search Appliance Configuration icon.

The Search Settings page is displayed.

25b (Conditional) If the Filr Configuration wizard is displayed rather than the Settings page, 
there was a problem with the configuration. Resolve any configuration issues, then click 
Finish to reconfigure the system.

25c Ensure that all of the settings are set to your desired specifications.

26 (Conditional) If you are upgrading the database appliance:

26a Click the phpMyAdmin icon.
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26b Verify that the database is populated.

27 (Conditional) If you are upgrading the Filr appliance in a large deployment:

27a Click the Filr Appliance Configuration icon.

The Filr Settings page is displayed.

27b (Conditional) If the Filr Configuration wizard is displayed rather than the Settings page, 
there was a problem with the configuration. Resolve any configuration issues, then click 
Finish to reconfigure the system.

Following are common configuration issues:

 If your system is not using DNS, this is most likely a problem due to unresolvable DNS 
names and missing /etc/hosts entries.

 The Filr appliance does not have access to the database.

27c Ensure that all of the settings are set to your desired specifications.

28 (Conditional) If you are upgrading the Filr appliance in a small deployment:

28a Click the Filr Appliance Configuration icon.

The Filr Settings page is displayed.

28b (Conditional) If the Filr Configuration wizard is displayed rather than the Settings page, 
there was a problem with the configuration. Resolve any configuration issues, then click 
Finish to reconfigure the system.

28c Ensure that all of the settings are set to your desired specifications.

28d Click Home, then click the phpMyAdmin icon.
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28e Verify that the database is populated.

28f (Optional) On the target Filr system, remove the disk that you used for the backup of the 
database from the database appliance. You can either delete the disk or store it in a 
separate location.

29 In a large deployment, repeat this process for each appliance in the Filr system.

For information about how to add additional Filr appliances to the Filr system, see “Adding a Filr 
Appliance to an Existing Deployment to Accommodate System Load” on page 33.

30 Continue with Section 8.5, “Performing Post-Upgrade Tasks,” on page 128.

8.5 Performing Post-Upgrade Tasks
After upgrading to Filr 2.0, you should perform the following tasks to ensure a fully functional Filr 
system:

 Section 8.5.1, “Rebuilding the Metadata and Content Search Indexes,” on page 128

 Section 8.5.2, “Re-Enabling SSH on the Filr Search and Database Appliances,” on page 128

 Section 8.5.3, “Install Your Filr 2.0 License,” on page 129

8.5.1 Rebuilding the Metadata and Content Search Indexes

Because of changes made to the index schema in the Filr 1.2 release, you must re-index your Filr site 
if you are upgrading from Filr 1.1 to Filr 2.0. 

If you are upgrading from Filr 1.2 to Filr 2.0, rebuilding the index is not required.

For information about how to re-index the Filr site, see “Rebuilding the Lucene Index” in the Filr 2.0: 
Administration Guide.

8.5.2 Re-Enabling SSH on the Filr Search and Database 
Appliances

If you enabled SSH on the search or database appliances before upgrading your Filr system, it is 
disabled after upgrading, and you need to re-enable it. For more information about how to enable 
SSH, see “Changing System Services Configuration” in the Filr 2.0: Administration Guide.
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8.5.3 Install Your Filr 2.0 License

Upgraded Filr 2.0 appliances have a 60-day evaluation license installed. 

To prevent a service interruption, you must install your 2.0 license by following the instructions in 
“Viewing and Updating the Filr License” in the Filr 2.0: Administration Guide.
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9 9Troubleshooting the Filr Installation and 
Upgrade

 Section 9.1, “The Upgrade Dialog Box Is Not Displayed during an Upgrade,” on page 131

 Section 9.2, “Rolling Back to the Previous Version after an Unsuccessful Upgrade,” on page 131

9.1 The Upgrade Dialog Box Is Not Displayed during 
an Upgrade
The following dialog box should be displayed when powering on the new appliance. If it is not 
displayed, the data storage location was not successfully copied or attached to the new Filr system. 
Begin the upgrade process again and ensure that you have configured the new Filr system to point to 
the data storage location of the source Filr system.

9.2 Rolling Back to the Previous Version after an 
Unsuccessful Upgrade
You can roll the Filr system back to the previous version if the upgrade is unsuccessful.

 Section 9.2.1, “Rolling Back a Small or Non-Clustered Filr System,” on page 131

 Section 9.2.2, “Rolling Back a Clustered Filr System,” on page 132

9.2.1 Rolling Back a Small or Non-Clustered Filr System

You should have created a copy of the data storage location (/vastorage) to be used in the new Filr 
system (as described in Section 8.3, “Copying the Appliance Data Storage Location to Prepare for the 
Upgrade,” on page 107).

If you experience complications when upgrading the Filr system, your existing Filr system is still intact 
and you are able to power it on at any time. 
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9.2.2 Rolling Back a Clustered Filr System

A clustered Filr system (multiple Filr appliances) consists of not only a data storage location (/
vastorage), but also shared storage (/vashare).

 “Rolling Back the Data Storage Location (/vastorage)” on page 132

 “Rolling Back the Shared Storage Location (/vashare)” on page 132

Rolling Back the Data Storage Location (/vastorage)

You should have created a copy of the data storage location (/vastorage) to be used in the new Filr 
system (as described in Section 8.3, “Copying the Appliance Data Storage Location to Prepare for the 
Upgrade,” on page 107).

If you experience complications when upgrading the Filr system, the data storage location of your 
existing Filr system is still intact.

Rolling Back the Shared Storage Location (/vashare)

After an unsuccessful upgrade, you can roll back the shared storage location (/vashare) to the 
previous version by reconfiguring clustering on the Filr server:

1 On the Filr appliance that you are rolling back to, log in as the Filr administrator.

https://ip_address:9443

Replace ip_address with the IP address of your Filr appliance.

2 Sign in to the Filr appliance using the vaadmin user and the password that you set during 
installation.

The Novell Filr Appliance landing page is displayed.

3 Click the Filr Server Configuration icon.
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4 Click Clustering.

5 In the Server Address field, add the port number to the server address of each search index 
appliance.

For example, change 172.17.2.2 to 172.17.2.2:11211
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 Appendix A, “Installing Novell Filr in Silent Mode,” on page 137

 Appendix B, “Migrating the Filr Database from MySQL to Microsoft SQL,” on page 141

 Appendix C, “Setting Up Remote NFS or Remote CIFS for the Filr Shared Storage Location,” on 
page 149
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A AInstalling Novell Filr in Silent Mode

If you are familiar with Novell Filr installation and you want to get the system installed quickly, you can 
leverage the Novell Filr silent installation.

Silent installation requires that you create the following two files:

 vaauto.conf: Contains the operating system configuration that is used by the system installation 
program.

The contents of this file are the same regardless of which appliance you are installing (Filr, 
search index, or database).

 appliance.conf: Contains the appliance-specific configuration that is used by the configuration 
wizard.

The contents of this file differ depending on the appliance that you are installing (Filr, search 
index, or database).

Filr supports silent installation and silent upgrade:

 Section A.1, “Installing Filr in Silent Mode,” on page 137

 Section A.2, “Upgrading Filr in Silent Mode,” on page 140

A.1 Installing Filr in Silent Mode
To install Filr as a new installation in silent mode:

1 Create the vaauto.conf file. You need to populate this file with configuration information. 
Following is an example of the type of information that is required:

I_HAVE_ACCEPTED_THE_PRODUCT_LICENSE_AGREEMENT="yes"
CONFIG_VAINIT_ROOT_PASSWORD="password" (example: novell)
CONFIG_VAINIT_APPLIANCE_PASSWORD="password" (example: novell)
CONFIG_VAINIT_HOSTNAME="hostname.domain" (example: filr.novell.com)
CONFIG_VAINIT_IPADDRESS="ip_address" (example: 172.17.2.3)
CONFIG_VAINIT_NETWORK_MASK="network_mask" (example: 255.255.252.0)
CONFIG_VAINIT_GATEWAY="network_gateway" (example: 172.17.2.254)
CONFIG_VAINIT_DNS_SERVER="dns_server" (example: 172.17.247.1)
CONFIG_VAINIT_DNS_SERVER_ALTERNATE="dns_server" (example: 172.17.160.160)
CONFIG_VAINIT_NTP_SERVER="ntp_server" (example: tock.novell.com)
CONFIG_VAINIT_TIMEZONE="timezone" (example: America/Denver)
CONFIG_VAINIT_STORAGE_TYPE="device"
CONFIG_VAINIT_SHARED_STORAGE_TYPE=""
CONFIG_VAINIT_NFS_SERVER_HOST=""
CONFIG_VAINIT_SHARED_NFS_SERVER_HOST=""
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CONFIG_VAINIT_NFS_REMOTE_DIR=""
CONFIG_VAINIT_SHARED_NFS_REMOTE_DIR=""
CONFIG_VAINIT_SHARED_CIFS_SERVER_FOLDER=""
CONFIG_VAINIT_SHARED_CIFS_ADMIN=""
CONFIG_VAINIT_DEVICE_STORAGE="type:uninitialized drive:sdb size:16.00G 
format:ext3"
#CONFIG_VAINIT_DEVICE_STORAGE="type:uninitialized drive:sdb size:* 
format:ext3"
CONFIG_VAINIT_VAR_STORAGE_TYPE="device"
CONFIG_VAINIT_VAR_STORAGE="type:uninitialized drive:sdc size:* format:ext3"
CONFIG_VAINIT_SHARED_DEVICE_STORAGE=""
CONFIG_VAINIT_HOSTNAME_2=""
CONFIG_VAINIT_IPADDRESS_2=""
CONFIG_VAINIT_NETWORK_MASK_2=""

You can populate the vaauto.conf file by using either of the following methods:

 If you have already installed Filr using the regular installation process prior to running a 
silent installation, you can copy the information from the previously installed system. (For 
information about how to install Filr, see Section 3.1.2, “Installing the Filr Appliance,” on 
page 47.)

1. Start the SSH service on the Filr appliance that is currently running, for which you want 
to copy system information to be used in your silent installation.

For information about how to enable SSH on the appliance, see “Changing System 
Services Configuration” in the Filr 2.0: Administration Guide.

2. SSH to the Filr appliance.

3. Change to the following directory and copy the /etc/sysconfig/novell/NvlVAinit 
file to your workstation.

4. Copy each configuration setting that contains a value from the NvlVAinit file and 
paste them into the vaauto.conf file.

IMPORTANT: 

Do not copy the following setting: 

 SERVICE_CONFIGURED="YES"

Ensure that you do copy the following settings:

 I_HAVE_ACCEPTED_THE_PRODUCT_LICENSE_AGREEMENT="yes"

CONFIG_VAINIT_ROOT_PASSWORD="password" (example: novell) 
CONFIG_VAINIT_APPLIANCE_PASSWORD="password" (example: novell)

CONFIG_VAINIT_APPLIANCE_PASSWORD="password" (example: novell)

Configuration options that do not have values are not being used in your environment, 
and do not need to be copied. All other configuration options that do contain values do 
need to be copied.

 Copy and paste the configuration options above to your own vaauto.conf file. When doing 
so, specify the values unique to your environment, and delete the example text.

For information about each option, see Section 3.1.2, “Installing the Filr Appliance,” on 
page 47.

2 Create the appliance.conf file for the appliance that you are installing. The information that the 
appliance.conf file must contain differs depending on the appliance.

For simplicity, you can copy and paste the configuration options below to your own 
appliance.conf file. When doing so, delete the example text.
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NOTE: There is no silent installation or upgrade option for the database appliance. The 
installation and configuration of the database appliance must be done by using the Filr 
installation program, as described in Section 4.2, “Installing the MySQL Database Appliance,” on 
page 65.

NOTE: If you do not set the password encoding, passwords are not encoded by default. 

If you do not set a password, the default password is novell.

2a (Conditional) If you are installing the Filr appliance in a small deployment, use the following 
information:

filr.passwords.encoded=yes
filr.deployment.type=small
filr.database.user.password=filr
filr.locale.country=locale_code (example: "US")
filr.locale.language=language_code (example "en")

2b (Conditional) If you are installing the Filr appliance in a large deployment, use the following 
information:

filr.passwords.encoded=yes
filr.deployment.type=large
filr.database.type=mysql
#filr.database.type=sqlserver 
filr.database.user.password=filr
filr.database.user.name=filr
filr.database.port=3306
filr.database.host.name=database_host (example: filrdb.novell.com)
filr.database.name=filr
filr.search.Service.name=lucene service
filr.search.port=1188
filr.search.host.name=search_host (example: filrsearch.novell.com)
filr.search.password=filr
filr.locale.country=locale_code (example: US)
filr.locale.language=language_code (example: en)

2c (Conditional) If you are installing the search index appliance, use the following information:

lucene.passwords.encoded=yes
lucene.server.password=filr
lucene.max.booleans=10000
lucene.ram.buffer.size.mb=256
lucene.merge.factor= 11
lucene.java.max.heap.size=3g
lucene.java.max.thread.stack.size=3m

2d (Conditional) If you are installing the MySQL appliance, use the following information:

mysql.passwords.encoded=yes
mysql.filr.username.password=filr
mysql.filr.database.name=filr
mysql.filr.username=filr
mysql.host.access=%
mysql.root.password=root

3 Create an ISO image that contains the vaauto.conf and appliance.conf files that you created 
in Step 1 and Step 2.

The files must be located at the root of the ISO image, and the ISO image must be in a location 
where you can attach it to the virtual appliance.
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Give the ISO image any name of your choosing.

You can download free tools from the Internet that allow you to create ISO images. An example 
of one such tool is Virtual CloneDrive.

4 Add a second hard disk for the appliance, as described in Section 3.1.1, “Downloading the Filr 
Appliance and Configuring the Virtual Environment,” on page 37.

5 Attach the ISO image to a CD-ROM device on the virtual appliance that you are installing.

6 Ensure that the CD-ROM device is set to connect to the appliance when the appliance powers 
on.

7 Power on the appliance.

8 Detach the ISO image after the installation has successfully completed.

9 Continue with Chapter 7, “Setting Up the Filr Site,” on page 101 to make your site ready for user 
access.

A.2 Upgrading Filr in Silent Mode
To upgrade Filr from one version to another:

1 Create the vaauto.conf file. The file must contain the following information:

For simplicity, you can copy and paste the configuration options below to your own vaauto.conf 
file. When doing so, delete the example text.

Filr retrieves most configuration information from the shared storage directory. For an upgrade, 
you only need to provide Filr with the passwords for the root and vaadmin users. 

CONFIG_VAINIT_ROOT_PASSWORD="password" (example: "novell")
CONFIG_VAINIT_APPLIANCE_PASSWORD="password" (example: "novell")

2 Create an ISO image that contains the vaauto.conf file that you created in Step 1.

The ISO image must be in a location where you can attach it to the virtual appliance.

Give the ISO image any name of your choosing.

You can download free tools from the Internet that allow you to create ISO images. An example 
of one such tool is Virtual CloneDrive.

3 Add a second hard disk for the appliance, as described in Section 3.1.1, “Downloading the Filr 
Appliance and Configuring the Virtual Environment,” on page 37.

4 Attach the ISO image to a CD-ROM device on the virtual appliance that you are upgrading 
before you power on the appliance.

5 Power on the appliance.

6 Detach the ISO image after the upgrade has successfully completed.

Your Filr site is now upgraded and ready for use.
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B BMigrating the Filr Database from 
MySQL to Microsoft SQL

You can migrate the Filr database from the MySQL database appliance that ships with Filr to an 
enterprise database.

This section describes how to migrate from the MySQL database appliance to Microsoft SQL.

IMPORTANT: When migrating from the MySQL database appliance to Microsoft SQL, you must first 
migrate the database schema and then the data as described in this section.

 Section B.1, “Prerequisites,” on page 141

 Section B.2, “Configuring the Existing Microsoft SQL Database Server,” on page 142

 Section B.3, “Connecting to the MySQL Database Server,” on page 142

 Section B.4, “Connecting to the Microsoft SQL Server,” on page 143

 Section B.5, “Customizing Data Types,” on page 143

 Section B.6, “Migrating the Database Schema,” on page 144

 Section B.7, “Migrating Data,” on page 145

 Section B.8, “Running Post-Migration Scripts,” on page 145

 Section B.9, “Post-Migration Steps,” on page 146

 Section B.10, “Modifying Liquibase Tables,” on page 147

B.1 Prerequisites
 Download the latest MySQL Connector/ODBC driver to the Microsoft SQL server. You can get 

this driver from the MySQL development website (http://dev.mysql.com/downloads/connector/
odbc/).

This driver enables you to establish a connection between the MySQL server and the Microsoft 
SQL server.

 Download and install the Microsoft SQL Server Migration Assistant for MySQL onto the Microsoft 
SQL server, as described in the Microsoft Developer Network (http://msdn.microsoft.com/en-us/
library/hh313147(v=sql.110).aspx). 

 Modify an existing user on the MySQL Appliance so that the user is associated with the IP 
address or DNS name of the Microsoft SQL server where the Microsoft SQL Server Migration 
Assistant for MySQL is installed. This can be accomplished via phpMyAdmin or the MySQL 
appliance.

 Stop the Filr service on any Filr appliances in the Filr system, as described in “Changing System 
Services Configuration” in the Filr 2.0: Administration Guide.
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B.2 Configuring the Existing Microsoft SQL Database 
Server
For information regarding which versions of the Microsoft SQL database Filr supports, see 
Section 1.2.1, “Filr Server Requirements,” on page 13.

To configure an existing Microsoft SQL database to be used with your Filr system:

1 Enable remote access to the Microsoft SQL database server.

2 Open port 1433 on the Windows firewall where the database is running.

3 Identify a user account configured with SQL Server Authentication and that this user has 
sufficient rights to manage the Filr database.

Filr supports only SQL Server Authentication. Filr does not support Windows Authentication or 
Windows Domain User Authentication to Microsoft SQL.

4 Using Microsoft SQL Server Management Studio, create a new database to use as the Filr 
database.

Select the Master database in the list of databases, then paste the following script into the New 
Query window and execute it to create the new Filr database:

USE master;
GO
IF DB_ID (N'filr') IS NOT NULL
DROP DATABASE filr;
GO
CREATE DATABASE filr
COLLATE Latin1_General_100_BIN;
GO

--Verify the collation setting.
SELECT name, collation_name FROM sys.databases WHERE name = N'filr';
GO

If your database name is something other than filr, replace filr with the name of your 
database in the script.

5 Continue with Section B.3, “Connecting to the MySQL Database Server,” on page 142.

B.3 Connecting to the MySQL Database Server
1 On the Microsoft SQL server, launch the Microsoft SQL Server Migration Assistant for MySQL.

2 Create a new project by clicking File > New Project.

The New Project dialog box is displayed.

3 Accept the defaults for the project by clicking OK.

4 Click Connect to MySql.

The Connect to MySql dialog box is displayed.

5 In the Provider drop-down list, select the MySQL ODBC 5.3 Unicode Driver (v5.3.x).

This option must be selected because the Filr database uses a Unicode character set.

6 In the Server name field, specify the IP address of the MySQL database appliance that you are 
migrating from.

7 Specify the user name and password for the MySQL database, then click Connect.
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A connection to the MySQL server is established.

8 Continue with Section B.4, “Connecting to the Microsoft SQL Server,” on page 143.

B.4 Connecting to the Microsoft SQL Server
1 In the MySql Metadata Explorer window, browse to and select your MySQL database.

2 Click Connect to SQL Server.

3 Accept the defaults for connecting to the Microsoft SQL server, then specify the user name and 
password for a user with sufficient rights on the database.

4 Click Connect.

A connection to the Microsoft SQL server has been established.

5 Continue with Section B.5, “Customizing Data Types,” on page 143.

B.5 Customizing Data Types
1 On the Microsoft SQL server, launch the Microsoft SQL Server Migration Assistant for MySQL.

2 Click Tools > Project Settings.

The Project Settings dialog box is displayed.

3 Click Type Mapping, select bigint(*..255) in the Source Type column, then click Edit.

The Edit Type Mapping dialog box is displayed.

4 In the Target Type drop-down list, select Numeric (Precision, Scale).

5 In the Precision section, specify 19.

6 In the Scale section, specify 0, then click OK.

7 Select datetime in the Source Type column, then click Edit.

The Edit Type Mapping dialog box is displayed.

8 In the Target Type drop-down list, select datetime, then click OK.
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9 Click Apply > OK.

10 Continue with Section B.6, “Migrating the Database Schema,” on page 144.

B.6 Migrating the Database Schema
1 In the MySQL Metadata Explorer window, select the Filr MySQL database and tables that you 

want to migrate, then click Convert Schema.

This creates the database schema on the target Microsoft SQL server.

2 In the SQL Server Metadata Explorer section, right-click the MySQL database that you are 
migrating, then click Synchronize with Database.

3 In the Synchronize with the Database dialog box, verify that the tables will be created, then click 
OK.

4 Continue with Section B.7, “Migrating Data,” on page 145.
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B.7 Migrating Data
1 In the MySQL Metadata Explorer window, select the Filr MySQL database and tables that 

contain the data that you want to migrate.

To avoid timeout errors, migrate large tables individually, as described in Step 6.

The Connect to MySQL dialog box is displayed.

2 Accept the defaults for connecting to the Microsoft SQL server, then specify the user name and 
password for a user with sufficient rights on the database.

3 Click Connect.

The Connect to SQL Server dialog box is displayed.

4 Accept the defaults for connecting to the Microsoft SQL Server, then specify the user name and 
password for a user with sufficient rights on the database.

5 Click Connect.

The data is migrated. Depending on the amount of data and number of tables in your database, 
this process can take a few minutes.

After the migration finishes, the Data Migration Report is displayed. You can save the report for 
your records, or close it without saving.

6 (Optional) To migrate individual tables, repeat Step 1 through Step 5 and select the table that you 
want to migrate in the MySQL Metadata Explorer window.

7 Run the following queries in sequence against the migrated database using the SQL Query 
Editor of the Microsoft SQL Server:

ALTER DATABASE filr SET SINGLE_USER WITH ROLLBACK IMMEDIATE;
ALTER DATABASE filr COLLATE Latin1_General_CI_AS_KS_WS;
ALTER DATABASE filr SET MULTI_USER;
SELECT name, collation_name FROM sys.databases WHERE name = N'filr';

If your database name is something other than filr, replace filr with the name of your 
database.

These queries must be successfully executed in the correct order before continuing.

8 Continue with Section B.8, “Running Post-Migration Scripts,” on page 145.

B.8 Running Post-Migration Scripts
1 After the database schema and data is successfully migrated, run the post-migration script 

(post-migration.sql) on the migrated database by using the SQL Query Editor of the 
Microsoft SQL Server. You can download the 
MySQL_MSSQL_Post_Migration_for_Filr_2_0.sql file from the Filr 2.0 download site on 
download.novell.com.

After running the script, you should see the following message in the SQL Query Editor for both 
the Parse and Execute actions:

Command(s) completed successfully.

2 Continue with Section B.9, “Post-Migration Steps,” on page 146.
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B.9 Post-Migration Steps

IMPORTANT: In a large Filr deployment with multiple Filr appliances, this procedure must be done 
for each Filr appliance in the Filr system.

1 Access the Novell Filr appliance at port 9443.

For example, https://ip_address_or_DNS:9443

Use the IP address or DNS name of the server that you specified during the appliance 
installation.

2 Log in to the appliance using the vaadmin user and the password that you set.

The Novell Filr Appliance landing page is displayed.

3 Click the Filr Server Configuration icon.

The Filr Server Configuration page is displayed.

4 Click Database.

5 In the Database Type drop-down, select SQLServer.

6 Change the Host Name or IP Address and Port fields to match the new host name or IP address 
and port number for the Microsoft SQL server.

7 Change the User Name and User Password fields to match that of a user on with sufficient rights 
on the Microsoft SQL server.

8 Click OK to save the new database configuration settings.
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In the Configuration Summary, verify that the database information has changed.

9 Click Reconfigure Filr Server.

10 Repeat this process for each Filr appliance in the Filr system.

11 Continue with Section B.10, “Modifying Liquibase Tables,” on page 147.

B.10 Modifying Liquibase Tables
Filr ships with Liquibase scripts that validate database schema, keep track of schema changes, 
compare changes with the reference database, and so forth. In order to use these scripts, the 
Liquibase tables need to be deleted and re-created. (This is because the Liquibase tables contain 
metadata specific for the MySQL database that you are migrating from.)

You need to remove the MySQL tables and create new tables that are compatible with the Microsoft 
SQL database.

1 Delete the Liquibase tables (databasechangelog and databasechangeloglock) from the 
migrated MSSQL database.

2 Modify the sqlserver.liquibase.properties file and set the database password to be clear 
text so that it can be read by the Liquibase scripts:

2a SSH to the Filr appliance and log in to the appliance as the root user.

2b In the console of the Filr appliance, change to the /filrinstall/db directory.

2c Make a copy of the sqlserver.liquibase.properties file.

For example, to copy the file to the root partition:

cp sqlserver.liquibase.properties /

2d Open the sqlserver.liquibase.properties file in a text editor.

For example, you can use the vi Editor to edit the file:

vi sqlserver.liquibase.properties

2e Change the password value to the password of the Microsoft SQL database.

2f Save and close the sqlserver.liquibase.properties file.

In the vi Editor, you can type the following command when in command mode:

:wq

3 Run the manage-database.sh script with the markDatabaseAsUpdated switch. 

This creates the Liquibase tables and populates them with the definitions read from the Microsoft 
SQL version of the changelog files that are available in the Filr installation directory.

To run the manage-database.sh script with the markDatabaseAsUpdated switch:

3a SSH to the Filr appliance and log in to the appliance as the root user.

3b Run following command:

sh /filrinstall/db/manage-database.sh sqlserver markDatabaseAsUpdated

4 Perform the final validation by running manage-database.sh with the updateDatabase switch.

To run the manage-database.sh script with the updateDatabase switch:

4a SSH to the Filr appliance and log in to the appliance as the root user.

4b Get Executable permission to the manage-database.sh script by running the following 
commands:

cd /filrinstall/db/
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chmod x manage-database.sh

4c Run following commands:

sh /filrinstall/db/manage-database.sh sqlserver updateDatabase

sh /filrinstall/db/manage-database.sh sqlserver validate

The Liquibase script should find no need to perform any further schema changes, and this run 
should complete without making any changes and without any errors.

5 Replace the sqlserver.liquibase.properties file that you edited in Step 2d with the one that 
you copied in Step 2c.

6 Start the Filr service on any Filr appliances in the Filr system, as described in “Changing System 
Services Configuration” in the Filr 2.0: Administration Guide.

7 Users can now access the Filr site at port 8443.

For example, https://ip_address_or_DNS:8443
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C CSetting Up Remote NFS or Remote 
CIFS for the Filr Shared Storage 
Location

You can configure Shared storage either on a remote Linux server via NFS or on a remote Windows 
server via CIFS. This is the /vashare location where information specific to the appliance is stored 
and it is used when the appliance is upgraded.

 Section C.1, “Setting Up Remote NFS for the Filr Shared Storage Location,” on page 149

 Section C.2, “Setting Up Remote CIFS for the Filr Shared Storage Location,” on page 150

C.1 Setting Up Remote NFS for the Filr Shared Storage 
Location

IMPORTANT: Filr does not support remote NFS from a Novell Storage Services (NSS) volume.

To configure remote NFS on a Linux server:

1 On the Linux server where you want to configure remote NFS to work with Filr, launch YaST2.

2 In the Network Services section, click NFS Server.

The NFS Server Configuration dialog box is displayed.

3 Click Next.

4 Click Add Directory.

5 In the Directory to Export field, specify the directory that you want to create, then click OK.

IMPORTANT: In Filr 2.0, the directory must not be located in the /var directory structure on the 
NFS server, as explained in “NFS Mount Point Must Not Point to /var on Target Server” in the 
Novell Filr 2.0 Release Notes.

6 Click Yes to confirm directory creation.

7 In the Host Wild Card field, specify the host name for the Filr appliance.

For example, filr1.novell.com.

8 In the Options field, change ro to rw (read-only to read-write), then change root_squash to 
no_root_squash.

9 Click OK.

10 (Conditional) If you have a clustered Filr system with multiple Filr appliances, edit the wild card 
field and add each host name separated by a comma (no spaces).

11 Click Finish.

12 Configure each Filr appliance in the cluster to reference this NFS server, as described in 
Section 4.4, “Installing the Filr Appliance,” on page 79.
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C.2 Setting Up Remote CIFS for the Filr Shared 
Storage Location
 Section C.2.1, “Setting Up Remote CIFS,” on page 150

 Section C.2.2, “Modifying the Credentials for the CIFS Share,” on page 150

C.2.1 Setting Up Remote CIFS

To configure shared storage on a remote Windows server via CIFS:

1 Create a folder on the Windows server where you want to configure remote CIFS to work with 
Filr.

This folder will be the shared storage location (/vashare) for Filr.

2 Right-click the folder that you just created, then click Properties.

3 Click the Sharing tab.

4 Designate a user to administer the folder.

This user must have Read/Write permissions to the folder. You can select an existing user, or 
create a new user.

5 After you have designated and selected a user with Read/Write permissions, click Share.

6 Configure each Filr appliance in the cluster to reference this CIFS share, as described in 
Section 4.4, “Installing the Filr Appliance,” on page 79.

When connecting to the share via the Filr installation program, use the user name and password 
of the user that you designated in Step 4.

C.2.2 Modifying the Credentials for the CIFS Share

After setting up shared storage on a remote Windows server via CIFS, you can change login 
credentials of the user who has access to the CIFS share:

1 Log in as root to the Filr command prompt.

2 Type the following command to navigate to the base directory:

cd /etc/opt/novell/base

3 Display the first lines of the file:

vi .smbcredentials

4 In the vi editor, modify the credentials as desired.
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D DTroubleshooting the Filr System

For general troubleshooting information, see “Troubleshooting the Filr System” in the Filr 2.0: 
Administration Guide.

For troubleshooting information related to Filr installation or upgrade, see Chapter 9, 
“Troubleshooting the Filr Installation and Upgrade,” on page 131.
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E EThird-Party Materials

 Section E.1, “Growl License,” on page 153

 Section E.2, “Oracle Outside In Technology,” on page 154

 Section E.3, “ANTLR 3 License,” on page 154

 Section E.4, “Colt License Agreement,” on page 155

 Section E.5, “Dom4j License,” on page 155

 Section E.6, “iCal4j License,” on page 156

 Section E.7, “ICU4J license (ICU4J 1.3.1 and later),” on page 156

 Section E.8, “JAXEN License,” on page 157

 Section E.9, “Jung,” on page 157

 Section E.10, “ASM,” on page 158

 Section E.11, “Firebug Lite,” on page 159

E.1 Growl License
Copyright (c) The Growl Project, 2004-2011

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 Neither the name of Growl nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
Third-Party Materials 153



E.2 Oracle Outside In Technology
Oracle shall inform you of any notices and other instructions that are related to third party 
components (including open source software) that are included in a program and/or hardware and 
that Oracle is required to distribute with such programs and/or hardware. These notices and other 
instructions shall be provided to you in at least one of the following ways, at Oracle’s sole discretion: 
(a) automatically installed with the programs or in the installation details; (b) in the program 
documentation; (c) in the readme files or notice files; or (d) via a supplemental list. You shall comply 
with all instructions related to third party software components (including open source software). If 
you reproduce the programs, operating system and/or integrated software, you shall reproduce all 
third party notices in an appropriate location in the reproduction and/or in its related documentation 
and include any associated source code (to the extent such source code is provided by Oracle), as 
required by the applicable notices or as otherwise directed by Oracle?.

PDF documents with complete information about the use of Oracle technology in Filr are located in 
the following directory on the Filr server:

/opt/novell/filr/stellent-converter

E.3 ANTLR 3 License
Copyright (c) 2003-2008, Terence Parr

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 Neither the name of the author nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
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E.4 Colt License Agreement
Packages cern.colt*, cern.jet*, cern.clhep 

Copyright (c) 1999 CERN - European Organization for Nuclear Research.

Permission to use, copy, modify, distribute and sell this software and its documentation for any 
purpose is hereby granted without fee, provided that the above copyright notice appear in all 
copies and that both that copyright notice and this permission notice appear in supporting 
documentation. CERN makes no representations about the suitability of this software for any 
purpose. It is provided “as is” without expressed or implied warranty. 

Packages hep.aida.* 

Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas 
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or 
redistribute this work is granted under the terms of the LGPL License, with the exception that any 
usage related to military applications is expressly forbidden. The software and documentation 
made available under the terms of this license are provided with no warranty.

E.5 Dom4j License
Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“Software”), with or without 
modification, are permitted provided that the following conditions are met: 

1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions 
must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

3. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com.

4. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com. 

5. Products derived from this Software may not be called “DOM4J” nor may “DOM4J” appear in 
their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark 
of MetaStuff, Ltd. 

6. Due credit should be given to the DOM4J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “AS IS”' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.
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E.6 iCal4j License
Copyright (c) 2008, Ben Fortuna

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of Ben Fortuna nor the names of any other contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

E.7 ICU4J license (ICU4J 1.3.1 and later)
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995-2001 International Business Machines Corporation and others

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the 
Software, and to permit persons to whom the Software is furnished to do so, provided that the above 
copyright notice(s) and this permission notice appear in all copies of the Software and that both the 
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. 
IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE 
LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR 
ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, 
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE.
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Except as contained in this notice, the name of a copyright holder shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization of the copyright holder. 

E.8 JAXEN License
Copyright (C) 2000-2002 Bob McWhirter & James Strachan.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and 
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, 
and the disclaimer that follows these conditions in the documentation and/or other materials 
provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products derived from this software 
without prior written permission. For written permission, please contact license@jaxen.org.

4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their 
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation provided 
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
www.jaxen.org.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE Jaxen 
AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Jaxen 
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan 
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://
www.jaxen.org.

E.9 Jung
THE JUNG LICENSE

Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the University of California nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

E.10 ASM
Copyright (c) 2000-2005, INRIA, France Telecom

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the copyright holders nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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E.11 Firebug Lite
Copyright (c) 2006-2007, Joe Hewitt

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the copyright holders nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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F FDocumentation Updates

The following changes have been made to the guide since the initial release of Novell Filr 2.0.

Date Section Additional Information

20 April 2016 Section 4.3.2, “Configuring an 
Existing Microsoft SQL Database 
Server,” on page 78

Added two queries that must be run 
against an existing MS SQL 
database.

16 March 2016 Section 8.1, “Upgrade Caveats,” on 
page 106

New section.
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